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The Vocera Messaging Platform (VMP) provides an enterprise messaging solution designed to address the
unique communication challenges of healthcare. Users can leverage the communication capabilities of
VMP from the Vocera Collaboration Suite, Vocera Secure Texting, the VMP Web Console, and the Vocera
badge and Smartbadge.

The VMP platform runs on Windows Server and integrates with Windows SQL Server. User data can be
imported from Active Directory, Vocera Voice Server, Vocera Secure Texting, SQL, or Excel/CSV data files.

VMP administrators perform initial system configuration and ongoing system administration. Initial
configuration tasks are managed from the VMP Enterprise Manager and the VMP Administrator.
Administrative tasks are also managed from the VMP Web Console.

The Vocera Messaging Platform (VMP) runs on Windows Server and integrates with other server systems.

Table 1: Integration options

System Integration Details

Active Directory Server The VMP Server uses Active Directory to synchronize domain users with the VMP
Administrator.

SQL Server The VMP Server uses SQL Server to store the system data in a secure database. Users

and Contacts can also be imported from an SQL database.

Vocera highly recommends that you create a unique instance on the SQL Server to house the VMP database.
This ensures that resources can be assigned as specified in the Vocera Messaging Platform Server Sizing
Guide.

Apple Push Notification The VMP Server integrates with APNS when Apple iOS devices are not connected

Service (APNS) directly to the Vocera infrastructure to receive direct push notifications. The APNS
Servers are not hosted within a network. The VMP Server connects to the APNS
network through HTTPS.

Firebase Cloud Messaging = The VMP Server integrates with FCM when Google Android devices are not connected

Service (FCM) directly to the Vocera infrastructure to receive direct push notifications. The FCM
Servers are not hosted within a network. The VMP Server connects to the FCM
network through HTTPS.

Vocera Voice Server The VMP Server integrates with the Vocera Voice Server through a direct network
connection.
Engage Platform The VMP Server can obtain patient information through the Engage Patient Context

Adapter, and can receive alarms through the VMP SOAP interface. These alarms are
sent to client devices and the VMP Web Console as notifications.
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ABOUT THE VOCERA MESSAGING PLATFORM

The VMP architecture indicates how the VMP Server is connected to other Vocera servers, to client
devices, and to other servers.

The following diagram shows how the VMP Server connects to other servers inside your network firewall.
As shown in the diagram, a reverse proxy can be used to communicate with entities outside of your
corporate firewall.

For information on the ports that these connnections use, see on page 11.

; <>
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====| Note: In older versions of VMP, devices running the Vocera Collaboration Suite app communicated
with the Vocera Voice Server using a Comet connection. This connection option is still available
for backward compatibility, but has been replaced by a TCP-based connection to the Vocera Client
Gateway server. See on page 78 for more details.

When the Vocera Collaboration Suite app is being used outside of your corporate firewall, it communicates
with the Apple Push Notification Service (APNS) if you are using the Apple iOS operating system, or with
the Firebase Cloud Messaging service (FCM) if you are using the Android operating system. The diagram
below shows the relationships between the VMP Server, VCS, APNS, and FCM.
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VCS Client
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. . VS Client
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====| Note: For more information on security and the interface to APNS and FCM, see

on page 88.

The VMP Server can also use the Vocera Voice Server to communicate with Vocera badges, or to interact
with the Vocera SIP Telephony Gateway when VCS apps are making cellular calls.

VMP also has a SOAP-based API that external systems can use to send messages and receive delivery
statuses and responses to the messages. See the Vocera Messaging Platform API Guide for more
information on this API, and also see on page 109 for information on how to
integrate an inbound SOAP connection to the VMP Server.

VMP also supports WCTP as an inbound and outbound protocol to allow third-party systems to initiate
and receive messages. See on page 104 for more details.
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Learn about VMP Server system requirements, and learn how to install the VMP Server.

For detailed information on operating system requirements, MS SQL Server requirements, and more, see
the >Vocera Messaging Platform Server Sizing Guide.

Before you begin your installation, make sure that the VMP installation server is running with at least 4
GB RAM and 120 GB HDD and meets the requirements described here.

====| Note: The VMP Server can be installed on a virtualized server running VMWare. For details about
virtualization, see the Vocera Messaging Platform Server Sizing Guide.

If you are using an SSL connection, the VMP Server must validate the SSL certificate using the existing
Windows mechanisms. See on page 19 for more details.

====| Note: If your devices are using VCS 3.4 or later for iOS, you must have SSL enabled on the VMP
Server. See on page 81 for more details.

Prior to installation, make sure that the minimum network access requirements are met.

Table 2: Network access requirements

Requirement Details

HTTPS connection SMS message aggregation requires an outbound HTTPS connection.

IIS Service The IIS World Wide Web Publishing Service must not be running on port 80
or 443.

To install and deploy the VMP Server, you must have the required software.

* The VMP installation files and license file.
* An SSL certificate if needed. (SSL is recommended, and is required if using iOS devices with VCS.)
* If you are working with the Vocera Voice Server, version 4.4.3 or later is required. If your organization

is using Vocera Voice Server departments and synchronizing them with VMP groups, Vocera Voice
Server 5.2 or later must be installed.

.NET Framework 4.7.1 must be installed.
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If you do not have these items ready for your installation, speak with your Vocera services representative
before continuing with the installation.

During the VMP Server installation, two system accounts are created on the associated SQL Server:
wicapplication and wicauth.

* wicapplication is the VMP system application account.
* wicauth is the user authentication account.

The accounts are created automatically during platform installation. The installation wizard prompts you
for the user ID and password that you use to log in to the SQL server.

To install VMP, you must configure a firewall or proxy firewall.

This firewall or proxy firewall must be configured with the following conditions:
* Support for resolving Internet addresses that use DNS
* A firewall proxy that does not change incoming or outgoing data (transparent proxy)

To allow communication between VMP devices and services, configure communication protocols and port
numbers on the firewall and within the organization network environment.

This is the complete list of port numbers that must be open for Vocera Messaging Platform
communication.

The following table describes the protocol and port requirements for the VMP Server.

Port Number Protocol Source Destination Direction

1433 TCP VMP Server Microsoft SQL Server Outbound

80 and 443 (for TCP VMP Web Console Users' VMP Server Outbound

SSL) computers

389 and 636 (for TCP VMP Server Microsoft Active Outbound

SSL) Directory Server

5008 TCP VMP Server Vocera Client Gateway  Bidirectional
Server

The following table describes the protocol and port requirements for Apple iOS device messaging.

Port Number Protocol Source Destination Direction

443 HTTP/2 VMP Server Apple Push Notification Outbound
Service (APNS),
api.push.apple.com

52232 TCP Apple i0S devices using Apple Push Notification Outbound
Wi-Fi connection Service (APNS),
gateway.push.apple.com

! For versions of VMP earlier than version 5.5, the Use VCG for VCS client connection
management option must be set in the VMP Administrator.
% Apple iOS devices can use port 443 as a fallback if this port is not working.
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The following table describes the protocol and port requirements for Firebase Cloud Messaging (FCM) for
Android devices.

Port Number Protocol Source Destination Direction

443 TCP VMP Server Firebase Cloud Outbound
Messaging (FCM),
fcm.googleapis.com

5228-5230° TCP Android devices using Firebase Cloud Outbound
Wi-Fi connection Messaging (FCM)

The following table describes protocol and port requirements for Simple Network Paging Protocol (SNPP)
gateways (using the default port).

Port Number Protocol Source Destination Direction

444 TCP VMP Server SNPP Gateway Outbound

The following table describes protocol and port requirements for Wireless Communications Transfer
Protocol (WCTP) gateways (using default ports).

Port Number Protocol Source Destination Direction

80 or 443 TCP VMP Server WCTP Gateway Bidirectional

The following table describes protocol and port requirements for Vocera Secure Texting.

Port Number Protocol Source Destination Direction

443 TCP VMP Server VST Server Bidirectional

The following table describes protocol and port requirements for the Engage server (using default ports).

Port Number Protocol Source Destination Direction

80 or 443 REST VMP Server Engage server Outbound

The following table lists the protocol and port requirements for email.

Port Number Protocol Source Destination Direction

25 or 465 (for SMTP VMP Server SMTP Bidirectional
secure SMTP)

143 or 993 (for IMAP VMP Server IMAP Bidirectional
secure IMAP)

110 POP3 VMP Server POP3 Bidirectional
80 or 443 (for Exchange Web  VMP Server EWS Bidirectional
secure EWS) Services (EWS)

The following table lists the protocol and port requirements for Vocera Collaboration Suite when on
premises.

Port Number Protocol Source Destination Direction
443 TCP Vocera Collaboration VMP Bidirectional
Suite

% Your firewall must accept outgoing connections to all IP addresses contained in the IP blocks listed in
Google's ASN of 15169. Android devices running version 4.3 or later can use port 443 as a fallback if
the other three ports are not working.
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Port Number Protocol Source Destination Direction

5060(SIP) TCP* VCS Vocera Client Gateway  Bidirectional
signaling

5888-5889 (VOMO) UDP VCS Vocera Client Gateway  Bidirectional
signaling

7700-8467 (iPhone) UDP VCS Vocera Client Gateway  Bidirectional
audio

7700-8467, UDP VCS Vocera Client Gateway  Bidirectional

32768-65536 audio

(Android)

8080° TCP VCS Vocera Voice Server Bidirectional

Ping/Comet connection

80 or 443’ TCP VCS Vocera Voice Server Bidirectional
Ping/Comet connection 8

This table lists the protocol and port requirements for Vocera Collaboration Suite when off premises.

Port Number Protocol Source Destination Direction
443 TCP Vocera Collaboration VMP Bidirectional
Suite

VMP is shipped with a setup file that enables you to install the VMP Server. Before you can install
this setup file, you must disable the IIS World Wide Web Publishing Service and you must have .NET
Framework 4.7.1 installed.

====| Note: If you are using an SSL connection, the VMP Server must validate the SSL certificate using

the existing Windows mechanisms. See on page 19 for more details.

1. Use the following steps to turn off the IIS World Wide Web Publishing Service. This step ensures that

port 80 is open for the VMP Web Console.
a. Open the Windows Services application:
Windows > Start > Administrative Tools > Services
b. Click to select World Wide Web Publishing Service.
c. Right-click and select Properties.
d. From the Startup type dropdown list, select Disabled.
e. Click Stop, and click Apply.
2. Execute the VMP setup file on the VMP installation server.

For versions of VMP earlier than version 5.5, if the Use VCG for VCS client connection
management option is not set, the protocol is UDP.

Administrator.
management option is not set in the VMP Administrator.
This is used if the Enable Enhanced Voice Server NIO Tomcat Feature option is not set in the

VMP Administrator.

management option is not set in the VMP Administrator.

This is used if the Enable Enhanced Voice Server NIO Tomcat Feature option is set in the VMP

In versions of VMP earlier than version 5.5, this is used if the Use VCG for VCS client connection

In versions of VMP earlier than version 5.5, this is used if the Use VCG for VCS client connection
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3. In the Welcome screen, click Next.

@ vMP 533 Setup - X
\ ,‘(«,(\9‘"{»:]‘ Welcome to the VMP 5.3.3 Setup
T Wizard

This wizard will guide you through the installation of VMP
5.3.3.

Itis recommended that you close all other applications
before starting Setup. This will make it passible to update
relevant system files without having to reboot yaur
computer,

Click Next to continue,

4. Accept the License Agreement, and click Next.

@ VMP 533 Setup — hd
License Agreement , —~
Flease review the license terms before installing VMP 5.3.3, VOIS c,J‘

iEnrl User License Agreement for Messaging Products Software ~
Territory: United States and Canada
Vocera Messaging Products Software and Product
Documentation

1. Please consuli winevocera
Agresment that may have been

This version is currend as of February 13,
for supersading versions of this End User
subsequer

[[11 accept the terms of the License Agreement

< Back lext Cancel

5. In the Software Type dialog, select VMP Server and Administrator, and click Next.

@ vMP 533 Setup - X
Software Type e
Select type of software you want to instal vOCC (_'J‘

(®) VMP Server and Administrator
(O VMP Administrator

<o Conc

6. In the Destination Folder field, Vocera recommends that you use the default destination folder
provided. To use a different destination folder, type or browse for the folder in which the VMP Server
is to be installed, and click Install. You may need to wait a few moments while the installation process
initializes and copies files.
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@ VMP 533 Setup — be
Choose Install Location e
Choose the folder in which to install VMP 5.3.3. \VOCE] C)‘
Setup wil install VMP 5.3.3 in the following folder. To installin a different folder, dick Bronse
and select another folder. Click Next to continue.
Destination Folder
Space required: 55.9M8
Space available: 58.4GB
<Back Install Cancel

7. In the Create VMP Database Wizard dialog, do the following:

a. In the SQL Server field, enter the SQL Server VMP instance name using the format of ServerName
\InstanceName.

Tip: Vocera recommends that you type the name of the Server and instance name instead of
using the dropdown list.

Create VMP Database Wizard X

SQL Server connection

Configure connection to SAL server. This connection will be used to
create VMP databases. SQL server login should have rights to create
databases and SGL accounts.

QL Server: [VMP\SGL v
Authertication

() Windows Authentffication

(® Sql Server Authertication

Login ‘sa |

Password ""‘""‘“ |

Mesxt > Cancel

b. Select the Sql Server Authentication radio button.

c. Enter the server authentication Login and Password.

d. Click Next.

====1 Note: For details about the SQL Server requirements, see the Vocera Messaging Platform Server
Sizing Guide.

8. Enter a password for the wicapplication and wicauth accounts using the following rules, and click
Next.
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Create VMP Database Wizard X

VMP Database Access

Configure VMP database access. This database stores VMP data and
clients for devices. Setup wil create SQL server login and configure
newly created login permissions to grant access to VMP database.

WMP application SGL account

Login: |wicapplicaﬂon |

Password: |C1|ck here to change.. |

Confim Password: | |

User Authentication Account
Login: |wicaulh |

Password: |Click here to change .. |

Corfirm Password: | |

< Back Next > Cancel

Passwords must be a minimum of 7 characters and include at least three of the following:
* Uppercase letter

* Lowercase letter

* Symbol and/or number

====| Note: Do not change the system account names.

9. In the VMP system Settings dialog, enter the VMP Server public and internal host information and

16

the SMTP settings as shown in the tables below.

Create VMP Database Wizard X

VMP system Settings
Specify VMP system settings

WMP server public host name or ip: | |

WMP server intemal host name or \p:| |

Smtp

Mail server: |smtp |

Mail server port: |25 |

Email address: |\ |

[1 Use authertication

< Back Complete Cancel

Table 3: VMP Server Host Name / IP settings

Setting Description

Vocera Messaging Server Public The IP address or fully-qualified domain name (friendly DNS name) that is
Host Name / IP used to reach VMP when sending email registrations to end-users.

Vocera Messaging Server Internal The IP address or fully-qualified domain name (friendly DNS name) that
Host Name / IP V5000 devices use to reach VMP and the VMP Administrator uses to retrieve
the list of users from a Vocera Voice Server group.

VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



GETTING STARTED WITH VMP

Table 4: VMP SMTP settings

Setting Description

Mail Server The Exchange server name or IP address.

Mail Server Port The port on which the Exchange server resides.

Email Address The email address for sending out installation communications and

receiving server status updates.
Use Authentication Enable the Use Authentication checkbox and enter the credentials, as
these credentials are required to access the Exchange server.

Click Complete.

Tip: Use the DNS name for the external host name to make IP scheme updates easier. If
configuring a device manually, use an IP address.

10If the VMP Server is using a Vocera Voice Server:

Create VMP Database Wizard x

Voice Server Settings

To corfigure the Messaging Server to integrate with your Vocera Voice
Server, complete the following fields

[ Integrate with Voice Server

< Back Next = Cancel

a. Select Integrate with Voice Server.

b. In the Active Voice Server IP field, type the IP address of the Voice server that you want to use. If
you are using a clustered environment, ensure that the IP address of the active Voice server is listed
first.

c. In the Port field, specify the port number that the Voice server is using. In most environments, you
can use the default port number that is provided in the installer.

d. Select Use SSL Authentication if you are using SSL when communicating with the Voice server.

Click Next. If you have enabled integration with a Vocera Voice Server, the VMP installer checks that

the connection to the Vocera Voice Server is working properly.

====| Note: To fully integrate the VMP Server with the Vocera Voice Server, you must configure the
Vocera Voice Server for use with VMP and synchronize the Vocera Voice Server with the VMP
Server. See on page 31 and
on page 50 for more details.

11If the VMP Server is using an Active Directory server:

17

VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



Create VMP Database Wizard

Active Directory Settings

To corfigure the Messaging Server to integrate with your Active
Directory Server, complete the following fields

[ Integrate with Active Dirsctory

< Back Next > Cancel

a. Select Integrate with Active Directory.

GETTING STARTED WITH VMP

b. In the Server Name or IP field, type the domain name or the IP address of the Active Directory

server that you want to use.

c. Select Use Active Directory for Authentication if you want to authenticate using Active
Directory usernames and passwords. The default is to use VMP Server authentication.

d. Select Use SSL Authentication if you are using SSL when communicating with the Active

Directory server.

Click Next. If you have enabled integration with an Active Directory server, the VMP installer checks
that the connection to the Active Directory server is working properly.

====1 Note: To fully integrate the VMP Server with the Active Directory server, you must synchronize

the Active Directory server with the VMP Server. See

page 52 for more details.
12.In the Security Options window:

Create VMP Database Wizard

Security Options

Admin Password: |

Corfirm Admin Password |

] Use S5L for Web and Smartphone connections

Use app PIN for shared devices

] Suppress notfication message content

< Back Mext > Cancel

on

a. In the Admin Password field, type the password to use for the default administrator account.
b. in the Confirm Admin Password field, retype this password.
c. Select Enforce SSL for Web and Smartphone connections to enforce the use of secure

connections.

18
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d. If Use SSL for Web and Smartphone connections has been selected, in the Location of SSL
certificate field, specify the location of the SSL certificate to use with this installation. Click
Browse to display the certificates that are available to you.
e. Select Use app PIN for shared devices if you want to force users to supply a PIN when accessing
this server from the Vocera Collaboration Suite. This sets the Enforce App PIN configuration option
to SHARED. If this checkbox is not selected, Enforce App PIN is set to OFF.

====1| Note: You can override this specification for any individual user. See
on page 122 for more details.

f. You do not need to select the Suppress notification message content option, as message content
is now no longer displayed in notifications.
g. Click Next to continue.
Tip: Vocera recommends that you use SSL to transmit information. If you are using VMP
to transmit confidential patient information, your jurisdiction may require by law that this
information be transmitted securely.

13.The installer creates the VMP databases on the SQL server. When the script is complete, click OK.

14.This release opens the VMP Enterprise Manager after the database script is complete. Normally, you
do not need to make any changes to the VMP configuration at this point. See
on page 265 for details on the VMP Enterprise Manager configuration options.

15 Close the application to complete the installation process. The installer VMP now starts the Vocera Data
Exchange service (referred to as WDE here).

16.Click Finish to close the installer.

17.The VMP Server is now installed. Confirm a good installation by opening a supported Web browser and
pointing to the server URL. If VMP is installed correctly, the VMP Web Console opens at the login page.
For information on supported Web browsers, see on page 193.

The VMP Server must validate any SSL certificate using the existing Windows mechanisms before it will
allow an HTTPS connection to a remote system.

The VMP Server now enforces the following requirements:

* The certificate subject name must match the domain name used for the connection.

» Self-signed certificates must be in the VMP Server's Windows key store.

* If you are using your own internal certificate authority to sign the certificate, the internal CA's
certificate must be in the VMP Server's Windows key store.

* If the certificate uses an IP address, the connection configuration must use an IP address. Similarly, if
the certificate uses a DNS name, the connection configuration must use the same DNS name.

This certificate requirement affects certificates defined for use on the Vocera Voice Server.

====| Note: Vocera Collaboration Suite clients and VMP Web Console clients are not affected by this
behavior.

Before you can use the VMP Server, you must install a valid license. You can do this from the VMP
Enterprise Manager.

1. Start the VMP Enterprise Manager application:
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All Programs > VMP > VMP Enterprise Manager
2. Click the Instances icon.

The Connect To SQL Server dialog box appears.
3. Type the SQL Server administrator credentials.

@ VMP Enterprise Manager
File  Tools

Configuration
Connect To SQL Server

SQL Sewver: [VMP\SQL
Authentication

Instances O Windows Authertification
Plugins

(®) SOL Server Authentication
ton:
Fomvrt

Messaging Platform Server Sizing Guide.

4. In the Licenses tab, select the Install License button.

20
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Note: For more information about the SQL Server credential requirements, see the Vocera
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5. Navigate to the license file and click Open.

Note: The license file is provided by the Vocera order management team. The file is distributed
as a zip file. Extract the license file before you begin the installation.

Note that the license file is changed to an XML format. See The XL License Key Format on page
21 for more details.
6. Click OK to close the install dialog.
The Modules panel displays the details of your license. In particular, note that the PagerInboundEmail,

PagerInboundSOAP, and PagerInboundWCTP fields specify whether your VMP Server is licensed to
use any of the inbound Email, SOAP, and WCTP connections, respectively.

@ VMIP Enterprise Manager - [Instances] — a %
g File Tools -8 %
o PMe 2 e e
g Company Name SID 1 GUID Bq)irecl
» MAIN v |y 721
Configuration

Plugins
ame al
@ | Yes
| Pagerinbounds0AP Yes
ASP Licenses
ez
1=
PagerSMS [] i
= PagerSNPPAWCTP/TAR 0 a
Scheduling Yes

These fields are set to Yes only if your license has enabled them. See [nbound Integration on page 104
for more information on inbound connections.

The XML License Key Format
License keys for VMP are now provided in a file in XML format.

Here's how the XML license key works:
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* This license key file is readable in an XML editor. License keys in the old WLC format are not.

* In the XML license key file, a Messaging module is defined. This replaces the Alert, Chat, Contacts, and
Content modules in the old WLC license key file.

* Only one XML license key file can be defined at any time for a specific VMP installation.

The XML license key file cannot co-exist with an old WLC license key file. When a XML license key file

is imported, all old license keys are removed. Once an XML license key file has been imported, an old

WLC license key file cannot be used.

If you have previously installed the VMP Server, you can use the VMP setup file to upgrade your
installation to the latest version.

Note: For best results, save a backup of the contents of the folder in which the VMP Server is
installed (by default, this is \Program Files\Vocera), and save a copy of the WICMASTER SQL
database.

If you are using an SSL connection, the VMP Server must validate the SSL certificate using the existing
Windows mechanisms. See on page 19 for more details.

1. Stop the Vocera Data Exchange service. See on page 26 for
details on how to do this.

Execute the updated VMP setup file on the VMP installation server.

In the Welcome screen, click Next.

Accept the License Agreement, and click Next.

In the Software Type dialog, select VMP Server and Administrator, and click Next.

Accept the existing Destination Folder and click Install.

In the Create VMP Database Wizard dialog, do the following:

a. Ensure that the SQL Server field contains the SQL instance name that the VMP Server is using.

No gl wN

Create VMP Database Wizard X

SQL Server connection

Configure connection to SGL server. This connection will be used to
create VMP databases. SQL server login should have rights to create
databases and SQL accounts

SQL Server: [VMP\SQL "

Authentication
() Windows Authentification
(@) Saql Server Authertication

Login ‘sa |

Password "““‘“ |

ezt > Cancel

b. Select the Sql Server Authentication radio button.
c. Enter the server authentication Login and Password.
d. Click Next.

====1| Note: For details about the SQL Server requirements, see the Vocera Messaging Platform Server
Sizing Guide.
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8. Click OK to confirm that the existing database will be upgraded.

9. The database wizard now enables you to change the SQL login names that VMP uses. You do not
normally need to change these login names. Click Next.

10.The installer will upgrade the VMP databases on the SQL server. When the script is complete, click OK.

11.If the VMP Enterprise Manager opens after the database script is complete, close the application to
complete the installation process. Click Finish to close the installer.

12 Restart the server.

13.The VMP Server is now updated. Confirm a good installation by opening a supported Web browser and
pointing to the server URL. If VMP is installed correctly, the VMP Web Console opens.

To ensure maximum reliability, you can set up a cluster and install the VMP Server on each node of the
cluster.

For more information on using the Vocera Messaging Platform in a clustered environment, see
on page 96.

When installing the VMP Server in a clustered environment, the first step is to install on the first node of
the cluster.

1. Perform a normal installation of the VMP Server using the steps in on page
13.

2. Test your installation to ensure the server is working properly.
3. Copy the server configuration file, WIC.config, to a folder that the second node of the cluster can
access.

Note: The WIC.config file is located in the VMP installation folder. By default, this is \Program
Files\Vocera\WIC.

After you have installed the VMP Server on the first node of a cluster, you can use the configuration file
from this node when installing on the second node of the cluster.

1. Create the VMP installation folder for the VMP Server. By default, the path is:
\Program Files\Vocera\WIC
2. Locate the copy of the server configuration file, WIC.config, that you created when installing the VMP

Server on the first node of the cluster. Copy this file to the VMP installation folder that you have just
created.

3. Turn off the IIS World Wide Publishing Service. See on page 13 for
instructions on how to do this.

Execute the VMP setup file.
Accept the License Agreement, and click Next.
In the Software Type dialog, select VMP Server and Administrator, and click Next.

In the Install Location field, enter the path of the installation directory into which you copied the
WIC.config file. Click Install.

8. At the Create VMP Database Wizard prompt, confirm that the SQL Server name is correct.

No aw
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Note: The SQL Server name is supplied by the WIC.config file that you copied.

9. Select the Sql Server Authentication radio button, and enter the SA Login and Password. Click
Next.

10.When prompted, click OK to upgrade the database.
11 Leave the SQL Account Configuration page unchanged and click Next.

Note: The account configuration information is supplied from the WIC.config file that you
copied. Do not change this information.

12.Complete the VMP System Setting dialog and all subsequent steps in the Create VMP Database
Wizard as described in on page 13.

If you are using the VMP Server in a clustered environment and you want to install an update, you must
update the VMP Server on each node of the cluster.

1. Stop the Vocera Data Exchange Service on both nodes of the cluster.

2. On the first node of the cluster, follow the instructions in on page 22 to
update the VMP Server.

3. The upgrade installer automatically starts the Vocera Data Exchange Service on the first node of the
cluster. Stop the Vocera Data Exchange Service on the first node of the cluster before proceeding.

4. On the second node of the cluster, follow the instructions in on page 22 to
update the VMP Server.

5. Restart the Vocera Data Exchange Service on both nodes of the cluster.

The VMP Administrator can be installed on a server other than the VMP Server. It can also be installed on
the administrator's personal computer.

To use the VMP Administrator on a standalone computer, you must have the following:

* The installation disk or folder that you used to install the VMP Server.
* The SQL server name and instance name.

* Remote connections enabled on the SQL server.

* The login password for the wicauth account on the SQL server.

* The Active Directory server IP address.

You can use the VMP installation setup file to install the VMP Administrator on a computer other than the
one on which the VMP Server is installed.

1. Locate the installation disk or folder that was used to install the VMP Server. In this folder, start
Setup.exe on the desired computer.

2. Accept the license agreement and click Next.
3. In the Software Type dialog box, select VMP Administrator. Click Next.
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@ VMP 5.3.0 Setup - X
Software Type
Select type of software you want to instal Vocera‘ :

(C)VMP Server and Administrator
(@) VMP Administrator

4. Accept the default Destination Folder, or click Browse to select a custom installation folder, then
click Install.

5. In the VMP Enterprise Manager Configuration window, in the Server row, type the location of the
SQL server that the VMP Server is using. This consists of the IP address or name of the computer that
the SQL server is on, followed by a backslash, followed by the name of the SQL server (for example,
MYCOMPUTERNAME\SQLSERVERNAME).

[ VMP Enterprise Manager - [Configurator] * (== = ]
|| & File Tools _ 8 x
£} Advanced Options [ Save & Reset
Name Value
» Database
@ " futh
&} Login wicauth
3 Password =
&) Confirm Passwiord —
€3 Server (llocal) |

WDE
T3 Active Directory Server

€} Connect to Active Directory over SSL false
€3 Allow any Active Directory user to login (displaylo.. false
£} Enable automatic login using Active Directory auth.. | false

(€4 Allow current logged domain user to login (display..  false

6. In the Auth section, in the Password field, type the password for the wicauth account on the SQL
server. This account was created when the VMP Server was installed.
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, ,
e =
o File Tools -8 X

£} Advanced Options [ Save & Reset

Name Value
4 Database
- Auth

C

I © Login wicauth

€3 Password — |
| €} Confirm Passwiord -

5 Server (local)

WDE
I {C4 Active Directory Server
[ €} Connect to Active Directory aver SSL false
I €3 Allow any Active Directory user to login (displaylo.. false
£} Enable automatic login using Active Directory auth... | false
(€4 Allow current logged domain user to login (display..  false

L J

7. In the Confirm Password field, retype the password for the wicauth account.

8. In the WDE section, in the Active Directory Server row, type the IP address for the Active Directory
Server.

& VMP Enterprise Manager - [

al File Tools -8 x

£} Advanced Options [ Save & Reset

Name Value
13 Database

futh

&} Login wicauth

€3 Password -

€3 Confirm Passwiord —
£ Server {local)

WDE
103 Active Directory Server |
€} Connect to Active Directory over SSL false
€3 Allow any Active Directory user to login (displaylo.. false
€} Enable automatic login using Active Directory auth . | false
(€4 Allow current logged domain user to login (display..  false

— = = C—— J

9. Click Save and close the VMP Enterprise Manager.
10.Click Finish.

If you are installing a standalone VMP Administrator to work with a running VMP Server, you will
need to configure your Vocera Voice Server to add this new installation to the list of recognized VMP IP
addresses. See on page 31 for details.

ensure that the connection to the SQL server is working properly.

=| Note: If the standalone VMP Administrator does not start properly after you have installed it,

When you install the VMP Server, it is automatically started for you. To restart the server, you must
restart the Vocera Data Exchange service.
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Like any other service running on Windows, the Vocera Data Exchange service can be stopped, started, or
restarted.

1. Open the Windows Services application:

Windows > Start > Administrative Tools > Services
2. Click to select Vocera Data Exchange Service.

3. Right-click and select one of the following:

e Start: start the Vocera Data Exchange service.

* Stop: stop the service.

Restart: restart the service.

The VMP Server log files provide information on actions performed by the VMP Server. This can be useful
if an unexpected error occurs. You can control what goes into these log files.

The server log files are stored in the WIC\Logs subfolder of the folder in which the VMP Server is
installed. By default, this is C: \Program Files\Vocera\WIC\Logs.

You can use the VMP Enterprise Manager to specify what message levels are to appear in log files.

1. From the VMP Server, start the VMP Enterprise Manager.
Start > All Programs > VMP > VMP Enterprise Manager
2. Select Configuration.

27

o

)3
a3

Configuration

The Configuration window appears.
Scroll down to the Logging section.

Click in the Value column of the Limit log messages to VMP Log File field. From the dropdown list
that appears, select one of the following:

Table 5: Logging options

Option Description

Do not log Do not write to the log files.

Write all events Keep a record of all VMP Server events.
Warnings and Errors Write only warnings and errors to the log files.
Errors Write only errors to the log files.

!

. Click Save to save your change.

Important: In a live environment, you should not set Limit log messages to VMP Log File

to Write all events and set Enable extended communication logging to true, as this may
cause patient-sensitive data to be written to the log files. The Enable extended communication
logging setting appears when you click Advanced Options.
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& VMP Enterprise Manager - [Configurator]

& File Tools

£} Advanced Options [ Save &, Reset

| hame

€} Enable automatic Web login

£} Do not show YMP instances on Wb login page:
€} Connect to Active Directory over §5L f
€} Enable automatic Ingin using Active Dirsctory authentication

GETTING STARTED WITH VMP

In the event of a failover scenario, the VMP Server log files include a log entry describing the failover
to a standby server and the startup details for the new active node. For more information on clustered
environments and failover, see

on page 96.

If the SQL Server database has been updated, and some or all of the SQL accounts that the VMP Server
uses have been removed, you can update the VMP Server to use the changed accounts.

1. Start the VMP Enterprise Manager.
2. From the Tools menu, select Fix VMP Accounts.

28

a WMP Enterprise Manager - [Configurator]

ol File | Tools
Mai Fix VIMP Accounts

APl Key
o . ¥ Sa
% Name
g 5o €3 NetworkSecure
Connect To S0L Server x
SQL Server: [VMP\SQL v

Puthertication
(O) Windows Authentification
(® 50L Server Authertication
Login || |

Password | |

Canc

. In the Connect To SQL Server dialog box, supply the SQL Server authentication:

a. Select the authentication method to use by selecting either Windows Authentication or SQL

Server Authentication.

b. If you have selected SQL Server Authentication, enter your SQL login and password in the Login

and Password fields.

c. Click OK. The Fix VMP Accounts window appears.
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Fi VMP Accounts x

o e
Login
N
| wicappii
VMP SQL Account 5QL Login
» wicauth w
Instance: MAIN wicapplication ~
Sty
4. To add a new SQL account:
a. Click Add.

The New SQL Login dialog appears.

MNew SQL Legin *

Login: “ |

Password: ‘ |

Confimn Password: ‘ |

In the Login field, type the new SQL account name.
In the Password field, type the password for the new SQL account.
In the Confirm Password field, retype the password for the account.
e. Click OK.
5. To edit an SQL account:
a. Highlight the account that you want to edit, and click Edit.

a e o
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The Edit SQL Login dialog appears.

Edit 50L Login *

Login:

Password: ‘Click here to change... |

Confimn Password: ‘ |

Cancel

b. In the Login field, edit the SQL account name if needed.

c. In the Password field, type the new password for the SQL account.
d. In the Confirm Password field, retype the new password.

e. Click OK.

. To delete an SQL account, highlight the account that you want to delete, and click Delete.

Fix VMP Accounts X
SQL Logins
[+ i ]

Login

-

wicapplication

In the confirmation dialog box that appears, click Yes.

. To change a VMP SQL account, in the VMP SQL Accounts pane, select the account that you want to

change:
* Authentication: The user authentication account.
* Application server: The VMP system application account.

* Instance: name: The account that you use to log in to the VMP Server database named name. A
standard installation of the VMP Server has a database named MAIN.

From the dropdown list in the SQL Login column, select the VMP SQL account that you want to use.

. Click Start fixing. This runs a script that updates your SQL database. The progress of the script is

displayed in a dialog box.

9. When the script has completed, click OK to close the display window.
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After you have installed the VMP Server, you must integrate it with the other Vocera products and servers
in your environment.

Vocera Voice Server to VMP integration enables Vocera Collaboration Suite users to make Calls and use
other Vocera Voice Server capabilities from their devices.

====| Note: Vocera Voice Server is integrated with the platform as a connector and no additional
licensing is required.

To configure the VMP Server to integrate with Vocera Voice Server, prepare the following:

Table 6: Vocera Voice Server configuration requirements

Configuration Requirement Description

Vocera Voice Server Software Requirements See on page 10 for
information on software requirements.

Vocera Voice Server Credentials You must have administrator access to the Vocera Voice
Server.

VMP Server IP Address You must have the VMP Server IP address.

Vocera User Email Address If using the default setting, make sure that each Vocera

Voice Server user profile includes the user email
address. Or see

on page 66 for details on how to
synchronize the Vocera User ID field with a field in the
Active Directory source.

The following Vocera Voice Server components must be installed to use the VMP Server with Vocera
Collaboration Suite:

» Vocera Client Gateway: required for Wi-Fi calling
» Vocera SIP Telephony Gateway: required for cellular calling

To configure the Vocera Voice Server and VMP to work together, you must access the Vocera Voice Server
Administration Console and the VMP Administrator to make the necessary changes.

1. Open the Vocera Voice Server Administration Console.
2. Log on with your administrator credentials.
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3. Select the System view.
4. Select the License Info tab.

License Info Passwords Preferences b

Company Name

VAl Application IP Addresses (comma-separated list)
10.37.43.128|

License No.: 25 Speech Ports:

Locale: United States

’— General License Info.

Spoken Mame
Count:

5. In the VAI Application IP Addresses field, type the VMP Server IP address. For load balanced
environments, use comma-separated values.

If you have installed the standalone VMP Administrator on a separate computer, and you want to
synchronize the VMP Server and Vocera Voice Server from this computer, you must add this computer's
IP address to the list.

Note: If you are using other VAI applications, the IP address for VMP must be the first IP
address listed in the VAI address field.

6. Click Save Changes.
7. Click the Preferences tab.

8. If the Enable Auto-Logout Period checkbox is selected, set the auto-logout period to a value greater
than 1 Minute. This ensures that clients that use the i0S operating system are not unexpectedly logged
out.

(] Enable Auto-Logout Period

off
Auto-Logout Users after 2 Hours v network.

9. Select the Enable VMP checkbox.

[#| Enable vMP

’7V|}cera Messaging Platform (VMP)

10.Click Save Changes.
11.Start the VMP Administrator:
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All Programs > VMP > VMP Administrator
12In the VMP Login dialog, type admin and the password for the administrator account, and click OK.
13.Select Configuration > System Options.

System Options

The System Options dialog box appears.

14 Scroll down the System Options dialog box to the Vocera Voice section. This displays the Vocera
Voice Server configuration options.

System Options X
Enabled Yes 2
Enabled Yes
IP Addresses 152.168.2.114
Port 80
Use HTTFS No
VCG IP Addresses 192.168.2.113
WMI Message Expiry (in minutes) 5
Enable Enhanced Vioice Server NIO Tomcat Feature No
Retain call and voice mail histary in the database (days) 14
Use VCG for VCS client connection management Yes
Send user-generated messages to Vocera badges Yes
Consider Call Forwarding in User Presence Status Yes
Prevent voice enunciation on usergenerated messages No
Allow Accept/Decline for Urgent Calls No
Show integration messages on device lock screen Mo
v
[ ok || cancel || Heb |

Important: If you change any of these values, you must manually restart the VMP Server by
restarting the Vocera Data Exchange Service. See on page
26 for details on how to do this.
15.Set the Enabled option to Yes.
16 If the IP Addresses field was not specified when you installed VMP, provide it. If you are using more
than one Vocera Voice Server in a clustered environment, separate the IP addresses with commas, and
ensure that the active Vocera Voice Server is listed first.

17In the Port field, enter the Vocera Voice Server port number. The default port number is 80.
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18.Set any other configuration options as needed. See on page
258 for descriptions of these options.

19.Click OK to save your changes.

After you have configured the Vocera Voice Server and VMP to work with one another, the next step is
to import the Vocera Voice Server contacts into the VMP Server. See
on page 50 for information.

If your Vocera Voice Server has enabled Non-Blocking I/O (NIO) connectivity with Tomcat, you can
configure VMP to use it.

This allows more than 2000 simultaneous Vocera Collaboration Suite clients to connect.

Vocera Voice Server on a different port. The connection is on port 8080, unless you have manually
edited the VMP Server configuration to use some other port. (Normally, Vocera Collaboration Suite
clients connect to the Vocera Voice Server on port 80 if SSL is disabled, or port 443 if SSL is enabled.)
This port change could affect connectivity if you are filtering traffic between the wireless VLAN
used by VCS clients and the Vocera Voice Server.

@ Important: When this capability is enabled, Vocera Collaboration Suite clients connect to the

To enable enhanced Vocera Voice Server NIO Tomcat support:

1. Start the VMP Administrator.
2. Select Configuration > System Options.

@ vvP (Default adi

P

The System Options dialog box appears.
3. Scroll down to the Integrations > Vocera Voice section.
4. Set the Enable Enhanced Voice Server NIO Tomcat Feature option to Yes.
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System Options X
Web Console Date Format MMM /dd Ay ~
Enabled Yes

Wegors
VecemVoee |
Enabled Yes
IP Addresses 1921682114
Port a0
Use HTTFS No
VCG IP Addresses 192.168.2.113
WMI Message Expiry (in minutes) 5
Enable Enhanced Voice Server NE) Tomeat Featurs No I
Retain call and voice mail history in the database (days) 14
Use VCG for VCS client connection management Yes
Send user-generated messages to Vocera badges Yes
Consider Call Forwarding in User Presence Status Yes
Prevent voice enunciation on user-generated messages No
Alow Accept/Decline for Urgent Calls No
Show intearation messanes an device lock screen o hd
D o
'Whether or not Patient Context integration is available
Cancel Help

5. Click OK to save your change.

When you are creating Vocera Collaboration Suite users, you must create them as Vocera Voice Server
users, not as Vocera Voice Server address book entries.

This ensures that the Vocera Collaboration Suite users will have voice capabilities.

When importing users into VMP from an external source, you can create a spreadsheet of address book
entries to be exported to the Vocera Voice Server.

This enables badge and Vocera Collaboration Suite users to contact these imported users using the Vocera
Voice Server voice recognition capability (the Genie).

To export address book entries to the Vocera Voice Server, select the Export Address Book Entries to
Vocera checkbox when synchronizing users in the VMP Administrator.

====| Note: If a VMP user is using the Vocera Collaboration Suite client and wants to use the Genie from
this client, this user must also be a Vocera Voice Server user, not a Vocera Voice Server address book
entry.

Vocera Secure Texting (VST) extends the reach of your VMP messaging capabilities to include employees of
your affiliated organizations.

When VMP is integrated with the VST cloud platform:

» Your on-premises badge and VCS users will appear properly in the VST Directory, allowing VST users
to send messages to them. VST users in your own organization and also your affiliated hospitals and
practices appear in the VST Directory as well.

* Both your internal VST users and also the users of your affiliated hospitals and practices appear
properly in the Contacts list of the VCS app, if you have the VMP integration. Badge users and your
organization's VCS users continue to appear in the VCS Contacts list as well.
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e The messaging and voice capabilities of your on-premises solution are integrated with the VST
messaging and basic voice capabilities of the cloud platform.

@ Important: VST 2.1 or later is required.

You can configure the VMP Server to enable messages and images to be exchanged between Vocera
Collaboration Suite users and VST users.

When this capability is enabled, VST users are automatically imported from the VST cloud server into the
VMP Server.

Important: VST 2.1 or later is required. If you have previously installed the VST Sync Connector
in your on-premises network, you must uninstall it before enabling VST message exchange on the
VMP Server. See the VST Hospital Administrator Guide for information on upgrading existing VST
integrations.

1. Start the VMP Administrator.

2. Select Configuration > System Options.

@ vMP (Default adi

System Options

[

The System Options dialog box appears.

3. Scroll to the Integrations section, and then to the Vocera Secure Texting App - Message Exchange
subsection.

4, Set the Enabled field to Yes.
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System Options X
Use VCG for VCS client connection management Yes ~
Send user-generated messages to Vocera badges Yes
Consider Call Forwarding in User Presence Status Yes
Prevent voice enunciation on user-generated messages Mo
Alow Accept/Decline for Urgent Calls No
Show integration messages on device lock screen Mo
e
Enabled No
ocera ecure |exting App £5s3ge change
Enabled Yes ~
User ID
Shared Key
Manage VST Contacts Voice
I
Enable Secure Message Initiation No
e e N
Protocol FOP3
Fmail Scan Interval in seconds) a0 hd
D o

Setting this to "Yes" enables message and images to be exchanged between users of the Vocera
Collaboration Suite and the Vocera Secure Texting mobile applications

Cancel Help

organization.

and the connected Vocera organization.

VMP SERVER INTEGRATION

. In the User ID field, type the ID that the VST cloud server uses to identify the connected Vocera
. In the Shared Key field, type the key that authenticates the connection between the VST cloud server

. In the Manage VST Contacts field, select Voice to manage your VST contacts on the Vocera Voice

Server, or select VMP to manage your VST contacts on the VMP Server.
If you are managing your VST contacts on the VMP Server, VMP creates the VSTContacts distribution

list to contain them.
Click OK to save your changes.

. On the computer on which the VMP Server is running, ensure that outgoing connections on port 443

are not blocked by your firewall. The VMP Server uses this port to transmit information to the VST

SEerver.

The User ID and Shared Key fields are generated from the VST Administration Console. See the VST
Vocera Administrator Guide for more details.

When the VMP Server synchronizes with the VST cloud server, all VST users on the cloud server are
imported into the VMP Server as VMP users. These users also automatically become members of the VST
Users Distribution List. To control which VMP users can view these VST users as contacts, specify access
permissions on this Distribution List. See
details.

on page 159 for more

Messages sent to merged VST are sent to either the VST client or the badge based on predefined rules.
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Conversation-based messages are delivered to VST clients, not to badges.
User-generated notifications from the VMP Web Console, VCS, and Staff Assignment are delivered to

VST clients, not to badges.

Third-party system-generated notifications from sources such as VMI, email, WCTP, and CWE are

delivered to badges, not to VST clients.
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You can use the VMP Enterprise Manager to configure VMP to work with an Active Directory server.

The following configuration options are available:

* You can configure the VMP Server to interact with Active Directory using an SSL connection.

* You can allow users to log into the VMP Administrator or VMP Web Console using their Active
Directory username and password, provided you have granted permission to these users.

If you specified an Active Directory server when installing VMP, some of the fields described here have
already been supplied.

=== Note: Sece

on page 122 for more information on how to edit user

information to grant user access to the VMP Administrator or the VMP Web Console.

====| Note: If you have previously imported users from an Active Directory server, you must supply the
= same server information here. See

1. Start the VMP Enterprise Manager application:

All Programs > VMP > VMP Enterprise Manager

2. Select Configuration .

The Configuration window appears.
3. Scroll down to the Active Directory Server field. If this field is empty, type the domain name or the

IP address of an Active Directory server.

on page 52 for details.

If your Active Directory server is not using port 389, you must specify the port number. For example,
for an Active Directory server on vocera.com using port 50000, specify vocera.com:50000.

4. If you want to use SSL with Active Directory, set the Connect to Active Directory over SSL to true.

@ VMP Enterprise Manager - [Configurater]

gl File  Tools

Main

=

Configuration

Instances

@

Plugins

s

ASP Licenses

€} Advanced Options Save i Reset
Name

103 Server

Services
WOE
£ Networknterface
3 NetworkPart
£} NetworkSecurePort
03 NetworkSecureCertificate
€3 NetworkSecureE rforcewehS5L
I3 EnablewebServer
£} Enable automatic Web login
I3 Enable no authentication for web Iogin
€3 Do not show VMP instances on Web login page
0} Active Ditectary Server

Value
DTILLWMPASOLEXPRESS

0.0.0.0
Ell
443

false

tiue

tiue.

false

falze
1921682112

| £} Connect to Active Directory over 551

false

£ Allow any Active Divectory user ko Iogin (display login/password form]
€} Enable automatic login using Active Directory authentication

Al enwrant lonnad domain e b lnmin (diendan fnk

false
falze

falea

e —
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5. If you want to enable users to use their Active Directory usernames and passwords to access either the
VMP Administrator or the VMP Web Console, depending on granted permissions, set Allow any Active
Directory user to login (display login/password form) to true.

& VMP Enterprise Manager - [Configurator] - o x
Wl File Tools .8 x
Main |-
€3 Advanced Options B Save i Reset
Name Value ~
- \qu £ MetworkS scursE rhorceiw sbSSL e

EE £} EnablewebServer tue
€} Enable automatic Web login e
(€3 Enable no authentication for Web login false
€} Do not show YMP instances on ‘et login page false
€3 Active Directoy Server 192168.2112

€} Connect to Active Directory ower $5L false

oy

Instances

I 03 Allow any Active Directory user to login (display login/passwerd form) false I

. Enable automatic login using Active Directary authentication false
(€3 Allow curent logged domain user to login (display fink] false
SMTP

& ®

03 Server smtp
€3 VMP emall diil@vocera.com
Logging
€3 Limit log messages to WMP Log File “white all events
s €3 Limit Iog messages to Windows Event Log Enors .
- —

6. Save the configuration changes. In the confirmation dialog, click Yes to restart the VMP Server.
7. Click OK to close the restart dialog and complete the configuration.
8. Close the VMP Enterprise Manager.

====| Note: If you have set up VMP in a clustered environment, you must repeat these instructions for
= each cluster node on which the VMP Server is installed. To ensure the least amount of down time,
integrate the Active Directory on the standby server first, then repeat on the active server.

You can integrate VMP with one or more Engage servers. This enables users to add information on a
patient to a message conversation and view alarms sent by patients or care providers as notifications.

Two types of connections are supported:
* Connections to the Engage Patient Context Adapter, which enable users to add information on a patient
to a message conversation.

* Connections from Engage to the VMP SOAP interface, which send alarms sent by patients or care
providers as VCS or VMP Web Console notifications.

====| Note: If you plan to use Engage with VMP, a member of the Vocera Professional Services team will
install and configure it for you. Contact your Vocera representative for more details.

To integrate the VMP Server with an Engage environment:

* Ensure that the Active Directory server that your Engage environment is using is also integrated with
the VMP Server. This ensures that both the Engage server and the VMP Server use a common user

identifier. See on page 38 for more information on integrating
VMP with Active Directory.

» Specify the following when adding Engage server information:
* The Engage Patient Context Adapter that you are using.
* If you are displaying waveform information, the AirStrip ONE platform that you are using.
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* Create one or more VMP users and grant access rights to the SOAP API gateway. Engage uses this
gateway to send alarms as notifications. See on page 45 for details on
how to enable Engage SOAP access for a VMP user.

====1| Note: If you are upgrading from a previous version of Vocera Voice Server while integrating VMP
with Engage, and are therefore replacing a connection between the Engage server and the Vocera
Voice Server with a connection between the Engage server and VMP, the Vocera Voice Server VMI
license that you have been using for the Engage integration is now freed up.

You can configure the VMP Server to obtain information from one or more Engage Patient Context
Adapters. This enables Vocera Collaboration Suite and VMP Web Console users to include links to patient
information in message conversations.

1. Start the VMP Administrator.
2. Select Configuration > System Options.

@ vvP (Default adi

Systern Options

=

The System Options dialog box appears.
3. Scroll to the Integrations section, and then to the Patient Context subsection.
4. Set the Enabled field to Yes.
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WMI Message Expiry (in minutes)

Retain call and voice mail history in the database (days)

Send user-generated messages to Vocera badges

Prevent voice enunciation on usergenerated messages

Show integration messages on device lock screen

Enabled

Enabled

Shared Key

Yes

Mo

No

Mo

No

[ox ] cancel |

Help

VMP SERVER INTEGRATION

5. In the VMP Administrator, select Configuration > Engage Servers.

6. In the Engage Sites window, click the Add icon.

4]

The Engage Sites and Edit Site panels appear.
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Engage Sites Edit Site
Server aptions
Site Name: Defaut Ste Engage Client ID
Adapter URL
Adapter Authentication Key
Airstrip Enabled No v
Mapped Voice Sites [m]

If the Engage site that you are adding is to be the default site, select the Default Site checkbox.

oe ‘|Suvan|jirl|5

Site Name: 4 Defaul Site:

8. In the Edit Site panel, supply the following information for your Engage site.

a.

b.
c.

42

In the Engage Client ID field, type the client ID that the Engage server uses to represent your VMP
Server.

In the Site Label field, specify the name that you want to use to identify this Engage server.

In the Adapter URL field, type the URL of the Engage Patient Context Adapter. An example URL is
http://172.30.1.1/myadapter/PatientContext/api/1.

In the Adapter Authentication Key field, type the key that authenticates the connection between
the VMP Server and the Engage Patient Context Adapter.

If your Engage server is integrated with an Airstrip platform that displays waveform data for
patients whose information has been obtained through the server's Engage Patient Context Adapter,
set Airstrip Enabled to Yes.

If Airstrip Enabled has been set to Yes:

* In the Airstrip Shared Key field, type the Airstrip authentication field.

* In the Airstrip Site ID field, type the Airstrip site ID.

To map a VMP Server site to this Engage server:

e Click the icon in the Mapped Voice Sites field.
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e In the Edit Mapped Voice Sites window, click the Add icon.

* In the Select Sites window, select the site or sites to map, and click OK.

* (lick OK in the Edit Mapped Voice Sites window.
9. To add an additional Engage site, click the Add icon again and repeat the preceding steps.
10.Click OK to save your changes.

11.The next step is to create a VMP group containing the users that have permission to access the Engage
Patient Context Adapter. To do this, select Users & Groups > Groups.

. Note: You can also use an existing group, if this fits better with your group organization.

12If you are creating a new group:
a. In the toolbar in the Groups pane, click Add.

43 VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



VMP SERVER INTEGRATION

b. In the New Group dialog box, enter the name of the group (for example, Engage Group), and click
OK.
131In the Groups view, select the group that is to receive Engage Patient Context Adapter permissions, and
click the Permissions tab.
14 Select the Patient data access checkbox.

I Fatient data zcoess

After you have created this group, if you are viewing a user who is a member of the group, and you select
the Member of tab, the Patient Data Access column indicates that the user is a member of a group that
has patient data access.

Member of Content Distribution Lists  View Serit By - Text Messages  View Received By - Text Messages  Messaging Templates
0o ®

Name . Patient Data Access Ste
3 Yes

The user is also listed as having the Patient Data Access user right:

- | Patient data access

This user right is not editable in the Edit Rights dialog box.
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Enabling Engage SOAP Access

You can create a VMP user and enable SOAP access for this user from Engage.

Note: To enable SOAP access from Engage, VMP must be licensed to use the Pager Inbound SOAP
Connector. By default, VMP licenses do not include this connector. See Configuring the VIMP License
on page 19 for more information on licensing.

Important: You must create a new VMP user to access SOAP from Engage. If you use an existing
VMP user, SOAP access may not work properly.

1. From the VMP Administrator, select Users & Groups > Users.

S

Users

2. In the toolbar in the Users pane, click Add.

The End-User Settings window appears.
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Step 1: End-User Settings

Step 1- End- Settings First Mame: |

Step 2: Push Technology and Licensing Middle Name:

Last Name:

Title:

Public 1D:

Pager ID:

|
|
|
|
Email: |
|
|
|

Vocera ID:

Home Site: |

Auto Forwarding

Allow Forwarding: | Follow System Settings (Yes) ~

Forward To: |

Profile:
Deskiop and Web Access
] Enable PC Admin Console Access
] Enable Web Console Access

Vocera credentials

Login: |

Fassword: |

Corfirmation: |

MNext = Cancel Help
3. Enter the following end-user settings.
Table 7: End-user settings
Field Description
First Name The first name of the user.

Middle Name

Last Name The last name of the user.
Title The job title for the user.
Email The email address for the user.

Enable PC Admin Console Access

Vocera credentials

VMP SERVER INTEGRATION

The middle name of the user (optional).

Select this checkbox to allow the user to access the VMP Administrator.

Provide Vocera credentials for the new user: enter a unique user name in

the Login field, enter the password in the Password field, and re-enter
the password in the Confirmation field.

4. Click Next to display the Push Technology and Licensing window. Ensure that the Enable checkbox in

the Mobile Device Access section is cleared.
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5. Click Finish to create the user.
6. In the Users view, select the user that you have just created.
7. In the toolbar, from the User preferences dropdown list, select User rights.

Email

& Unlock user clu@tdtill local
& Applications on device

@ Plugins configuration
& Retrieve Application Logs

Memberof Content Distribution Lists  View Sent By - Text Messages  View Received By - Text Messages  Messaging Templates

©o|n ®
Name »  Patient Data Access Site
» No

The Edit Rights dialog box appears.
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Edit Rights X

» O
[ Contacts managsr [ | Assign documents to devices
[ | Content manager [ Change system ssttings
[ | Distribution lists manager [ | Create/zdit /delete VMP users
[ | Groups manager [ | Defautt email intiation user
[1| Own group manager [1| Manage all documerts
[]| Paging API Gateway [ Manage all groups
[ Reports viewsr [ | Manage all schedules
[ | Superuser [ | Manage contact distribution lists
[ | System manager [] | Manage contact sources
[ | Users manager [ | Manage distribution lists
[1| Manage groups user belongs to A
R Deserption |
[ ok || cance | Hep |

8. In the Rights pane, select Allow access to Paging API Gateway.
9. Click OK.
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Use the VMP Administrator to import users and contacts into the VMP Server from one or more sources.

If a user with the same email address, Public ID, Pager ID or Vocera ID is imported from multiple sources,
the VMP Server merges the information from these sources into a single VMP user entry.

====| Note: A user and a contact are linked if the email address is the same for both.

You can import from any or all of the following sources:

* Vocera Voice Server: see on page 50
* Active Directory: see on page 52

* Excel and CSV files: see on page 55
e SQL: see on page 57

You can synchronize the VMP Server with its sources to ensure that the list of users and contacts is
kept up to date. You can start the synchronization process manually, or configure the VMP Server to
synchronize at regular intervals.

Vocera Secure Texting users are automatically imported when VST message exchange is enabled. See
on page 36 for more details.

Attention: Each user or contact on the VMP Server must have a unique email address, Public ID, Pager
ID, or Vocera ID, as these fields are used as key fields. If multiple users or contacts have the same email
address, Public ID, Pager ID, or Vocera ID, the VMP Server may not operate as expected.

Tip: You can customize the field mappings that the VMP Server will use when importing users or
contacts. For details about source field mapping, see on page 187 and
on page 186.

====| Note: BlackBerry Enterprise Server (BES) sources are included in the list of available source types,
but are no longer supported.

When importing from sources into the VMP Server, you can import both users and contacts.

A user is anyone who can send or receive a message from a licensed device, from the VMP Web Console,
or by email. Most users are employees who have application licenses assigned to them. Some users who
generate messages but do not receive them do not need application licenses.

Contacts are parties who may or may not be part of your organization, but with whom critical and
frequent communication occurs. You can think of contacts as a set of employees and non-employees who
are entered into the system with one or many contact points for easy communication.
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Importing Users From Vocera Voice Server

If you plan to integrate the VMP Server with a Vocera Voice Server, you must import the Vocera Voice
Server users into the VMP Server.

Note: See Vocera Voice Server Integration on page 31 for information on integrating the VMP
Server with a Vocera Voice Server.

VMP users, ensure that each Vocera Voice Server user has an email address defined. This prevents
duplicate user entries. This does not apply if you are matching Vocera Voice Server user IDs to Active
Directory fields.

@ Important: If you are using the email address field to match Vocera Voice Server users with

Note: If a Vocera Voice Server user has been linked to a Vocera Secure Texting account, this user
cannot access the Vocera Collaboration Suite.

1. Select Users & Groups > Users.

S

2. Click Synchronization in the Users view.

orMe o e|2]e

D efault administiator
Grace Morgan
Jen McMaster

3. If you have previously imported one or more sources into the VMP Server, the Reconfigure/
Synchronize only window appears. Select Yes, reconfigure settings and click Next.
4. In the User Synchronization dialog, click Add primary source with users (under Sources).

50 VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



ABOUT IMPORTING AND SYNCHRONIZING

5. Select Vocera from the Source type dropdown list. This selection auto-populates the Title field. You
can accept the default title or customize the title.

Add Primary Source With Users x

Title
|Vocera |
Source type

Vocera

BES 4.0

BES 41

BES 5.0
csv

Generic Excel

Ms SEI Server

Options

Licenses Mo defautlt licenses

[] Enable Weh Console Access

[] Automaticaly send email registration

Concel ||t

6. Set Import departments as groups to Yes if you want to import Vocera Voice Server departments
into the VMP Server as VMP groups.

Edit Source

Title

Source type

Vocera
Settings:

Import departments as groups Mo

Options

Licenses Mo defautt licenses

Enable Web Console Access

[ Automaticaly send email registration

Cancel Help

====1| Note: The availability of this feature depends on the Vocera Voice Server version that you have
installed.

. Optionally specify the import source options described in on page
59.

. Click OK to close the dialog.
. Follow the steps in

on page 60 to synchronize the Vocera Voice
Server users and contacts with the VMP Server.
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Importing Users From Active Directory

The VMP Server can synchronize with an Active Directory or an Active Directory Lightweight Directory
Service to import Organizational Units, security groups, and Distribution Lists. When an import is
complete, VMP has the ability to convert the Organizational Units to VMP Distribution Lists.

1. Select Users & Groups > Users.

&

Users

2. Click Synchronization in the Users view.

D efault administiator
Grace Morgan
Jen McMaster

3. If you have previously imported one or more sources into the VMP Server, the Reconfigure/
Synchronize only window appears. Select Yes, reconfigure settings and click Next.
4. In the User Synchronization dialog, click Add primary source with users (under Sources).

5. Select one of the following from the Source Type dropdown list:
» Select Active Directory LDS if you are using an Active Directory Lightweight Directory Service.

Add Primary Source With Users x

Title:

|Active Directory LDS |
Source type:

[ Active Directory LDS v
Active Directon

EES 4.0
BES 41
BES 5.0
CSY
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» Select Active Directory if you are using a standard Active Directory service.

Add Primary Source With Users

Title

X

Active Directory

Source type:

This selection auto-populates the Title field. You can accept the default title or customize the title.

====1 Note: You cannot add both an Active Directory source and an Active Directory LDS source.

6. In the Connection Parameters section, enter the Active Directory or Active Directory LDS

53

credentials.

Edit Source

Title

|Ac‘tive Directary

Source type
Active Directory
Settings:

Connect over S5L No

Password

Sync Organizational Units Mo
Sync Security Groups Yes

Sync Distribution Groups Mo

Conffim Password _

Host 152.168.2.112
Port 389

Usemame Administrator

Options
Advanced Fiters No fiters
Licenses. Mo default licenses
Enable Weh Console Access

[ Automaticaly send email registration

Canel

Help

Add Primary Source With Users

Title

Active Directory LDS

Source type
Active Directory LODS
Settings:

Port 389
Connect over S5L No
Usemame

Password

Confirm Password

Maming Contesdt

Domain Mapping

Sync Organizational Units Mo

Host 1521682112

Options
Advanced Fiters Mo fitters
Licenses Mo defautt licensss
[] Enable Weh Console Access
[ Automaticaly send email registration

Canel

Help
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Note: The Active Directory server, port, and SSL connectivity information supplied here
must match the information supplied when installing VMP or in the VMP Enterprise Manager
configuration options. See on page 38 for more details.

For the Active Directory LDS source, you must provide the following additional fields:

+ Naming Context: The Active Directory LDS naming context that contains the groups and users that
you want to synchronize with VMP.

Select a naming context from the list provided.

Domain Mapping: The domain name mapping to use, in the format mydomain.com = MYDOMAIN.
For example, if your Active Directory LDS source users have email addresses such as
user@voceradomain.com, the domain mapping

voceradomain.com = VOCERADOMAIN

indicates that these addresses can be accessed as VOCERADOMAIN\user, which is the format that the
VMP Server requires.

====| Note: The service account that connects to LDS must have reader access for the default
naming context.

7. Configure the following options using their associated dropdown lists:
* Sync Organization Units
* Sync Security Groups
* Sync Distribution Groups

8. Optionally specify the import source options described in on page
59.

9. Click OK to close the dialog.

10.Follow the steps in on page 60 to synchronize the Vocera Voice

Server users and contacts with the VMP Server.

If your Active Directory server includes user photographs in the thumbnailPhoto source field, you can
ensure that these photographs are displayed in the Vocera Collaboration Suite.

1. Create a contact source for the Active Directory server. See on page
67 for details on how to do this.

2. In this contact source, map the Personal Photo contact field to thumbnailPhoto, and set the Key and
User Key checkboxes in the row that contains the Email contact field.
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Edit Contact Source X

Field Mapping
Contact Synchronization is an automated procedure defined by the VMP Administrator whereby all contact records stored on all remote
sources that the VMP system is referencing are checked for changes, and any new or changed Contact information is detected and pushed
out to the appropriate VMP-enabled devices.

Recorfigure/Synchronize only
Contact Source Name
Remote Sources

Select Contacts.

Contact/DL Synchronization
Field Mapping

& .

Contact field Source Source field Key UserKey
w}\mm Direct. . | | thumbnailPhoto |

First Name Active Direlt-=ag,_First name ~ [

Middle Name v T M=

Last Name Active Direct .~ | Last name \ ~ O

BlackBeny PIN v e

Email Active Direct... ~ | E-mail ~|

Phaoto ~ ~

Image 1 ~ ~ w

| <Back | Fmsh || Cancd |  Hep

3. Create a Contacts Distribution List for the Active Directory users for which photos are to be displayed.
See on page 137 for more details.

If your list of users is stored in an Excel spreadsheet or CSV file, you can import these users into the VMP
Administrator.

Tip: Avoid using an Excel or CSV file as a user or contact source if at all possible, as difficulties may
arise if this file becomes no longer available.

1. Select Users & Groups > Users.

2. Click Synchronization in the Users view.

Users
R B E
MName 4 Login Dy
Calvin Lu clu

Carol Wilson
D efault adminigbator
Grace Morgan
Jen McMaster jmcmaster
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3. If you have previously imported one or more sources into the VMP Server, the Reconfigure/
Synchronize only window appears. Select Yes, reconfigure settings and click Next.

4. In the User Synchronization dialog, click Add primary source with users (under Sources).

5. Select Generic Excel or CSV from the Source type dropdown list. This selection auto-populates the
Title field. You can accept the default title or customize the title.

6. If your file is an Excel file, edit the connection parameters listed below.

Add Primary Source With Users x

Title:
| Generic Excal |
Source type:

| Generic Excel
Settings:

File path

Login

Password
Corfirm Password
Worksheet
Document containg columns title Yes

v]

Header row number 1

Content row number 2

Options
e
o e

[ Enable Web Console Access
O A icaly send email regi

[0k ]| Cancel || el |

Table 8: Generic Excel connection parameters

File path Click in this field to browse for the file, or type the path in the box.

Login If required, enter a login and a password to access the Excel file.

Password

Confirm Password If a login and password are required to access the file, enter the password a second
time to confirm the credentials.

Worksheet

If the spreadsheet includes more than one worksheet, enter the name of the
worksheet to import as source data.
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Parameter

Document contains
columns title

Header row number

Content row number

ABOUT IMPORTING AND SYNCHRONIZING
Description

Select Yes if the spreadsheet uses title columns to define the data. Select No if the
spreadsheet does not include title columns.

Enter the header row number.

Enter the content row number.

7. If your file is a CSV file, edit the connection parameters listed below.

Table 9: CSV connection parameters

Parameter

File path

Login
Password

Confirm Password
Encoding
Delimiter

Document contains
columns title

Description
Click in this field to browse for the file, or type the path in the box.

====| Note: If your file resides on a remote network, automatic synchronization
m=m= | vill not work unless the Vocera Data Exchange service is modified to use the
local administrator account instead of the VMP local system account.

If required, enter a login and a password to access the CSV file.

If a login and password are required to access the file, enter the password a second
time to confirm the credentials.

Select the text encoding option appropriate for the imported data. In most cases, the
default option of Automatic is appropriate.

Use the dropdown list to choose a comma or semicolon as the string separator.

Select Yes if the spreadsheet uses title columns to define the data. Select No if the
spreadsheet does not include title columns.

8. Optionally specify the import source options described in on page

59.

9. Click OK to close the dialog.

10Follow the steps in

on page 60 to synchronize the Excel or CSV

file users and contacts with the VMP Server.

If you have your own SQL database for keeping track of user information, you can import the users from
this database into the VMP Server.

1. Select Users & Groups > Users.

2. Click Synchronization in the Users view.
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Name 4 Login Dev

Calvin Lu

Carol Wilson
D efault adminishator
Grace Morgan
Jen McMaster mcmaster

ABOUT IMPORTING AND SYNCHRONIZING

3. If you have previously imported one or more sources into the VMP Server, the Reconfigure/
Synchronize only window appears. Select Yes, reconfigure settings and click Next.

4. In the User Synchronization dialog, click Add primary source with users (under Sources).

5. Select MsSqlServer from the Source type dropdown list. This selection auto-populates the Title

field. You can accept the default title or customize the title.

6. Enter the Connection Parameters.

58

Add Primary Source With Users

Title:

| MsSql Server

Source type:

| MsSal Server

Settings:

Address

Login

Password

Confim Password

Database

Query

Cptions
-
Nodfn s

[[] Enable Web Console Access
O A send email

[ok ]| canmcel || ke |

Table 10: SQL connection parameters

Address The computer name or IP address of the SQL server.
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Parameter
Login
Password

Confirm Password

ABOUT IMPORTING AND SYNCHRONIZING

Description

The SA login credentials.

Enter the password a second time to confirm the credentials.

Database Select the database to import from the dropdown list.
Query Use the dropdown list to select any specifc query options for the import.

7. Optionally specify the import source options described in on page
59.

8. Click OK to close the dialog.

9. Follow the steps in

on page 60 to synchronize the SQL users and

contacts with the VMP Server.

When you are importing users from a source, you can use the source importing options to specify which
users to import, enable VMP Web Console access, assign licenses, or email registration instructions.

Edit Source X
Title:

Active Directory 7 |
Source type

Active Directory i ~
Settings: /

Host 152.168.2.112

Port 383 J

Connect over S5L No i ~

Usemame Administrator /

Password _— i

Confirm Password - f

Syne Organizational Units No i ~
Sync Security Groups Yesz e
Sync Distribution Groups Mo e

Options

Advanced Fiters Mo fitters
Licenses Mo defautt licenses
Enable Web Console Access
[ Automaticaly send email registration
Cancel Help

To specify source importing options:

1. If the Advanced Filters button is enabled, click it to display the advanced filtering options for this
import source operation. These filters enable you to specify which users are to be imported from the

source.
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Advanced Filters X

Contact types
Users Contacts InetOrgPersons

Enable fields filration

accourt Expires ~ | Contains ~ < -

Cancel Help

2. In the Contact types pane, select the check boxes of the types of users that you want to import.

3. Select Enable fields filtration to specify that only users that match the specified criteria are to be
imported. In the list of fields displayed, select the filtration criteria that you want to use.

4. Click OK to close the Advanced Filters dialog box.

5. Click Licenses to display the Assign applications to user dialog box.

Assign applications to user X

Application Name Available
u Messaging 5825
PagerSMS (1]
NCTR/TAP ]

Cancel Help

6. In this dialog box, specify the application licenses that are to be granted by default to all imported
users.

7. Click OK to close this dialog box.

8. Select the Enable Web Console Access check box if imported users are to be granted VMP Web
Console access by default.

9. Select the Automatically send email registration check box to automatically email registration
instructions to all imported users.

After you have specified the sources for the VMP Server, you can synchronize your sources with the
server to ensure that all information is up to date. You can synchronize manually or set up automatic
synchronization.

The following synchronizations happen automatically, whether or not you have set up automatic
synchronization:

* If a Vocera Voice Server has been set up as a source, the VMP Server is automatically updated
whenever a Vocera Voice Server user is added, edited, or deleted.
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* If the VMP Server has been integrated with Vocera Secure Texting, the VMP Server is automatically
updated whenever a VST user is added, edited, or merged with a Vocera Voice Server user. When a VST
user is deleted, the VMP Server is updated within 10 minutes.

Note: Contacts are never automatically synchronized.

The steps of the synchronization process depend on the sources that you have specified. The following

screens are included:

Screen

Reconfigure/Synchronize
only

Remote Sources

Select Users

User/DL Synchronization

Default DL Permissions

Field Mapping

Script

Export Address Book
Entries to Vocera

Description

Specifies whether to reconfigure import sources before synchronization. This screen
appears if you have already imported at least one source.

Lists the remote sources to be used in synchronization. Also enables you to specify
automatic synchronization.

If you are importing from an Active Directory source, this screen enables you to
specify which Organizational Units (OUs) are to be synchronized to create a VMP
Distribution List.

If you are importing from an Active Directory source, this screen enables you to
specify whether to import users only, or whether to also import the OU hierarchy.
If you are importing the OU hierarchy, you can specify whether you want the VMP
Server to automatically create Distribution Lists from the imported OUs.

This screen appears only if you are importing from an Active Directory source, you are
importing the OU hierarchy, and you are automatically converting OUs to Distribution
Lists. For the initial Active Directory import, you can configure permissions for the
default administrator and any groups selected for import.

For each selected source, this screen specifies how fields in the source are to be
mapped to VMP user fields.

Creates the internal script that performs the synchronization. In this screen, you can
manually specify the users or contacts to be added or updated and configure contact
options before running the script. These options can be changed manually at any
time after deployment. This screen is useful for defining device and wireless gateway
assignments.

If you are importing from a Vocera Voice Server, this screen enables you to export a
CSV file containing a list of the VMP users that do not have a Vocera ID. You can use
this file to create address book entries in the Vocera Voice Server. See

on page 35 for more information on this capability.

Follow the steps shown below to perform a synchronization.

1. In the VMP Administrator, select Users & Groups > Users.

2. Click Synchronization in the Users view.
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(Q) Uzers

CERIE B E

Name Login De
Calvin Lu

Caral Wilson ilson

Grace Morgan gmorgan

Jen McMaster jmcmaster

3. If the Reconfigure/Synchronize only screen appears, select Yes, reconfigure settings.
4. Click Next.

5. In the Remote Sources screen, you can enable automatic synchronization of user data from the
selected sources:

a. Select the Automatic synchronization checkbox.

b. Select one of the following:
* Every: Synchronize after the specified number of hours and minutes has elapsed.
* Daily at: Synchronize every day at the specified time.
* Weekly on: Synchronize once a week at the specified day and time.

Automatic synchronization

() Every: 0D 0 =
() Daily at: 1 = 0 s AM
(O Weekly on: | Sunday 1 <1 [o L] am

[ Aute Create and Delete users

Tip: The best auto synchronization time depends on your specific environment. The setting
should keep the system updated with new and updated user data and occur when network
traffic is not typically heavy.

c. Select Auto Create and Delete users if users that have been added or deleted in the source are to

be automatically added or deleted in the VMP Administrator.

6. Clear the When a user's wireless gateway is not provided, use checkbox.
7. Ensure that the Merge primary sources checkbox is selected.
8. Click Next.

L Wocera

< Back Mexd > Cancel Help

9. The Select Users screen appears if you have included Active Directory as a source. In this screen,
select the Active Directory users to import by clicking the checkbox next to the Organization Unit (OU)
name, if you have not already done this.

Depending on the user import configuration, the options may be included in the following three tabs:
* Organization Units

* Security Groups

* Distribution Groups

a. To import an OU, select its checkbox.
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Security Groups
All = Filter
Access Control Assistance Operators ~
Account Operators
- Administrators
.. Allowed RODC Password Replication Groug
Backup Operators

Cert Publishers
Certificate Service DCOM Access
Cloneable Domain Controllers
Cryptographic Operators
Denied RODC Password Replication Group
Distnbuted COM Users
DnsAdmins
DinsUpdateProngy
Domain Admins
Domain Computers
Domain Cortrollers
Domain Guests
) Domain Users
Enterprise Admins
Enterprise Key Admins
Cobmmasi

Dmd cche Dimrmmin

IDOKOOO00000000000000

w

To import a sub-OU, expand the OU and select its checkbox.
b. To limit the display of OUs, use either or both of the following:
e From the dropdown list, select Selected to display only the OUs that you have selected.

User Synchronization X

Select Users

Define which OU's wil lbe synchronized to create a VMP Distrbution List. if necessary, expand the OU and select any sub-OU's that will be
synchronized into a VMP Distribution List. To view the members within a OL, highlight the OU to wiew the member names

Reconfigure/Synchronize only Securty Graups

Remote Sources Selected H Filter
Select Users : O Domai

User/DL Synchronization ) Users

Field Mapping

Script

Expont Address Book Ertries to Vocera

< Back Next > Cancel Help

» To filter the OU list, type text in the field provided and click Filter. Only the OUs that contain the
filter text are displayed, along with some OUs that are always displayed.

User Synchronization x
Select Users
Define which OU's wil lbe synchronized to create a VMP Distrbution List. if necessary, expand the OU and select any sub-OU's that will be
synchronized into a VMP Distribution List. To view the members within a OL, highlight the OU to view the member names
Reconfigure/Synchrorize orly Securty Graups
Remote Sources ~ [Domain Filter
FEEE LIEE Administrators
User/DL Synchronization Denied RODC Password Replicz
Field Mapping Domain Admins
Seript Domain Computers
Export Address Book Erttries to Vocera Demain Controllers
Demain Guests
Domain Users
Guests
Users
< Back Next > Cancel Help

To remove the filter, clear the text field and click Filter again.
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c. Click Next.

10.The User/DL Synchronization screen appears if you have included Active Directory as a source. In
this screen, use the radio button selection to configure the Active Directory synchronization options

appropriate for your deployment. Depending on the user import configuration, the options are included
in the following three tabs:

* Organization Units
* Security Groups
* Distribution Groups
a. Click each tab to configure the options for the group.
You can import only the users or import the existing OU hierarchy.
b. When the options are selected, click Next.
11.The Default DL Permissions screen appears if you have included Active Directory as a source and are
importing the existing OU hierarchy. In this screen, configure permissions for the default administrator

and any groups selected for import. Use the tabs to toggle between User and Group permissions. When
the configuration is complete, click Next.

User Synchronization X
Default DL permissions
*You can set default permissions for ALL the YMP Distribution Lists {DL's) that will be created when VMP first synchronizes with an OU in Active Directory. If
required, unique permissions for individual WMP DL's can be corfigured in the "Distibution Lists’ section of this Admin console after the first synchronization
G
Reconfigure/Synchronize only Lz roups
Remote Sources +N-] ]
Select Users -
User/DL Synchronization Name
Default DL permissions Disaster Recovery Team
Feld Masping ’
Script
Export Address Book Entries to Yocera
< >
< Back Next > Cancel Help

12In the Field Mapping window, define the field mappings for your deployment, and click Next.
By default, the VMP Server uses email addresses to synchronize contacts between sources. If your
environment does not use email addresses, you can synchronize between the Vocera Voice Server User
ID field and the a field in your Active Directory server (such as sSAMAccountName). See
on page 66 for details on how to do this.

====| Note: For more information about field mappings, see on page 186 and
on page 187.
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User Synchronization

Field Mapping

The field mapping step in the User Synchronization process enables the user to define which User fields will be supported in the synchronization, and how
those fields will be mapped in relation to fields in the extemal Source. In addition the field in VMP that will be used as the Key to map with the Source is able

to be defined.

Recorfigure/Synchronize only
Remote Sources
Select Users

User/DL Synchronization 1 Active Directory

Field Mapping
Seript
Export Address Book Ertries to Vocera

&

Contact field Source Source field Import Settings ha
4 Vocera ~ | First Name ~

Middle Name ~ ~

Last Name: Vocera ~ | Last Name: ~

Title ~ v

Email Vocera ~ | Email ~

Public 1D ~ ~ v
< >

| <Back || MNed> || Camcel || Hep |
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13.The synchronization script is generated by the import wizard options selected and is revealed in a
script dialog box. Use the scroll bar to review the script and click Close.

14.In the Script dialog, configure the script options as needed:

65

Synchronization script creation...

12:05:08] 0 vocera groups have been loaded ..

12:05:08] 1 vocera sites have been loaded

12:05:08] Loading users from database

12:05:08] Loading gateways from database

12:05:08] Loading distribution lists from database

12:05:08] Loading groups from database ..

12:05:08] Loading vocera sites from database

12:05:08] Generating synchronization script

12:05:08] Sync:Skip, Activetrue, ManualyCreated:Y, Name:Default administrator, Email:, PIN:,
Comment :Associated remote user not found. Since user was created manually then user record will not be
deleted

|Sync:Skip, Active true, ManualyCreated N, Name ‘Gail Goodman, Email.ggoodman@dtill local, PIN
Sync:Skip, Active true, ManualyCreated N, Name Claudia Bemelli, Email:cbemelli@dtill local, PIN:
Sync:Skip, Active true, ManualyCreated N, Name:Denise Lundberg, Email-dundberg @il local, PIN
| Sync:Skip, Active true, ManualyCreated N, Name:Henry Thomas, Email hthomas@dtill local, PIN
| Sync:Skip. Active true, ManualyCreated:N, Name:John Smith, Emailjsmith @dtill local, PIN:

| Sync:Skip, Active true, ManualyCreated:N, Name:Martin Choi, Email: mchoi@dtill local, PIN:

| Sync:Skip, Active true, ManualyCreated:N, Mame Jane Moore, Email jmoore @dtil local, PIN:
Sync:Add, Active true, ManualyCreated:N, Name:Betty Wong, Email bwong @dtill local, PIN:
Sync:Add, Activetrue, ManualyCreated:N, Name:Brian Forsberg, Emailbforsberg @dtill local, PIN:
Vocera Site Sync:Skip, VoceralD:s-global, Name Global, VAANumber:

[12:05:08] Script was successfully created.

User Synchronization X
Script
The creation of the synchronization script enables the system to validate the corfiguration that the VMP Administrator has thus far defined. If the
validation is successful, the synchronization script wil be successfully created
Recorfigurs/Synchronizs only B N .
Remote Sources Action Prfile Admin Access  Web Access  Device Type
Select Users » Add I MO ] |Vocera Smartphone Cliert
s e (| |Md | [~] O | |Vocera Smartphone Cliert
Field Mapping
Seript
Export Address Book Entries to Vocera
< >
| <Back || Net> || cancal || Hep |

a. Click Check All to confirm the previously configured values.
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b. To specify that a user imported using this script is to be given access to the VMP Administrator,
select the Admin Access checkbox.

c. To specify that a user imported using this script is to be given access to the VMP Web Console, select
the Web Access checkbox.

d. When you have finished configuration, click Next or Finish to continue. (The button that appears
here depends on whether the Export Address Book Entries to Vocera screen appears.)

15.The Export Address Book Entries to Vocera screen appears if you have included the Vocera Voice

Server as a source. In this screen, select the Export Address Book Entries to Vocera checkbox to

export a CSV file containing a list of the VMP users that do not have a Vocera ID.

You can use this file to create address book entries in the Vocera Voice Server. See /ddress Book Entry

Exporting on page 35 for more information on this capability.

CSV File Path
CSV Delimiter:

[] Export Address Book Ertries to Vocera

| Browse |

. {comma) ~
. ([comma)

H Eamiculun

[ sk [ P | Cenel | e |

Click Finish to continue.
16.The synchronization script runs. When the sync is complete, click OK to close the successful sync

dialog, and click Close to close the script window.

Synchronizing Using Vocera User ID and Active Directory

By default, the VMP Server synchronizes using the email address of each user defined in each source. If
you have imported the Vocera and Active Directory sources, you can now synchronize the User ID field in
the Vocera source with a field in the Active Directory source, such as the sAMAccountName field. This is

useful in environments where users do not have email addresses.

1. Follow the steps described in Synchronizing Users and Contacts on page 60 to start the
synchronization process.
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2. When you reach the Field Mapping screen, select the Vocera source.

3. Scroll down to the Synchronization Key row.

4. In the Source column of the Synchronization Key row, select Vocera.
5. In the Source field column of the Synchronization Key row, select User ID.

User Synchronization

Field Mapping

Recerfigure/Synchronizz arly
Remate Sources

Select Users

User/DL Synchronization

Ficld Mapping

Script

Export Address Book Entries to Vocera

1 Bctive Dirsctom

The field mapping step inthe User Synchronization process enables the user to define which Userfields will be supported in the synchrorization, and haw these fields wil be mapped in
relation tofields in the extemal Source. In addition the field in VMP that wil be used as the Key to map with the Source is able to be defined

X

[Pt
&

Corttact field Source

Source figld

Impart Settings )

Wocera

Email

Email

Public ID

Pager ID Vocera

Pager

[] St characters

Vocera 1D Vocera

Entity ID

Device PIN/SMS phone #

Wirdless gateway

S S I KRS RS KA K

Wocera

-

‘Synehronization Key

User ID

S kS S K2 K2 KA K

Cancel Help

Note:

© o ND

Select the Active Directory source.

Scroll down to the Synchronization Key row.

In the Source column of the Synchronization Key row, select Active Directory.

In the Source field column of the Synchronization Key row, select the field that you want to use to
synchronize (such as sAMAccountName).

User Synchronization

Field Mapping

Reconffigure/Synchronize only
Remote Sources

Select Users

User/DL Synchronization

Field Mapping

Script

Export Address Book Entries to Vocera

x

The field mapping step in the User Synchranization procsss snables the userto define which Uiser fields will bs supported inthe synchronization, and how thass fields will bs mapped
in refation to fields in the extemal Surce. In addition the ficld in VMP that wil be used as the Key to map with the Source is cble to be defined.

4 Vocera

_

4
[Fodetemea
&

Contact field Source

Source field

Import Settings

Email Active Direct

E-mail

Public ID

Pager ID

] Stip characters

Wocera ID

Device PIN/SMS phone #

Wireless gateway

Active Direct...

-

Synchronization Key

sAMAccountName

SRS S RN RN

Next > Cancel Help

10.Click Next to complete the field mapping.
11.Continue following the instructions in
synchronization.

By default, in the Vocera ID row, the Source field column is set to Entity ID. Do not
change this.

on page 60 to finish user

If you have an external source of contact information, you can import the contacts into the VMP Server.
You can then regularly synchronize the external source with the VMP Server.

67

VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



ABOUT IMPORTING AND SYNCHRONIZING

For information on how to import contacts from a Vocera Voice Server global address book, see lrnporting
Contacts From a Vocera Voice Server Address Book on page 69.

1. Select the Contacts module, and select Contact Sources.

2. Select New and choose New Contact Source.

Mew Contact
| Mew Contact Source ‘

3. Enter a name for the new source, select the Associated with remote source checkbox, and click
Next.
4. If you want the VMP Server to be synchronized with this source:
a. Select the Automatic synchronization checkbox.
b. Select whether you want to synchronize every few hours, daily, or weekly, and then select the time
period or time at which synchronization is to take place.
5. Select an existing source or click Add primary source with contacts.

6. If the import is from Active Directory, select the contacts and groups to import, and click Next.
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Organizational Units ~ Security Groups

E

- Filter

ORXO0000000000000000000

Metwork Configuration Operators
Performance Log Users
Performance Monitor Users
Pre-Windows 2000 Compatible A
Prirt Operators

Protected Users

RAS and IAS Servers

RDS Endpoirt Servers

RDS Managemert Servers

RDS Remate Access Servers
Read-only Domain Controllers
Remote Deskiop Users

Remote Management Users
Replicator

Schema Admins

Server Operators

Storage Replica Administrators
System Managed Accounts Grou
Teminal Server License Servers

0 Users

Windows Authorization Access G v
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7. If the import is from Active Directory, configure group and Distribution List import options, and click

Next.

8. Customize the Field Mappings, if desired, and click Finish.

Note: For more information about field mappings, see
on page 187.

on page 186 and

9. Confirm that the synchronization is successful and click OK to close the dialog.

If you have stored contacts in an address book on the Vocera Voice Server, you can import them into VMP.
This enables you to access these contacts from the VMP Web Console or Vocera Collaboration Suite.

To import contacts from a Vocera Voice Server address book:

1. Select the Contacts module, and select Contact Sources.

New Contact

| Mew Contact Source ‘

3. Enter a name for the new source, select the Associated with remote source checkbox, and click

Next.

4. If you want the VMP Server to be synchronized with this source:
a. Select the Automatic synchronization checkbox.

b. Select whether you want to synchronize every few hours, daily, or weekly, and then select the time

period or time at which synchronization is to take place.
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5. If the Vocera source is not included in the list of contact sources, click Add primary source with
contacts.

6. In the Add Primary Source With Contacts window, in the Source type dropdown list, select Vocera.

Add Primary Source With Contacts

X
Title:

|Vowa |
Source type:

Vocera v
Settings.

Import users |Nn
Yes

Options

[ o ]| comcel [ hep |

Click OK. In the Remote Sources window, click Next. The Field Mapping window appears.

7. In the Field Mapping window, locate the Fields Mapping table at the bottom of the window. In the User
Key column, ensure that the checkbox in the Email row is selected.
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New Contact Source X

Field Mapping

Contact Synchronization is an automated procedure defined by the VMP Administrator whereby all contact records stored on all remote
sources that the VMP system is referencing are checked for changes, and any new or changed Contact information is detected and pushed
out to the appropriate VMP-enabled devices.

Contact Source Name
Remote Sources Name
Field Mapping »

&

Contact field Source Source field Key UsprKey #
» ~ ~

First Name Vocera ~ | First Name ~ [

Middle Name ~ ~ O

Last Name Vocera | Last Name ~

BlackBemy PIN ~ ~ O

Email Vocera ~ | Email ~| O

Photo ~ ~

Image 1 ~ ~ w

< Back Finish Cancel Help

8. In the Key column, select the checkboxes in the First Name, Last Name, and Email rows, as shown
below. Then, scroll down to Business Phone and select this checkbox also. These define the unique key
that will be used to identify each address book entry.

New Contact Source X

Field Mapping

Contact Synchronization is an automated procedure defined by the VMP Administrator whereby all contact records stored on all remote
sources that the VMP system is referencing are checked for changes, and any new or changed Contact information is detected and pushed
out to the appropriate VMP-enabled devices.

Contact Source Name
Remote Sources Name
Field Mapping »

& |
Cortact field Source Source field User Key
Personal Phato ~ ~
First Name Vocera ~ | First Name |
Middle Name ~ ~1 O
Last Name Vocera ~ | Last Name ~
BlackBemy PIN ~ ~|
b |Email Vocera ~ | Email ~ I
Phaoto ~ ~
Image 1 v < v
| <Back | Fmsh || Cancd |  Hep

If your site uses pagers, scroll to the Pager checkbox and select it also.
Setting these key entries is the best practice for most deployment models. Check your Vocera Voice
Server address book to see what model works best for you.

9. Click Finish to start synchronizing the address book.

10.Confirm that the synchronization is successful and click OK to close the dialog.

When synchronizing, you can specify a secondary source that is to be linked with data in one of the
sources that you have previously created. To link a secondary source with a primary source, you must
specify the common key between the two sources.
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1. During synchronization, in the Remote Sources window, locate the Sources pane and click Add source
with additional user info.

2. In the Add Source With Additional User Info dialog box, supply the title, source type, and connection

parameters for the new secondary source. These fields are identical to those that you provide when you
are creating a primary source.

Add Source With Additional User Info X

Title
| Generic Excel |
Source type:

| Generic Excel
Settings:

File path

Login

Password
Confirm Password
Worksheet

Document containg columns title Yes

Header row number 1
Content row number 2

Options

e

Sources linkage
Source key field:

| v]
Parent source key field:

| v]

[ ox ][ comced || Hep |

For details on providing these fields, see one of the following, depending on the type of the secondary
source that you are creating:

* Active Directory: see [mporting Users From Active Directory on page 52

* Vocera Voice Server: see [mporting Users From Vocera Voice Server on page 50

* Excel and CSV files: see lmporting Users From an Hxcel or CSV File on page 55

* SQL: see Importing Users From SOL on page 57

In the Source key field, specify the secondary source field to use as the common key.

4. In the Parent source key field, specify the primary source field to associate with the secondary
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source key field.
. Click OK to add the secondary source.
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To enable user devices and client applications to work with the VMP Server, you can perform these tasks.

* Send device installation information to a user device.
* Set up autoconfiguration for Vocera Collaboration Suite devices.
e Enable or disable email communication on user devices and the VMP Web Console.

Vocera smartphone and badge solutions offer secure messaging capability to any health care professional.
Regardless of role or location, you can use Vocera to send secure, HIPAA-compliant messages to any
member of your care team.

The following table lists the attributes and capabilities of the Vocera badge, Vocera Secure Texting, Vocera
Collaboration Suite, and the Vocera Smartbadge. Use this table to determine what solution is the best
choice for you.

Attribute Vocera Vocera Secure Vocera Collaboration Vocera
Badge  Texting Suite Smartbadge
Network Supported Wi-Fi Cellular Wi-Fi Cellular Wi-Fi Wi-Fi
Supports Shared Devices v v v v’
Hands Free v v
Voice Automated v v’ v v
Contact by Name, Role, Group v v v v v v’
Receive Group Call and Broadcast v v v
Initiate Group Call and Broadcast v v v v
Push-to-Talk 7 v v
Contacts Directory Search v v v v v
Favorites List v v v v v
Presence/Availability Information v v v Ve v
Select-to-Connect Commands v v v v v’
Keypad for extension dialing v v v’
Simple Paging v v v v
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Attribute Vocera Vocera Secure Vocera Collaboration Vocera
Badge Texting Suite Smartbadge
Alarms/Alerts through integration v v v v
Secure transmission and delivery of messages v v v 7 7
Text Users and Groups v’ v v v v’
Web Console Messaging 7 v v v v

The Vocera messaging solutions enable you to:

* Reach the right person, instantly.
* At the right time.

* On the right device.

* With the right information.

* In the right place, anywhere.

If you are using a Mobile Deployment Management (MDM) implementation in your environment, you can
use it to deploy Vocera Collaboration Suite.

The Vocera Collaboration Suite utilizes the following three key-value pairs. Your MDM solution must
implement these in its configuration. Contact your MDM solution vendor for assistance.

Field Name Description
LoginType The method to log into this device. This is either shared or personal.
ServerIP The IP address or fully-qualified domain name (FQDN) of the VMP Server.

ServerCertificateCheck If this is set to true, check for a valid server certificate on first connection. If false, use
the value of the Enforce server certificate validation on smartphone configuration
option in the VMP Administrator to determine whether to check for a valid server
certificate.

See on page 76 for more information on device and server certificates.

You can send instructions on how to install and register the client application on a user's device.

====| Note: If you are upgrading your iOS devices to VCS 3.4 or later, and you are installing a new SSL
=== certificate on your VMP Server, you will need to re-register your VCS application on your devices.

1. Select Users & Groups > Users.
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2. In the Users pane, highlight the name of the user to be sent installation instructions.
3. In the toolbar, click the Notify mobile device dropdown list and select Install VMP applications.

(@ VMP (Default administrator) - [Users] - o X

File View Window Help -

Users & Grours | R

Users

Emal Fubic ID Vocera ID
@il local e
cwison@dillocal wowison

gggggg \@dillocal ugmorgan

Reports

Configuration

4. If no registration key exists for this user, you will be asked whether you want to generate one. Click
Yes.

5. A notification dialog box appears, indicating that the installation information has been sent to the user's
email address.

====| Note: The generated registration key is valid for 48 hours only.

When the Vocera Collaboration Suite is started on a device, a startup screen appears on which the

user can specify the fully-qualified domain name (FQDN) or IP address of the VMP Server. You can
autoconfigure the Vocera Collaboration Suite client to display the FOQDN or IP address of the server on this
startup screen.

To set up autoconfiguration, have your IT department create a DNS entry named autodiscovervs for the
VMP Server. The recommended approach is to configure the autodiscovervs entry as a CNAME record
and reference the FODN of the VMP Server (or the VMP Server load balancer). The VCS client will use

the FODN present in the CNAME record if there is an A record for the FODN. If no DNS CNAME record is
found but an A record exists for autodiscovervs, the VCS client will use the IP address specified to connect
to the VMP Server.

The VCS client will search for autodiscovervs.localdevice if it cannot find autodiscovervs.

You can configure the VMP Server to enable or disable email communication on user devices and the VMP
Web Console.
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1. Start the VMP Administrator and select Configuration > System Options.

The System Options dialog box appears.

2. Scroll to Contacts.

3. From the Allow Email Communication dropdown list, select Yes to allow clients to send email to
contacts, or select No to disallow email.

System Options

Device inactivity timeout interval {in minutes)

VS logout in dual mode also causes a badge logout

Enforce Motification Settings OFF
Secure Messages Priority: Normal Confiqure
Secure Messages Priority: High Configure
Secure Messages Priorty: Urgent Confiqure
Calls Configure
Netify Me Confiqure
Other Configure

Minimum Urgent Message Motification Volume Level (%)

Allow User to upload personal image

Allow Email Communication

Secure Messaging
Enable Remind Me Later Option

3rd Party Notification

Default Subject Line for 3rd Party Integrations

[ok ]| cancal |

Help

4. Click OK to save your change.

You can use a certificate-based solution to ensure that only trusted devices can use the Vocera

Collaboration Suite application to connect to the VMP Server.

To employ this solution, contact your IT administrator and obtain a root and child certificate pair for use
in your VMP and VCS environment. This certificate pair should not be used for any other purpose.

The root certificate is then installed on the VCS devices that are to be trusted. You can install this
certificate in any of the following ways:
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Use a Mobile Device Management (MDM) solution. Ensure that your VCS devices can gain access to the
certificate from the MDM.

For Apple devices, use the Apple Configuration Utility.

Provide a link to the certificate in an email message that is provided to devices as part of the device
registration process.

Note: Each VCS device must have the same root certificate.

The child or leaf certificate of the root certificate is then installed on the VMP Server. See
on page 77 for details on how to install this child or leaf certificate.

Note: For technical details on the certificate and public key pinning solution used here, see

If you have used a Mobile Device Management solution or other solution to install a root certificate on
your devices, you can provide a child or leaf certificate of this root certificate to the VMP Server. This
ensures that only trusted devices can use the Vocera Collaboration Suite application to connect to the VMP
Server.

To upload a child or leaf certificate to the VMP Server:

1. Start the VMP Administrator and select Configuration > System Options.

@ YMP (Default adi
File View Winc

Users & Groups
Contacts

Messaging

Content

The System Options dialog box appears.
2. In the System and Networking section, scroll to Security.
3. In the Device Validation Certificate row, click Add.
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System Options

System and Networking

Networking

Vocera Messaging Server Public Host Name / [P 152.168.2.113
Vocera Messaging Server Intemal Host Name / IP 192.168.2.113
Email
Enable Outgoing Email No
Display Name
Email Address
SMTP Server
SMTP Port 25
SMTP Authentication Na
Device validation certficate Add
Enable smartphone authertication by certificate No
Erforce S5L for smartphone connections Mo
Enforce server certificate validation on smartphone No

Enforce App PIN

[ok ]| cancel |

Help

USER DEVICES AND CLIENT APPLICATION CONFIGURATION

4., Locate the child or leaf certificate on your computer. The file name for this certificate has the suffix

.cer.

5. Click Open. The device certificate is now uploaded.

You can specify that VCS is to use TCP to communicate with the Vocera Client Gateway server instead of
using Comet to communicate with the Vocera Voice Server. This is recommended, as it improves resource
management on the VCS clients.

required.

====1| Note: Vocera Voice Server 5.3.1 or later and VCS 3.2 or later are prerequisites if you want to use
TCP to communicate with the Vocera Client Gateway server. To use TCP to communicate with the
Vocera Client Gateway server when using devices that operate on Wi-Fi only, VCS 3.6 or later is

1. Start the VMP Administrator and select Configuration > System Options.

The System Options dialog box appears.
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2. Scroll down to the Integrations > Vocera Voice section.
3. Set the Use VCG for VCS client connection management option to Yes.

System Options X

S
Enabled Yes
IP Addresses 152.168.2.114
Fort a0
Use HTTPS No
VCG IP Addresses 152.168.2.113
WMI Message Expiry {in minutes) 5
Enable Enhanced Voice Server NIO Tomcat Feature No
Retain call and voice mail history in the database (days) 14
Use VCTEfcr VS client connection management Yes l
Send user-generated messages to Vocera badges Yes
Consider Call Forwarding in User Presence Status Yes
Prevent voice enunciation on user-generated messages MNo
Allow Accept/Decline for Ungent Calls MNo

Show integration messages on device lock screen Mo

Pt et I
Enabled No
Vnrerm Secure Texting Ann - Messane Fechanoe

Cocel || Hob

4. Click OK to save your changes.

On the Vocera Client Gateway server, you can edit a properties file named vgwproperties.txt to control
the behavior of the VCS and VMP interface. For more details, see the Vocera Voice Server Telephony
Configuration Guide.

In a multi-site environment, the Vocera Collaboration Suite client provides information to the VMP Server
to determine the location of the Vocera Client Gateway servers to use when making calls. This ensures
that calls do not have to traverse multiple network hops.

When a VCS client first registers with the VMP Server, it presents information to the server to register the
client's location. The VMP Server then determines which Vocera Client Gateway servers are closest to this
client's location. If necessary, the VMP Server communicates with the Vocera Voice Server to obtain this
location information.

After receiving this location information, the VCS client uses it to determine which Vocera Client Gateway
server to use. If the closest Vocera Client Gateway server is unavailable, the next closest is used, until the
list is exhausted.

If the Vocera Collaboration Suite client is an older version, and does not provide any location information,
the VMP Server provides a default set of Vocera Client Gateway server addresses to use. This list of
servers is obtained from the Vocera Voice Server.

For more information on locations, see the documentation on locations in the Vocera Voice Server
Administration Console Guide.

The VMP Server sends wakeup notifications to clients that are offline or do not have a Vocera Voice Server
1D, and that have not sent a getpushdata query to the server within the last 5 minutes and 15 seconds.
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When the server sends a wakeup notification, it sends a VoIP notification to clients running version 3.2 or
later of VCS on i0OS or a FCM notification to clients running version 3.2 or later of VCS on Android. It sends
a regular APNS or FCM message to clients running older versions of VCS.

If a VCS client is also a Vocera Voice Server user and is logged into the Vocera Voice Server, notification is
handled by both the Vocera Client Gateway and the VMP Server.

You can specify the vibration and ringtone for messages, calls, and other notifications sent to the use of
these system-level notifications on all devices.

1. Start the VMP Administrator and select:
Configuration > System Options O

2. Scroll to Notifications.

System Options X
Days of inactivity before user is placed into Waming state B0 ~
Days of inactivity before user is placed into Locked state 50
Time of inactivity for auto logout for smartphone client {in minutes) | 60
Device inactivity timeout interval {in minutes) 10
WS logout in dual mode also causes a badge logout Yes

Enforce Motfication Settings COFF
Secure Messages Priority: Normal Configure
Sefyre Messages Priority: High Configure
Secure Messages Priority: Urgent Confiqure
Calls Configure
Notify Me Configure
Other Configure
Contacts
Allow User to upload personal image Yes
Allow Email Communication Yes
T S R
Fnzhle Bemind Me | ater Ontion Yes hd
D L

Cancel Help

3. In this section, locate the notification option for which you want to define the default vibration and
ringtone. The following settings are available:
Setting Description

Secure Messages Priority:

The vibration pattern and ringtone for Normal priority secure messages.
Normal

Secure Messages Priority: High  The vibration pattern and ringtone for High priority secure messages.

Secure Messages Priority: The vibration pattern and ringtone for Urgent priority secure messages.

Urgent

Calls The vibration pattern and ringtone for calls.

Notify Me The vibration pattern and ringtone for notifications that are generated when
the Notify Me checkbox is selected for messages that require a response, and
a response is not provided in the specified time.

Other The vibration pattern and ringtone for notifications for changes in On-Call

status, new or updated Content, missed calls, and voicemails.

In the located option, click Configure to display the dialog box for configuring the vibration and
ringtone.
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Secure Message - Priority: Urgent *
Vibration
Enable Vibration
Vibration Pattem: | Vibration #1 ~
Ringtone
Ringtone: Default Tone w Play
Length: 30 seconds ~
Volume: ' 0%
Cancel

In this dialog box, do the following:

a.

b.
c.

f.

Select the Enable Vibration checkbox to enable a vibration to be included as part of the
notification.

From the Vibration Pattern dropdown list, select the vibration pattern to use.

From the Ringtone dropdown list, select the ringtone to use. Click Play to hear a sample of the
ringtone that you have selected. The sample ringtone is played three times.

For the Notify Me option, Ringtone can be set to Silent. This turns off this ringtone on client
devices.

' Important: Ringtones 9 through 14 are not available on Android devices that are using
versions of VCS prior to version 3.4. You must upgrade your Android devices to version 3.4 to
use these ringtones.

In the Secure Messages Priority configurations, from the Length dropdown list, select the length of
time that the ringtone is played in seconds. This can be 1 second, or any 5-second interval from 5
seconds to 30 seconds. In the Secure Messages Priority: Urgent configuration, the length of the
ringtone can also be set to 60 seconds or Unlimited.

If the ringtone is shorter than the specified length, it is played repeatedly throughout the selected
time period.

When a user receives a message within a conversation, a single tone is played.

. In the Secure Messages Priority: Urgent configuration, use the Volume slider to specify a

minimum volume level on client devices for messages classified as Urgent. The default value is 70%.
Click OK to close the dialog box.

4. Repeat the previous step for all other notification options for which you want to specify the vibration
and ringtone.

5. If you want to force all devices to use these system-level options, set the Enforce System Settings
option to ON. By default, this option is set to OFF, which means that users can specify their own
vibration and ringtone notifications.

6. Click OK to save your changes.

If your devices are using VCS 3.4 or later for iOS, you must have SSL enabled on the VMP Server.

See
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If you are upgrading your iOS devices to VCS 3.4 or later, and you are installing a new SSL certificate
on your VMP Server, you will need to re-register your VCS application on your devices. See
on page 74 for more details on registration.

Smartphones are a necessary tool in today's workplace. Vocera Collaboration Suite is an essential
smartphone application that allows users to securely stay connected. This documentation lists
considerations to take into account before designing and deploying Vocera Collaboration Suite (VCS) as
part of your workflow solution.

The Wi-Fi settings listed here are supported.

Setting Recommendation
Wi-Fi Quality (2.4 and 5 GHz will be different) Voice Grade
2.4 or 5 GHz 5 GHz only
MDM Supported
Phone Model / OS See the Vocera Collaboration Suite release notes
Wi-Fi Assist or Smart Wi-Fi Switcher Disabled

SSID Priority Queue Highest

VPN / Per App VPN No

Captive Portal No

Session Timeouts None
Wireless Authentication WPA2 PSK

802.1X w/ 802.11k/r

Client Exclusion Policies Disabled

Vocera Collaboration Suite includes a voice application which connects over Wi-Fi. For best results, a Voice
grade wireless network must be designed, and a site survey must be completed to verify proper coverage
for the frequency band it will be deployed on.

If you have badges running on 2.4 GHz and plan to run VCS on 5 GHz, the 5GHz must be validated. The
radio characteristics and planning of 2.4 and 5GHz are very different. Sufficient coverage on the 2.4 GHz
network does not mean adequate coverage for 5 GHz. In both cases, the requirements are to have -65dBm
power coverage with an SNR of 25 at 50mW or lower AP power output wherever the devices will be
utilized.

One of the most important considerations when deploying Vocera Collaboration Suite is the capability of
the smartphone platform.

Most smartphones are consumer grade devices and are limited in their Wi-Fi capabilities. Improvements
come with each generation of the phone. For the best user experience, use a phone released in 2014 or
later. Improvements have come in three main areas:

* Wi-Fi Roaming
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* Wi-Fi Security
* Battery Management

There are three typical models of smartphone use in the enterprise: Corporate Owned, BYOD, and Mixed.

The corporate owned model allows the business to completely secure the device and restrict applications
and use for business needs.

A Mobile Device Management (MDM) solution is highly recommended to deploy and control these devices.
With an MDM, the smartphone can be completely locked down so users can only use the necessary
resources.

Many employees have personal smartphones and use them at work. The challenge with this model is that
it is difficult to know if the BYOD phone will perform well.

Use of an MDM can be highly beneficial in making sure the device meets the minimum technical and
security requirements.

Many Vocera deployments are likely to have a combination of Vocera Badges and smartphones with the
Vocera Collaboration Suite client installed. This section discusses the best practices for deploying for this
mixture.

This table provides a list of priority classes and their associated data types and applications.

Priority Class Data Type Application Example

Voice Voice only Critical, voice only applications Vocera Badges

Video Video/mixed use Latency sensitive, mixed voice/data Smartphone running
Vocera CS

Best Effort Data Data only applications Web, email, chat

Background Guest Not business related Guest chat, video, etc.

In the wireless world, QoS is used to make sure the most important traffic will have priority over less
sensitive traffic.

Voice traffic is sensitive to delays in audio delivery (latency) and to variations in the timing of the
audio delivery (jitter). Voice over wireless is especially challenged because it is a shared medium. For
the best user experience, all audio traffic must be tagged with the appropriate QoS markings on the
wired infrastructure and be allocated to the appropriate wireless priority queue. The recommendations
described here focus on wireless prioritization, as it is typically more constricted.

Tip: An important thing to remember about Quality of Service (QoS) is that it is only important if
there is contention on the media. Traffic metering lights on freeway entrances are a type of quality
of service. When there is no traffic on the freeway there is no need to restrict traffic coming on.
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When the freeway is very busy, the metering lights are used to restrict the cadence of adding more
traffic. This restriction prevents the freeway from coming to a standstill.

Wireless prioritization is usually done at the SSID level. Vocera recommends that all voice only
applications, such as the Vocera Badge, be allocated to the voice SSID.

Mixed use devices, such as smartphones running Vocera Collaboration Suite (VCS), should use an SSID
with highest priority. Because the smartphone can only associate to one SSID, it cannot send voice packets
to the voice SSID and other packets to a lower priority SSID. It allows VCS voice packets to have higher
priority over other data traffic. The data packets from VCS will not impact voice quality on the voice only
SSID.

All other data applications in the environment should use an SSID with Best Effort priority. Data
applications typically use TCP and HTTF, which have protocol layer redundancy. Latency and jitter that
would seriously impact a voice application have no discernable effect on data applications.

The Background priority should be used for traffic that is least important to business. While Guest access
is important to patient and family satisfaction, it is less important than most business traffic. Care should
be taken to provide a balance for guest access to the wireless network.

The current generation of Apple and Android smartphones contain Wi-Fi radios that support both the 2.4
and 5 GHz frequency bands.

The 2.4 GHz band is typically overutilized because there are fewer channels and it is used by more
devices. It also has more common interference sources, such as microwave ovens, wireless security
cameras, and Bluetooth devices.

It is highly recommended that VCS enabled smartphones be deployed on a voice quality 5GHz
infrastructure only.

Depending on location, some channels may not be available in the 5GHz frequency band. Channel use is
limited by each country's regulatory agency.

Some of the 5 GHz channels are sometimes not available, as other applications (primarily RADAR) have
priority use. If the Wi-Fi is using one of these channels and the AP detects it is being used by RADAR, the
AP will change channels. When this happens, the clients associated with that AP will be forced to look for
another AP If a voice call is active during the channel change, voice audio will be interrupted.

If your facility is near an airport or a weather station (common users of RADAR), you should disable DFS
channels.

Wireless security is an important consideration, especially when deploying a BYOD model.

Wi-Fi Captive Portals require the user to log in through a web page before getting full access to the Wi-Fi
network.

The granted access is usually for a limited time. When that time expires, you must login again through the
web page.

A Captive Portal should not be used when deploying VCS. If it must be deployed, set the session timeout to
longer than a shift so that users do not have to re-login during their shift.
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VPNs are typically used to create a secure connection to a network. Using a VPN with VCS is not
recommended.

* The VCS client is already on a secure network. Unless the VCS client is on the guest network (not
recommended), it is already secure.

* VPN can be computationally intensive, which may cause delay or jitter in the audio packets.

With i0S 7, Apple introduced a way to initiate a VPN on a per-application basis. Unfortunately, the
implementation limits traffic over the VPN tunnel to TCP and HTTP traffic.

VCS uses UDP for both audio and signaling, and therefore will not work over a Per App VPN.

Before a smartphone can use the Wi-Fi network, it must associate with the network and be validated.

The easiest way to do this is to configure a key on the smartphone. After it is configured and when it
comes on the network, or when it roams between APs, the smartphone uses the key to get on the network.

A more secure method is to use an Authentication server (such as RADIUS, IAS, ICS, AAA). Authentication
uses the 802.1X protocol to validate the user by using an Extensible Authentication Protocol (EAP) type.
There are many EAP types, but they are all similar in that they communicate to the Authentication server
before allowing access to the network. While 802.1X and EAP are more secure, they take time to perform
the authentication. The authentication can take several seconds and occurs when the device first comes
on the network and every time the smartphone roams between APs. If a smartphone is in a VCS call while
roaming, there could be several seconds of lost audio on each roam.

If 802.1X is required, 802.11k/r must be used. 802.11k/r are protocols that improve the roaming times
drastically when using 802.1X.
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The following sections describe how security is implemented in the VMP environment.

If the VMP Server was not configured to use SSL during installation, you can use the VMP Enterprise
Manager to configure it to use SSL after installation.

You can also follow these steps to configure the VMP Server to use an updated SSL certificate.

====| Note: If you are using VMP in a clustered environment, and want to use SSL, you must configure

each cluster node to use SSL.

1. Start the VMP Enterprise Manager.

86

. Select Configuration.

The Configuration window appears.
Scroll down to the Services folder and then to the WDE subfolder.
In the NetworkSecureCertificate row, click in the Value column, then click select.

Services
WDE
L} Netwarklnterface 0.0.0.0
03 MetworkPort a0
¥ MetwarkSecurePort 443
163 NetworkSecureCertiicate I select |
£} NetworkSecureE nforceiwehS 5L false

£} EnablswebServer tiue

In the Select Certificate dialog box, select the SSL certificate that you want to use, and click OK.

====1 Note: Vocera recommends that you use a publicly issued SSL certificate rather than a self-signed
certificate. If a self-signed certificate is used, most web browsers will generate an error when the
VMP Server is accessed from the VMP Web Console, which might cause confusion for end users.

If you want to enforce the use of SSL when connecting from a web browser to this VMP Server, click in

the Value column of the NetworkSecureEnforceWebSSL row. From the dropdown list that appears,

select true. Users that attempt to connect using HTTP are now directed to the HTTPS URL.
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Services
WDE
¥ Metworklnterface 0000
s NetworkPort a0
¥ NetworkSecurePort 443
03 MetworkSecureCerificate
» €3 MetworkSecusEforgebS 5L Talse =
£} EnableWebServer true

¥ Enable sutomatic Web lagin m

For information on enforcing the use of SSL between the VMP Server and VMP clients, see
on page 87.
7. Click Save to save your changes. In the confirmation dialog box that appears, click OK.
8. After you have made your changes, the VMP Server needs to be restarted. In the dialog box that
appears, click Yes to restart the VMP Server now, or click No to restart it later.

From the VMP Administrator, you can enforce that all communications between the VMP Server and VMP
clients are to use SSL. This ensures that all communications are securely encrypted.

====| Note: The use of SSL can be enforced during the installation of the VMP Server. See
a— on page 13 for details.

If you are updating a previously installed VMP Server to enforce the use of SSL, all existing VMP clients
that are not using SSL must re-register to use the VMP Server, as the connection protocol used by a client
is specified when the client is registered.

Before you can enforce SSL use, you must configure a SSL certificate. For details, see
on page 86.

1. Start the VMP Administrator.
2. Select Configuration > System Options.

3. In the System Options dialog box, scroll to the Security section and click in the right column of the
Enforce SSL for Smartphone connections row.
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System Options X
Enable Outgoing Email No ~
Display Name
Email Address
SMTP Server
SMTP Port 25
SMTP Authentication Mo
I S
Device validation certficate Add
Enable smartphone authentication by cerificate No
Erforce SSL for smartphone connections Yes I
-
Enforce server cetificate validation on smartphane No
Enforce App PIN COFF
Enforce Smartbadge PIN MNo
PIN Timeout {in seconds) 6000
Enforce device password for all smartphones OFF
Minimum Password Length 5
Require at least one letter Yes
At | ol o mindas seconds) 1o hd
D L
'Whether or not Patient Context integration is available
Cancel Help

4. From the dropdown list that appears, select Yes.
5. Click OK.

If the SSL certificate that you are using with your VMP Server is set to expire in 30 days, the VMP Server
sends you an email notification once a day to remind you.

The format of the email message is:

Subject: VMP SSL certificate expiring on <datetime>

Your VMP SSL certificate used for HTTPS connections is expiring on <datetime> and

needs to be renewed. Failure to renew the certificate can result in connectivity issues
between

the VMP server and other devices.

For clients on the i0S and Android operating systems, the security and encryption structure depends on
whether you are using the client within your organization's Wi-Fi network.

* If you are using a device running the iOS operating system outside of your corporate Wi-Fi
environment, the VMP Server uses the security features provided with the Apple Push Notification
Service (APNS).

* If you are using a device running the Android operating system outside of your corporate Wi-Fi
environment, the VMP Server uses the security features provided with the Firebase Cloud Messaging
(FCM) service.

====1| Note: On Android and iOS devices, the Vocera Collaboration Suite application performs its own
data encryption and decryption. It does not depend on the operating system's encryption process.

To enable communication between a provider and a device, the Apple Push Notification Service (APNS)
must expose port 443. To ensure security, it must also regulate access to this entry point. For this purpose,
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APNS requires two different levels of trust for providers, devices, and their communications. These are
known as connection trust and token trust.

Connection trust establishes certainty that, on one side, the APNS connection is with an authorized
provider with whom Apple has agreed to deliver notifications. On the device side of the connection,
APNS must validate that the connection is with a legitimate device.
Token trust is made possible through the device token. A device token is an opaque identifier of a device
that APNS gives to the device when it first connects with it. The device shares the device token with

its provider. Thereafter, this token accompanies each notification from the provider. It is the basis for
establishing trust that the routing of a particular notification is legitimate. In a metaphorical sense, it

has the same function as a phone number, identifying the destination of a communication.

Service-to-Device
Connection Trust

Provider-to-Service
Connection Trust

C

APNS )

TLS initiation

certificate

Validale server ceriificale
L

Device

LS

Validate device certificate

TLS initiation

| If

I,‘b
i)
4
n

Server at

[ Validate server certificate

Provider certificate ———=

Validate provider certificate

[ |[——TLS established

Apple Push Notification Service (APNS) is a robust and highly efficient service for sending secure data

to devices running on the iOS operating system. Each device establishes an accredited and encrypted IP
connection with the service and receives notifications over this persistent connection. If a notification for
an application arrives when that application is not running, the device alerts the user that the application
has data waiting for it.

APNS includes a default Quality of Service (QoS) component that performs a store-and-forward function.
If APNS attempts to deliver a message when the device is offline, the QoS stores the notification. It retains
only one notification per application on a device: the last notification received from a provider for that
application. When the offline device later reconnects, the QoS forwards the stored notification to the
device. The QoS retains a notification for a limited period before deleting it.

All devices using Vocera Collaboration Suite with i0S must register with the VMP Server to receive push
notifications. The registration occurs after the application is installed.

Once i0S receives the registration request from an application, it connects with APNS and forwards the
request. APNS generates a device token using information contained in the unique device certificate. The
device token contains an identifier of the device. It then encrypts the device token with a token key and
returns it to the device.

The diagram below shows the token relationship between the VMP Server, APNS, and the client device.
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The VMP Server needs to authenticate itself with the FCM. This is done via an authentication token that is
determined with an HTTP POST request to the FCM servers.

The token is stored on the VMP Server and is used to authenticate the application server with the FCM
servers once it sends out data. In a FCM, you have three involved parties: the VMP Server that wants to
push messages to the Android device, the Google FCM servers, and the Vocera Collaboration Suite client
application.

HITP

=i
—
— Regisration ID—— | |15

Unique ID ——

Registration ID

| Token

Message

For the server to send a message, the application must have a registration ID that allows it to receive
messages for a particular device. The registration keys are securely stored within the SQL database.

The ClientLogin token authorizes the server to send encrypted data to the client application on the
Android device. The server has one ClientLogin token and multiple registration IDs. Each registration ID
represents a particular device that has registered to use the messaging service for Vocera Collaboration
Suite.

When the VMP Server sends data, the following occurs:

The VMP Server sends data to the FCM servers.
Google queues and stores the message in case the device is inactive.
When the device is online, Google sends the message to the device.

On the device, the system broadcasts the message to the specified application via Intent broadcast with
proper permissions, so that only the targeted application gets the message. This wakes the application
up. The application does not need to be running beforehand to receive the message.

5. The application processes the secure data.

Ll

This is the sequence of events that occurs when an Android application running on a mobile device
receives a message:

1. The system receives the incoming message and extracts the raw key/value pairs from the message
payload.
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2. The system passes the key/value pairs to Vocera Collaboration Suite.
3. The Android application extracts the raw data from the RECEIVE Intent by key and processes the data.

The Android-based Vocera Collaboration Suite application must register with the VMP Server to receive
push notifications. It does this right after it is installed on a device.

The Android mobile OS receives the registration request from an application, connects with FCM, and
forwards the request to the server. FCM generates a device token using information contained in the
unique device certificate. The device token contains an identifier of the device. It then encrypts the device
token with a token key and returns it to the device.

Older versions of the Vocera Collaboration Suite client on the iOS or Android operating system used Comet
to send a content-less notification to the device when it was operating within the organization's Wi-Fi
network.

This capability has been retained for backward compatibility, but Vocera recommends that you use
a connection to the Vocera Client Gateway server instead. See
on page 78 for more details.

The VMP Server provides configuration options to ensure that all smartphone users are required to
protect the device with a password. Additional options specify that Vocera Smartbadge users must provide
a four-digit Personal Identification Number (PIN) to access their device, and that Vocera Collaboration
Suite users must provide a PIN when accessing the app on either shared devices or all devices.

These options ensure that your confidential internal information is protected if the device is lost or stolen.
1. Start the VMP Administrator: All Programs > VMP > VMP Administrator

2. Type admin (or your administrative credentials) in the VMP Login dialog, and click OK.

3. Select Configuration > System Options.

@ vvP (Default adi
File  View Winc

Users & Groups
Contacts
Messaging
Content

Reports
Configuration

e

System Opticns

The System Options dialog box appears.
4. Scroll to the Security section of the options.
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5. To enforce the use of a PIN for Vocera Collaboration Suite users, set the Enforce App PIN option to one

92

of the following:

* SHARED: Require the use of a PIN on shared devices only.

* ON: Require all users to supply a PIN. Users of personal devices must have their username and
password credentials to supply the PIN, or they will be locked out of the Vocera Collaboration Suite

application.

System Options

SMTP Port

25

SMTF Authentication

No

Device validation certficate Add
Enable smartphone authertication by certificate No
Enforce SSL for smartphone connections Yes
Erforce server certificate validation on smartphone Mo
™ Eriorce fop FIN O
Enforce Smartbadge PIN No
PIN Timeout {in seconds) 300
Enforce device forall ON
Minimum Password Length 5
Require at least one letter Yes
Auto Lock (in minutes, seconds) m
Enforce Change Password Yes
Password Change frequency (in days) 120
Unique Is before reuse d 2

password

Whether or not a Password Palicy will be pushed to ALL Smartphones to set and manage a device

Coc

Help

If Enforce App PIN is set to OFF, VCS users are not required to supply a PIN.
To enforce the use of a PIN for Vocera Smartbadge users, set the Enforce Smartbadge PIN option to

Yes.

System Options

SMTP Port 25
SMTP Authentication Mo
Security
Device validation certficate Add
Enable smartphone authertication by certificate No
Erforce S5L for smartphone connections Yes
Enforce server certificate validation on smartphone No
Enforce App PIN OFF
Erforce. Smartbadge PIN No
PIN Timeout {in seconds) 300
Enforce device 1 for all ON
Minimum Password Length 5
Require at least one letter Yes
Auto Lock (in minutes, seconds) m
Erforce Change Password Yes
Password Change frequency (in days) 120
Unique before reuse 2
Whether:jor not a Password Policy will be pushed to ALL Smartphones to set and manage a device
passwo

Coc

Help

. If Enforce App PIN or Enforce Smartbadge PIN has been selected, set PIN Timeout to the amount

of time, in seconds, that the device can remain idle before the PIN must be entered again.
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8. To enforce a device password for all smartphones, set the Enforce device password for all
smartphones option to ON. To enforce a device password for shared smartphones only, set this option
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to Shared.
Systern Options >
SMTF Port 25 ()
SMTP Authentication No
N
Device validation certficate Add
Enable smartphone authentication by certificate No
Enforce S5L for smartphone connections Yes
Enforce server cedificate validation on smartphone No
Erforce App PIN COFF
Enforce Smartbadge PIN No
PIN Timeout (in seconds) 300
Enforce device password for all smartphones ON \»I
Minimum Password Length 5
Require at least one letter Yes
Auto Lock (in minutes, seconds) m
Erforce Change Password Yes
Password Change frequency (in days) 120
Unique passwords before reuse permitted 2
Waimum failed stemots before device wine i} v
Descripti
Whether or not a Password Policy will be pushed to ALL Smartphones to set and manage a device
password
Cancel Help

Configure the following options:

Option

Minimum Password Length

Require at least one letter

Auto Lock

Enforce Change Password

Password Change
frequency

Unique passwords before
reuse permitted

Maximum failed attempts
before device wipe

Description

Enter the number of characters the user must include in the device password.
For iPhone users, the device Passcode Lock settings must be changed if you
want a password longer than 4 numerical digits.

Select Yes to ensure that the user adds at least one letter to the device
password. For iPhone users, you cannot insist on a password with at least one
letter. For iPhone users, the device Passcode Lock settings must be changed if
you want a password to include a letter.

Set the duration of inactivity, in minutes and seconds, until the device auto-
locks. In the following example, the device is set to auto-lock after five minutes
and thirty seconds:

5m30

Select Yes to ensure the user changes the device password at a regular
frequency.

If Enforce change password is set to Yes, enter the interval, in days, at which
the user is required to change the device password.

The VMP Server stores a list of the most recently used passwords for a device.
A password cannot be reused if it is one of the I most recent passwords used,
where N is the value of this option.

Enter the number of times a password can be incorrectly entered before all
system sensitive information is wiped from the device.

Tip: When configuring password options, remember to consider the speed at which your users
must view and respond to critical communications. An auto-lock setting that is too short will
impair the user's ability to quickly respond to messages and communications. A password that
requires too many characters may also be inhibiting, depending on the environment.
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=== Note: If you change the Enforce App PIN setting to ON, device users will not be able to set a PIN
== if they registered by email or using a registration key and do not have either a valid VMP Server
username and password or a valid Active Directory username and password.

Vocera Messaging Platform provides a data wipe option to let you remove sensitive Vocera data from the
mobile device without affecting any other mobile data. Additionally, if a more in-depth device wipe is
required, leveraging Microsoft Exchange or a Mobile Device Management tool may be effective.

This is useful when a user is no longer employed by the organization, a device is lost or stolen, a shared
device is assigned to a new user, or in the event of a communicated security breach.

You can use the VMP Administrator to wipe sensitive Vocera data from the device.

1. Select the Users & Groups module, and click to highlight the user to remove.

2. Select the Delete button. A window will prompt the administrator to remotely wipe the data from
the smartphone. Once complete, the user account will be inactive on the server, and VMP data will be
removed from the user's device.

If you have an iOS or Android device, you can use Microsoft Exchange to wipe sensitive Vocera data from
it.

—

. In the console tree, navigate to Recipient Configuration > Mailbox.
. Select the user from the Mailbox window:.

. In the action pane, click Manage mobile device, or right-click the user's mailbox, and click Manage
mobile device.

Select the mobile phone.
. In the Actions section, click Clear, and click Clear again.

w N

S

You can use Outlook Web to wipe sensitive Vocera data from an Android or iOS device.

Note: This process is specific to i0S or Android devices.

Open the Outlook Web Application in a browser.

Sign in to the device owner's mailbox, and click Options.

In the Navigation Pane, select Phone.

Click the Mobile Phones tab.

Select the ID of the mobile phone that you want to wipe and remove from the list.
Click Wipe device and click OK.

Click Remove Device.

No gk wN =

You can use a Mobile Device Management (MDM) solution to wipe sensitive Vocera data from your device.
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1. Submit a wipe request through the console, MDM Shell, or Self Service Portal. Submit the request as a
Wipe Now command stored in a central database to be picked up by the device within a determined
time in travel.

2. The device receives this Alert and immediately starts a management session with the Device
Management server.

3. The device picks up its wipe request from the Device Management server, sends back an
acknowledgement that started the wipe, and starts the wipe process.

You can remove sensitive Vocera data from your device using an Exchange Management Shell (ECS)
remote wipe.

1. Send a Get-ActiveSyncDeviceStatistics command, using the following syntax, where name is the
user id:
Get-ActiveSyncDeviceStatistics - Mailbox name | fl Identity

2. Send a Clear-ActiveSyncDevice command, using the following syntax, where name is the user id:
Clear-ActiveSyncDevice -Identity WM_name
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The Vocera Messaging Platform is designed to support clustered environments using active server and
passive server configuration.

In a clustered environment, the primary server:

* Routes system traffic.
* Responds to the load balancer acknowledgment request every ten seconds.
* Updates the SQL server timestamp every two seconds.

Secondary nodes retrieve a timestamp from the SQL server every two seconds, but stay passive unless

the primary node has not updated the SQL server timestamp in the last 20 seconds, at which point the
primary node is assumed to have failed. The load balancer manages the status of each VMP Server by
sending a health check request to the primary and secondary nodes. The load balancer redirects traffic to

a secondary node after a third missed heartbeat from the primary node.

Note: For instructions on how to install VMP on a cluster, see on page 23.

6 Tip: Configure email alert notifications to receive an alert when a failover occurs. For details, see
on page 97.

A typical failover configuration consists of a primary and secondary VMP Server, a load balancer, and a
SQL server.

This table shows the behavior of each of these server nodes.

Node Description

Primary Vocera Messaging Platform (VMP Server 1) * The primary server is accepting all HTTPS traffic.

* The primary server is responding with a positive
acknowledgment request from the Load Balancer
every 10 seconds.

* The primary server is updating the SQL server with a
timestamp every 2 seconds.
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Node

Secondary Vocera Messaging Platform (VMP Server 2)

The Load Balancer in conjunction with the VMP Server

pair

The SQL Server in conjunction with the VMP Server pair

HIGH AVAILABILITY AND VMP

Description

The secondary server is the standby server.

The secondary server is not responding with a
positive acknowledgment request from the Load
Balancer every 10 seconds.

The secondary server is retrieving a timestamp from
the SQL server every 2 seconds.

If the SQL timestamp table has not been updated by
VMP Server 1 within 20 seconds, VMP Server 2 will
automatically start its HTTP interface and begin to
accept traffic from the Load Balancer.

The Load Balancer is sending an HTTP health check
request to both VMP Server 1 and VMP Server 2.
After a third response failure from VMP Server 1, the
Load Balancer will start routing traffic to VMP Server
2 (This will happen once VMP Server 2 has initialized
its HTTP interface and is accepting requests.).

VMP Server 1 is updating a timestamp in the SQL
Timestamp Table every 2 seconds.

VMP Server 2 is retrieving the timestamp from the
SQL Timestamp Table every 2 seconds.

You can use the VMP Enterprise Manager to specify where an email notification is to be sent if a failover

occurs.

1. From the VMP Server, start the VMP Enterprise Manager:
Start > All Programs > VMP > VMP Enterprise Manager

2. Select Configuration > Advanced Options.

m VMP Enterprise Manager - [Configurator]

ool File Tools

Main | Confi

£} Advanced Optionsl Save
4 ?#> Name
SR j Database

L
anfiruratinn Auth

3. In the SMTP section, type the SMTP mail settings for your deployment.

SMTP
[F Server smitp
i3 Port 25

£k VMP email

dtillE@vocera com

4. In the Logging section, type the notification email address.

Logging
L Limit log messages toWMP Log File ‘write all everts
3 Limitlag messages to Windaws Event Log Errars

% Limit EMail notifications Do not notify

I r‘; Email Addressies] for Motifications dhill@vocera. com

g} Enable extended communication logging falze
[3 Enable smartphone extended communication logging false

C; Enable web console extended communication logging falze

If a failover occurs, the following email is sent:

Message from the VMP server: VMP SERVER2
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VMP SERVER2 server becomes active application server

When a failover occurs, the secondary VMP Server takes over the role of the primary server.
The behavior of the two servers is shown below.
Primary VMP Server - VMP Server 1

* VMP Server 1 is now the secondary (passive) server.

* VMP Server 1 will attempt to send an E-Mail to the Administrator to indicate that a failover has
occurred.

Secondary VMP Server - VMP Server 2

* VMP Server 2 is the primary (active) server and is accepting HTTPS traffic from the load balancer.
* VMP Server 2 will send an email to the administrator indicating its primary server status.
* VMP Server 2 is updating the SQL server with a timestamp every 2 seconds.

The Load Balancer is working in conjunction with the VMP Server pair, and is now redirecting all HTTPS
traffic to VMP Server 2.

Network

Load Balancer

— HTTPS traffic
Requestiresponse " X Requestiresponse
sent every 10 sentevery 10

seconds seconds

—

VMP 1 VMP 2

Timestamp

sentto SQL

table every 2
seconds

% i
|

SQL Cluster

When a failover has occurred, the Load Balancer is now directing the HTTPS traffic to the secondary VMP

Server (VMP Server 2). You can reconfigure your environment so that traffic is directed to the primary
server.

After this action has started, the Administrator will receive an email indicating that VMP Server 2 has
become the primary server.

To reconfigure VMP Server 1 to be the primary server:

1. Shut down the Vocera Data Exchange Windows service on VMP Server 2.
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. Restart the Vocera Data Exchange Windows service on VMP Server 1. VMP Server 1 will assume
primary server status.

3. Restart the Vocera Data Exchange Windows service on VMP Server 2. VMP Server 2 will assume
secondary server status.

N

====| Note: If VMP Server 1 is to remain as the secondary server, no action is required.

If you want to use SSL in a clustered VMP Server environment, Vocera recommends that you put an SSL
certificate on each node on which a VMP Server is running. This ensures that all internal traffic between
the Load Balancer and each of the individual servers is secure, which may be a requirement in your
jurisdiction if you are transmitting patient information.

Network

Load Balancer

—_— HTTPS traffic

h 4
Y

VMP 1 Putan SSL certificate on

each node of the cluster. VMP 2

To determine whether you need an SSL certificate for your Load Balancer to ensure end-to-end
encryption, consult the specifications provided by the manufacturer of the Load Balancer.

SQL AlwaysOn Availability Groups and SQL AlwaysOn Failover Cluster Instances are high availability and
disaster recovery solutions that provide an enterprise-level alternative to database mirroring.

SQL AlwaysOn Availability Groups is available for SQL Server 2012 and later, and SQL AlwaysOn Failover
Cluster Instances is available for SQL Server 2014 and later.

An AlwaysOn Availability Group supports a failover environment for a discrete set of user databases,
known as availability databases, that fail over together. The availability group supports a set of read-write
primary databases and one to four sets of corresponding secondary databases.
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An AlwaysOn Availability Instance supports a failover environment for a complete SQL instance, known
as a failover cluster instance. When one instance fails, the secondary instance is activated. Refer to the
Microsoft SQL documentation for information on how many secondary instances you can create in your
environment.

Note: Multiple listeners on different subnets in an AlwaysOn environment are supported. Contact
Vocera Technical Support for details on how to configure the VMP Enterprise Manager to use this
capability.

To set up an AlwaysOn Availability Group for VMP, contact Vocera technical support to obtain SQL scripts
needed to run on each secondary SQL instance.

To set up an AlwaysOn Failover Cluster Instance for VMP, no specific VMP-related configuration is
required.
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Learn how to configure wireless gateways and email connections in VMP.

You can configure the SNPP and WCTP wireless gateways for VMP.

The SNPP protocol facilitates a link between the Internet and a TAP-compliant paging terminal. To
configure VMP for use with a provider using SNPP, you must have the provider's SNPP address and port
number.

For a list of provider SNPP addresses and port numbers, see

For a deployment with SNPP protocol, you can use the VMP Administrator to configure the SNPP Wireless
Gateway.

1. Start the VMP Administrator application:

All Programs > VMP > VMP Administrator
2. Type admin (or your administrative credentials) in the VMP Login dialog, and click OK.
3. Select Configuration > Wireless Gateways.

Users & Groups

Wireless Gateways

The Wireless Gateways window appears.
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4. Click to highlight AT&T SNPP, and click Edit.

ATET SNPP

5. Select the SNPP Implementation from the dropdown list.

ATT, Sprint, and Verizon are pre-configured. For another implementation, select Generic and provide

the following details:

Table 11: SNPP Configuration Options

Option
Name

Secure delivery

Host
Port

Send short message if
available

SNPP gateway
compatibility

Max # of characters per
message

Delivery receipts

Treat "accepted by
gateway" as delivery
receipt

Multiple Choice responses

Use authentication

Values
Name the SNPP implementation.

Select this option if the channel is secure and the full message content can be
delivered. If this option is not selected, only the message subject is delivered.

Enter the host name.
Specify the port number to use.

Use the brief version of the message body provided via SOAP if it exists.

Select One way or Two way from the dropdown list.

Enter the maximum number of characters allowed in a text message.

Select to activate delivery receipts if this option is supported by the provider.
Select this option if it is supported by the provider. If this option is selected, the
message is deemed delivered when accepted by the gateway.

This option is selected by default. Leave this option active unless instructed

otherwise by the provider.

If authentication is required to establish the gateway connection, click to activate
this option and enter the login credentials.
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MNew Wireless Gateway *
Name:
[i
Type:
SNFPP ~

Secure delivery
SNPP Implementation:
Generic ~
Host: Port:

| a4 :

[] Send short message if available
Supported Features

SNPP gateway compatibilty: | Two way ~
Max H of characters per message:
1 Delivery receipts

[] Treat "accepted by gateway” as delivery receipt
Muttiple choice responzes

[ Use authertication

QK Cancel Help

VMP supports polling to add additional features to AT&T Enterprise Paging, Sprint SMS, and US messaging
gateways. Polling sends messages to the gateway at a set interval in order to determine if the page is sent,
delivered, and read.

Use the following steps to configure polling for WCTP.

1. Start the VMP Administrator.
2. Select Configuration > System Options.

Systemn Options
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The System Options dialog box appears.
3. Scroll down to WCTP, enter the polling IDs, and click OK.

Learn how to integrate inbound WCTP, SOAP, or email connections to the VMP Server.

Note: By default, VMP licenses do not include access to the WCTP or SOAP connectors. See
on page 19 for more details.

VMP supports inbound WCTP messages from external systems, and forwards these messages to end-users'
mobile devices.

====| Note: VMP supports the features of WCTP version 1.1. Requests from other versions are not
rejected.

Messages are delivered from VMP to:

* Supported iOS devices

* Supported Android smartphones
* Cellphones (via SMS)

* Pagers (via SNPP)

* Vocera badges

Delivery receipts, read receipts, text responses, and multiple choice responses are supported. The WCTP
request sent to the VMP Server sets the appropriate flags to true as per the specification, and the VMP
Server provides the response to the initiating system. The VMP Server posts these responses and read/
delivery receipts back to the originating system in real time.

The VMP SOAP-based API provides support for external systems to send messages, and to receive delivery
statuses and responses to the messages (see the Vocera Messaging Platform API Guide for details).

Systems that support WCTP generally allow the administrator to identify users in the system as WCTP
users, and point the WCTP configuration to the VMP Server. When a message needs to be sent, the system
will send the message via the WCTP protocol to the VMP Server.

====| Note: USA Mobility is supported via outbound WCTP through a direct push rather than polling.

To configure WCTP, the third party needs the VMP Server URL with /wctp?F=XX appended. The format
follows:

www.domain.com/wctp?F=XX

XX refers to the third-party system initiating the messages. The configuration is shown in the following
code sample:

F=EM For Emergin
F=generic For all other systems (including Connexall)

To override the end user's profile settings, based on the priority of the message sent, append one or more
of the following additional tags to the URL. Each tag can be set to Y (override) or N (do not override).

Tag Description

&0H Whether to override the user profile when the priority is High.
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Tag Description
&50ON Whether to override the user profile when the priority is Normal.
&0L Whether to override the user profile when the priority is Low.

The priority of the VMP message depends on these settings and on the priority of the message payload, as
shown in the table below.

Priority appended to URL Message payload priority Resulting VMP message priority
High High
Normal Normal
SO0H=Y High Urgent
SO0H=Y Normal Normal
SOH=N High High
SO0H=N Normal Normal
SON=Y High High
SON=Y Normal Normal
&ON=N High High
&SON=N Normal Normal
&OL=Y High High
&0L=Y Normal Normal
&OL=N High High
&0L=N Normal Normal

====| Note: These settings are supported on the Vocera Collaboration Suite and other Vocera smartphone
clients.

If you are using an Emergin third-party system, and your message text contains LVL or 1v1, the multiple-
choice responses *ACK and *NAK are automatically inserted into the message.

To link users with a WCTP source, a user must be created to support WCTP. This user account will send
the messages.

1. Start the VMP Administrator.
2. Select Users & Groups > Users.
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The Users window appears.
3. Click to highlight the Partner Alerts entry, and click Edit.

4. Specify a name that is relevant for your deployment. This is the name that appears as the sender for
messages sent via WCTP.

. Note: To synchronize this user with the WCTP source, set the Public ID field or the Pager ID

field for this user to match the WCTP Source senderID.

5. Click Next, and click Finish.
6. Select Configuration > System Options.

The System Options dialog box appears.

7. Scroll down to the Default Subject for 3rd Party Integrations entry, change the subject line as
appropriate for your deployment, and click OK.
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__
Allow User to upload personal image

Allow Email Communication Yes
e S I
Enable Remind Me Later Option Yes

Default Subject Line for 3rd Party Integrations 3rd Party Metification I
Response waiting interval (in seconds) 600

Retain Message History in Database (in weeks) 104

Deliver message content to SMS users Yes

Allow Urgert messages Yes

Include attached images in the report No

Mumber of days of inactivity to archive a conversation {in days) 14

Allow users to forward messages Yes

Forward clinical system messages Mo

Allow attaching pictures from a file Yes

Allow attaching pictures from the camera Yes
T
Fnzhle Do Not Distut Mode on Smatohane Client: Y hd
D L

Cancel Help

If a WCTP message starts with the text Subject:, VMP uses the rest of the line containing this text as the
subject field for the message. VMP then skips one empty line and extracts the remaining data as the body
of the message.

The following is a simple example of a WCTP XML payload that overrides the default subject:

<?xml version="1.0"?>
<IDOCTYPE wctp-Operation SYSTEM "http://dtd.wctp.org/wctp-dtd-virl.dtd">
<wctp-Operation wctpVersion="wctp-dtd-virl">
<wctp-SubmitRequest>
<wctp-SubmitHeader submitTimestamp="2010-03-31T01:00:56">
<wctp-Originator senderID="166.214.43.65:8088/WCTP"
securityCode=""/>
<wctp-MessageControl messageID="5345-21" transactionID="5345-21"
allowResponse="false" notifyWhenDelivered="false"
deliveryPriority="HIGH" preformatted="true"/>
<wctp-Recipient recipientID="12345"/>
</wctp-SubmitHeader>
<wctp-Payload>
<wctp-Alphanumeric>Subject: This is a subject.

This is a message body</wctp-Alphanumeric>
</wctp-Payload>
</wctp-SubmitRequest>
</wctp-Operation>

Users that are configured to receive WCTP messages can be set up manually using the VMP Administrator,
or the VMP Server can connect to a SQL table and synchronize this information on a regular schedule.

1. Start the VMP Administrator.
2. Select Users & Groups > Users.
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The Users window appears.
3. Click to highlight the user that is to be configured to receive WCTP messages, and click Edit.

4. Enter a value in the Public ID field or the Pager ID field to match the WCTP Source recipientID.

108 VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



WIRELESS GATEWAY AND EMAIL CONFIGURATION

il Note: The WCTP Source can identify the recipient using a phone number, email address, or
y randomly generated number. The only requirement is that it must match the user Pager ID field.

5. Click Next, and click Finish.

SOAP Connections

VMP supports inbound SOAP messages from external systems, and forwards these messages to end-users'
mobile devices.

SOAP provides considerable flexibility for structuring inbound messages.

For more information on the SOAP interface to VMP, and on the entry points, data classes, and methods
that are defined for it, see the Vocera Messaging Platform API Guide.

| Note: By default, VMP licenses do not include access to the WCTP or SOAP connectors. VMP
yJ must be licensed to use the SOAP connector. See Configuring the VMP License on page 19 for more
information.

Configuring VMP to Receive SOAP Messages

Users or distribution lists that are configured to receive SOAP messages can be set up manually using the
VMP Administrator.

1. Start the VMP Administrator.
2. To configure a user to receive SOAP messages:
a. Select Users & Groups > Users.

&

Users

The Users window appears.
b. Click to highlight the user that is to be configured to receive SOAP messages, and click Edit.

c. Enter a value in one of the following fields that will match the identifier provided in the SOAP input:
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* AD Account (visible only if the VMP Server has been configured to allow any Active Directory
user to log in)
e Pager ID
* VoceraID

Edit User X
Step 1: End-User Settings

First Name:

Step 1: End-User Settings
Step 2: Push Technology and Licensing Midde Name: |

|
|
Last Name: ‘Morgan |
|
|

Title: [Patient Care Technician

Email: |amorgan@dil local

Public ID: [

Pager ID:

Vocera ID: u-gmorgan

Home Ste:  |Global
Auto Forwarding
Allow Forwarding: | Follow System Settings (Yes) ]

Forwerd To: | | [ Remove

Desktop and Web Access
[ Enable PC Admin Console Access
[#] Enable Web Console Access
Active Directory Authentication
Vocera credentials
Login [amergan |

Password:  |Click here to change .. |
Confirmation | |

[ et ([ Canod || e

d. Click Next, and click Finish.
3. To configure a distribution list to receive SOAP messages:
a. Select Messaging > Distribution Lists.

b. Click to highlight the distribution list that is to be configured to receive SOAP messages, and click
Edit.

c. Enter a value in the Distribution List ID field that will match the identifier provided in the SOAP
input.

| Note: If the Vocera ID field is available, you can use it to match the identifier provided in the

J SOAP input.
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Edit Distribution List - Users X

Name and Type

Enter 3 name forthe Distribution List (DL) that is being created. Check the 'On-Call Distribution List’ checkbox to enable on-call
functionality so that only members of the DL who have a status of ‘On-Call' or "Monitor' will receive a Alert sent to DL. The Minimum Users
On-Call defines the minimum number of DL members that can be On-Call at any one time:

Name and Type Distribution List Name:
Users Doctors ‘

DL Access rmm Tt 10
| |

Ste:

[ Enable for Texting

Hidden
Members
(®) Add Users Manually
(O Create DL based on Active Directory structure

Next > Cancel Help

d. Click Next, Next, and Finish.

Vocera Messaging Platform provides features to integrate user email into the Messaging feature. The
server monitors the email box and sends a message to the user when new mail is received.

The following services are supported:

e POP3

e IMAP

* Exchange Web Services (EWS)

The email body is expected to contain an XML document with specific tags used by the VMP Server. Email
aliasing and redirection are not necessary, as email messages are sent directly to the monitored mailbox.

The XML document contained in the email body defines the recipients for the message. The email header
fields are not used to determine the recipients and sender information.

To view an example, see on page 113.

You can use the VMP Administrator to specify the configuration parameters for sending messages using
email.

====| Note: For email messages, the VMP Server supports Plain Text format only. The email body must
= be in XML format.

1. Start the VMP Administrator.
2. Select Configuration > System Options.
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The System Options dialog box appears.
3. Scroll to Integrations > Email.
4. From the Enable Secure Message Initiation dropdown list, select Yes.

System Options X

User ID 0
Shared Key
Email
Secure Message Initiation — Incoming Mail
Protocol FOP3
Email Scan Interval (in seconds) 30
Initiation Permitted From WVMP users only
Email Usemame:
Email Password —
Corffirn Email Password —
POP3/IMAP4/EWS Host
POP3/IMAP4/EWS Port 110
Delete Email Once Processed Immediately
PallinglD 1
PolingID 2

[ok || concel || Heb |

5. In the Secure Message Initiation - Incoming Mail section, provide the configuration settings that
are appropriate for your POP3, IMAP4, or Exchange Web Services deployment. See the Secure Message
Initiation - Incoming Mail section of the Integrations table in
on page 258 for a complete description of these options.

6. Scroll back to System and Networking > Email.

7. Set Enable Outgoing Email to Yes. This ensures that delivery and response updates can be sent back
to the email initiator.

8. Provide the outgoing email settings that are appropriate for your SMTP deployment. See the Email
section of the System and Networking table in on page
258 for a complete description of these options.
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Because the email body is in XML Format, email aliasing and redirection are not required, as the XML
document contains all of the necessary information.

The following XML tags are supported:

Tag Description

AlertExternallID: The ID of the message, as specified by the initiating process or system.

From: The sender or initiator's name and email address.
The value stored in the From field must match the Email and Public ID fields in an existing VMP user
definition. See on page 118 for more information on the fields that can be

specified for a VMP user.

To: A list of one or more recipient email addresses.
The value stored in the To field must match the Public ID field in an existing VMP user definition, or the
Distribution List ID field in an existing VMP Distribution List definition. See
on page 118 for more information on the fields that can be specified for a VMP user, and see
on page 152 for more information on creating a Distribution List.

Subject: The message subject.
Message: The body of the message.
Priority: The message priority. Must be one of Normal or High. To specify Urgent priority, set

Priority to High and set OverridePersonalAlarmSettings to true. For Normal or
High priority, OverridePersonalAlarmSettings must be set to false.

OverridePersonalAlarmSe Whether the message should force the recipient's device to emit a tone and vibration.
Valid options are true and false. See the description of Priority above.

notifyWhenDelivered: Whether the Delivered status notification should be sent back to the initiator.

notifyWhenRead: Whether the Read status notification should be sent back to the initiator.

sendResponse: Whether the initiator should be notified when a recipient sends a response.

notificationEmail: The email address for status notifications. Overrides the email address specified in the
From: tag.

ResponseType: The response type associated with the message. This is one of the following:

* None: No response is required.
e Multi: Recipients must select from one or more responses defined in the message.

Responses: When ResponseType is set to Multi, this is a container tag for the responses defined
for the message. Each response is contained in an EmailPagingAlertResponse,
which is defined below.

Each EmailPagingAlertResponse tag contained in the Responses includes the following subtags:

Subtag Description

RspExternallD: The third-party ID associated with this response. This ID is returned to the initiating
system if the recipient selects this response.

Text: The text that is displayed for this response.

Here is an example of an XML email template.

<?xml version="1.0"?>
<EmailPagingAlert>
<AlertExternalID>externalID1</AlertExternalID>
<From>user_sender@company.com</From>
<To>
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<string>user_recipient@company.com</string>

<string>dl_recipient@company.com</string>
</To>

<!-- High, Normal -->
<!-- For urgent priority, set Priority to High and -->
<!-- OverridePersonalAlarmSettings to true -->

<Priority>High</Priority>

WIRELESS GATEWAY AND EMAIL CONFIGURATION

<OverridePersonalAlarmSettings>true</OverridePersonalAlarmSettings>

<notifyWhenDelivered>true</notifyWhenDelivered>
<notifyWhenRead>true</notifyWhenRead>
<sendResponse>true</sendResponse>

<notificationEmail>user_sender@company.com</notificationEmail>

<Subject>Test subject</Subject>
<Message>Test message</Message>

<!-- None, Multi --»>
<ResponseType>Multi</ResponseType>
<Responses>

<EmailPagingAlertResponse>
<RspExternalID>extid1</RspExternalID>
<Text>Response 1</Text>
</EmailPagingAlertResponse>
<EmailPagingAlertResponse>
<RspExternalID>extid2</RspExternalID>
<Text>Response 2</Text>
</EmailPagingAlertResponse>

</Responses>
</EmailPagingAlert>
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The VMP Administrator enables you to perform all necessary administrative tasks for the VMP Server. It
can be installed on the same computer as the VMP Server or on a separate machine.

To use the VMP Administrator, you must first log into it.

1. Open the VMP Administrator.

2. Select Start > All Programs > VMP > VMP Administrator.
The VMP Login dialog appears. The appearance of this dialog depends on the login options that have
been configured. By default, the dialog asks you to type your VMP login name and password:

VMP Login

e

Enter registration information:

I E—

Cancel Help

*

If the Allow any Active Directory user to login configuration option has been set to true, radio
buttons enable you to specify whether to use Active Directory or VMP credentials to log in:

VMP Login

e

Enter registration information:

A —

Credentials type:
(®) Active Directory

() VMP system

Cancel Help

x

If the Allow current logged domain user to login option has been set to true, a checkbox appears
that enables you to use Windows authentication to log in:

VMP Login

e

Enter registration information:

I E—

[ Use Windows authentication

Cancel Help

x

If both of the above options have been set to true, both options are available on the login screen:
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VMP Login X
Enter registration information:
o R E—
Credentials type
® Active Dirsctory
() VMP system
[ Use Windows authentication
Cancel Help
See on page 38 for more information on configuring the VMP
Server for use with Active Directory, and see on page 258

for more information on the options shown here.
3. If the Credentials type radio buttons are available, select one of the following:

Credentials Type Description

Active Directory Select this option to log in using your Active Directory credentials.

VMP system Select this option to log in using your VMP system credentials if you have been
authorized to do so.
See on page 118 for details on setting the Enable PC Admin Console Access

option to authorize user access to the VMP Administrator.
4. Alternatively, if the Use Windows authentication checkbox is available, select it to use your
Windows authentication credentials to log into the VMP Server.
5. If you are not using Windows authentication, type the Login and Password, and click OK.

If you are the system administrator and are logging into the VMP Administrator for the first time:

* If the Credentials type radio buttons are available, select VMP system.
* In the Login field, type admin.

* In the Password field, type the administrative password that you supplied in the Security Options
dialog box during installation. See on page 13 for more details.

=== Note: To exit the VMP Administrator, select Exit from the File menu.

The VMP Administrator is organized into modules, each of which performs a set of common
administrative tasks.

The following modules are defined:

¢ Users & Groups

* Contacts

* Messaging

* Content

* Reports

* Configuration

If you are not the administrator and some or all of these modules are not visible to you, your

administrator has not granted the user rights that you need to view them. See on page
123 for more information on granting user rights.

To access a module, click its name in the left pane of the VMP Administrator window:
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&) YMP (Default administrator) - [Users] — [m] pe
£ File View Window Help .8 x
Users 8 Groups
QPO ® 2| % Total: 10 | ®
Name 4 Login Device ID Email Public 1D Vocera ~
Calvin Lu clu clu@dil local ucl
0 Carol Wison cwilson Jocal ucwisol
ers
Default administiator admin
Grace Morgan gmorgan local ugmorg;
() [l Jen Mchiaster jmcmaster jmemaster@dtil local ujmema
8‘ Josh McNab imonab imenab @dillocal ujmenal
Groups Linda Davis il local udavis
Paging gateway user paw. v
< >
8‘ Memberof Cortent Distribution Lists View Sent By — Text Messages  View Received By - Text Messages  Messaging Templates
F i =
Group Profiles ©ols .
Name 4 Patient Data Access
9 Diszster Recovery Team
Contacts
| Messaging
| content
| Repors
| Configuration

You can also access a module or its components from the View menu.

====| Note: If multiple windows are being displayed in the VMP Administrator, you can use the Window
menu to control the window layout. Select one of Gascade, Tile Horizontally, or Tile Vertically
to display all windows, or select a window to view. Select Close to close the window that you are
viewing.

The Users & Groups module provides features to import, create, and manage VMP users. This module also
allows you to use groups to create user sets and Distribution Lists to manage access permissions and on-
call scheduling.

Users can be entered and updated manually, or VMP can synchronize with contact lists in other corporate
systems.

’=| Note: Some of the features found in the Users & Groups module are covered in the following

sections:

. on page 49, which describes how to import users and contacts
from a Vocera Voice Server, an Active Directory server, and a SQL server, and how to import from Excel
and CSV files.

. on page 74, which describes how to send installation

and registration instructions to a client device.

If you want to add a user that is not included in your remote resource, you can add the user manually. You
can also manually delete users from the system.

Tip: When editing imported users, do not edit fields that synchronize with the imported source.

0 These changes should be made at the source to avoid overwriting the changes when the source
synchronizes with the VMP Server. If the email address of a contact is changed on the VMP Server,
or the Public ID of the contact is changed if no email address is provided, the contact will not
synchronize with the source.
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If you want to add a user that is not included in your remote resource, you can add the user manually.

1. From the VMP Administrator, select Users & Groups > Users.

S

Users

2. In the toolbar in the Users pane, click Add.

The End-User Settings window appears.
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Edit User

Step 1: End-User Settings

Step 1: End-User Settings
Step 2: Push Technology and Licensing

First Name: |Jen

Middle Name: |

Last Name: | McMaster

Title: |Registered Murse

Email: |imcmaster@dtill.lncal

Public ID: |

Pager ID: |

Vocera ID: |u-jmc:master

Home Site: |Global

Auto Forwarding

Allow Forwarding: | Follow System Settings (Yes) ~

Forward To: |

Deskiop and Web Access
] Enable PC Admin Console Access
Enable Web Console Access
Active Directory Authentication

AD Account: | DTILLymcmaster

Vocera credentials

THE VMP ADMINISTRATOR

Login:

Password:

|imcmaster |

|Cl\ck here to change... |

Corfirmation: |

Mext = Cancel Help

3. Enter the following end-user settings.

Table 12: End-user settings
Field

First Name

Middle Name

Last Name

Title

Email

Public ID
Pager ID
Vocera ID

Home Site

VST ID

119

Description

The first name of the user.

The middle name of the user (optional).
The last name of the user.

The job title for the user.

The email address for the user.

The user's public ID. This optional field can be used to identify the
recipient in APIs that are supported in VMP.

The user's pager ID. This optional field is populated when the VMP Client
Gateway API is implemented.

The user's Vocera ID. This optional field is populated when the VMP Client
Gateway API is implemented.

The site to which the new user is to belong.

Sites are available if they have been created on the Vocera Voice Server with which the
VMP Server has been integrated. See on page 31 for more
information on integrating with the Vocera Voice Server.

If a user has been imported from a Vocera Secure Texting cloud server,
this field contains the StaffID value that was assigned when the user was
created in VST.
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Field Description

Allow Forwarding Use this dropdown list to allow forwarding of messages from this user to
another user. Select Follow System Settings (the current system setting
is shown in brackets), Yes, or No.

Forward To When Allow Forwarding is enabled, this specifies the user to which
messages are being forwarded. This is set in the Vocera Collaboration
Suite application only.
To remove forwarding if it has been set up, click Remove.

Profile Select from this dropdown list to associate the user with a group profile.
See on page 134 for more information on group profiles.

Enable PC Admin Console Access Select this checkbox to allow the user to access the VMP Administrator.

Enable Web Console Access Select this checkbox to allow the user to access the VMP Web Console.
Activating this field requires you to enter authentication credentials for
the user.

AD Account If the new user has an Active Directory account, enter the account name

in the AD Account field. This option appears if VMP Administrator access
with Active Directory credentials is configured during installation.

Vocera credentials To provide Vocera credentials for the new user, enter the VMP
Administrator login in the Login field, enter the password in the
Password field, and re-enter the password in the Confirmation field.

4. Click Next to display the Push Technology and Licensing window.

Edit User X

Step 2- Push Technology and Licensing

Mobile Device Access

Step 1: End-User Settings
Enable

Step 2: Push Technology and Licensing

Device type: Wocera Smartphone Client ~
Registration Key: ‘ ‘ [ Generate key
Device PIN: ‘

Enforce App PIN: Follow System Settings (Off) o

Reset PIN

VMP Applications On Device
Application Name

< Back Cancel Help

5. To enable mobile device access, select the Enable checkbox, and select the device type from the Device
type dropdown list.
6. To register the user, type the registration information in the fields provided.

====| Note: For details on how to generate a registration key and email this registration information to
the user, see on page 74.
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7. From the Enforce App PIN dropdown list, select one of the following:

Follow System Settings Use the setting defined in the Enforce App
PIN configuration option, which is set in the
VMP Administrator. VMP Server configuration
options. This is the default. This option displays
the current system setting, which is one of Off,
On, or Shared.

Enforce PIN Enforce the use of an application-level PIN for
this user.
Do Not Enforce PIN Do not require this user to provide an application-

level PIN, even if a PIN is normally required.

8. Click Reset PIN to reset the PIN for this user. This forces a logout of the user.

9. In the VMP Applications On Device pane, select the VMP applications to which the user is to be
granted access. Access can be granted to an application only if at least one unused license is available.

Note: The applications that are available to you depend on whether your license key is in an
XML format. See on page 21 for more details on this format.

10.Click Finish to finish creating the new user.

You can manually delete any user, and can optionally wipe all data stored in the user's smartphone
application.

1. From the VMP Administrator, select Users & Groups > Users.

2. In the Users pane, click the name of the user to be deleted.
3. In the toolbar, click Delete.
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4. In the confirmation dialog box that appears, select the Wipe data on smartphone checkbox (if it is
enabled) to wipe all data stored in the smartphone application.

5. Click Yes to confirm user deletion.
Editing User Information

For any user, you can edit the information, device registration, and list of applications to which access has
been granted.

1. From the VMP Administrator, select Users & Groups > Users.

S

Users

2. In the Users pane, click the name of the user whose information is to be edited.
3. In the toolbar, click Edit.

The End-User Settings window appears.

4. Edit the user fields as needed. For more information on user fields, see /dding Users Manually on page
118.
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In the VMP Administrator, you can specify the rights that are to be granted to any user on the system.

You can also assign a user to one or more Right Groups. Each Right Group grants a specific set of user

rights.

1. From the VMP Administrator, select Users & Groups > Users.

&

2. In the Users pane, click the name of the user for which user rights are to be edited.
3. In the toolbar, from the User preferences dropdown list, select User rights.

-

<

Memberof  Content Distribution Lists

>

8 Vsers = e |
oMe W@- 2|0 Total: 10 | ®

Neme |5 Uservights | Device ID Email PbiclD A
» Unlock user @il local

Carol Wisi & Applications on device e

Default & Plugins configuration

(Grmcs Mot ' Retrieve Application Logs local

Jen McMaster | memaster imemaster@dil local

Jash McNab imenab@diillocal

v

View Sent By - Text Messages  View Received By - Text Messages  Messaging Templates

(RN

"

Name
3

& Patient Data Access Site:

No I

The Edit Rights dialog box appears.

Edit Rights

» [M] Allow access to Paging AP| Gateway
[ Contacts manager [ | Assign documents to devices
[] | Content manager [] Change system settings
[1| Distribution lists manager [[1| Create/edit /delste VMP users
[ | Groups manager ]| Defautt email inttiation user
[ | Own group manager [ | Manage all documents
[ | Paging AP Gateway [ | Manage all groups
[ Reports viewer [ | Manage all schedules
[ | Supenuser [] | Manage contact distribution lists
[1| System manager [1| Manage contact sources
[1| Users manager [[1| Manage distribution lists
[ | Manage groups user belongs ta b
[Roh Dosenprion
[ok | camesl || Hep

4. In the Right Groups pane, click a Right Group. The rights associated with the Right Group appear in
the Rights pane. To grant these rights to the user, select the checkbox next to the Right Group. Repeat
this for other Right Groups as needed.
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See on page 125 for a list of the available right groups.

5. To grant custom permissions without selecting a Right Group, click Custom permissions to display
a list of rights in the Rights pane. Select the checkboxes of the rights that you want to grant. See
on page 124 to view a list of the available rights.

====1 Note: Rights that have been granted by assigning a user to a Right Group are already selected,
and cannot be changed in this way.

6. Click OK to finish granting rights to the selected user.

You can grant rights to VMP Administrator users to enable access to the server's capabilities.

User Right

Allow access to Paging API Gateway

Assign documents to devices

Change system settings

Create/edit/delete VMP users

Default email initiation user
Manage all documents

Manage all groups

Manage all schedules

Manage contact distribution lists

Manage contact sources

Manage distribution lists

Manage groups user belongs to

Manage schedules

Manage who views VMP text messages

View all distribution lists

124

Description

Allow use of the SOAP API interface. For more information on this
interface, see the Vocera Messaging Platform API Guide.

Deprecated - no longer in use.

Enable access to the Configuration settings in the VMP
Administrator and the Group Profiles screen in the Users & Groups
section.

Enable access to the Users screen in the Users & Groups section of
the VMP Administrator.

Enabling this user right does not grant permission to view the View Sent By - Text
Messages and View Received By - Text Messages tabs in the Users screen. To
grant permission to view these tabs, you must grant the Manage who views VMP
pager alerts user right.

Deprecated - no longer in use.
Enable permission to import and share content.

Enable access to the Groups screen in the Users & Groups section of
the VMP Administrator.

Grant permission to create and manage schedules that anyone has
created in the VMP Web Console. For more information, see
on page 232.

Enable edit access to the Distribution Lists screen in the Contacts
section of the VMP Administrator. Without this permission, users
can view the Distribution Lists screen, but cannot add, update, or
change contact distribution lists.

Enable access to the Contact Sources screen in the Contacts section
of the VMP Administrator.

Enable access to the Distribution Lists screen in the Messaging
section of the VMP Administrator.

Deprecated - no longer in use.

Grant permission to create and manage schedules that you have
created in the VMP Web Console. For more information, see
on page 232.

In the Users screen, grant access to view the View Sent By - Text
Messages and View Received By - Text Messages tabs.

To grant this user right, you must also grant the Create/edit/delete VMP users user
right.

Deprecated - no longer in use.
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View all messaging templates

View all pager alerts in the report

View all reports

View all schedules

Patient data access

THE VMP ADMINISTRATOR
Description

Grant permission to edit existing messaging templates. Without this
permission, users can view and create templates, but can only edit
templates that they have created.

Deprecated - no longer in use.

Enable permission to access the Reports section to open and view
reports.

Enable permission to view on-call schedules without being part of
the on-call distribution list.

Enable permission to access Engage patient data. This right is
not editable in this view. See

on page 40 for information on how to integrate
VMP with the Engage Patient Context Adapter and how to grant
patient data access to a user.

You can assign VMP Administrator users to right groups. Each right group grants one or more rights to its

members.

====| Note: Some of the rights listed here are now deprecated because they are no longer in use. See

deprecated.

Right Group

Contacts manager
Content manager
Distribution lists manager

Groups manager

Own group manager

Paging API Gateway
Reports viewer

Superuser

125

on page 124 for more details. A right group is marked as deprecated if all of its rights are

Rights included in group

Manage contact distribution lists
Manage contact sources

Assign documents to devices
Manage all documents

Manage distribution lists
Manage schedules

Manage all groups

Assign documents to devices
Manage groups user belongs to

Allow access to Paging API Gateway
View all reports

Allow access to Paging API Gateway
Assign documents to devices

Change system settings
Create/edit/delete VMP users

Manage all documents

Manage all groups

Manage all schedules

Manage contact distribution lists
Manage contact sources

Manage distribution lists

Manage groups user belongs to
Manage schedules

Manage who views VMP text messages
View all distribution lists

View all messaging templates

View all pager alerts in the report
View all reports
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Right Group Rights included in group
System manager Change system settings
Users manager Create/edit/delete VMP users

Manage all groups
Manage who views VMP text messages

If a user has been inactive for a specified number of days, the user is placed in a Locked state, and cannot
access the VMP Administrator. You can unlock any user that has been Locked.

1. From the VMP Administrator, select Users & Groups > Users.

2. In the Users pane, click the name of the user to be unlocked.

3. In the toolbar, from the User preferences dropdown list, select Unlock user. The selected user is
unlocked.

====| Note: The number of days of inactivity before a user is placed in a Locked state is specified in the
Configuration > System Options section of the VMP Administrator.

You can filter the list of users to make it easier to find a particular user.

1. From the VMP Administrator, select Users & Groups > Users.

2. Click Filter.
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The Filter Users popup appears.

First Mame:

Middle Mams:

Last Mame:

Title:

Lagir:

Device 10:

Device type:

|
|
|
|
Email |
|
|
|
|

L L4l

Wwireless gateway:

Member of:

Mame | Site |

Select | Femove groups I

3. To improve filtering, enter a search string in any or all of the fields provided, and select an item from
any or all of the dropdown lists provided.

4. To filter by group, click Select and add one or groups to the filter list. To remove a group from the list,
highlight it and click Remove groups.

5. Click anywhere outside the popup to close it.

When you enter a search string in a text field, select an element from a dropdown list, or specify a group,
the Users list automatically updates to use the filtering that you have specified, and the Filter icon changes
color.

80 e [
“ Total: 1
Name 4 Login Device ID Email Publi
(3 jmemaster jmemaster@dtill local

Member of Content Distibution Lists  View Sent By - Text Messages  View Received By - Text Messages  Messaging Templates

N ®
Name . Patient Data Access Site

» No I |

Right-click this icon to reset filtering.
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From the VMP Administrator, you can retrieve application logs for any VCS user for which a device ID has

been specified. This enables you to respond quickly if a problem is detected.

====| Note: To use this capability, your devices must be using version 3.2 or later of VCS.

1. From the VMP Administrator, select Users & Groups > Users.

2. In the Users pane, click the name of the user for which you want to retrieve the application logs.

3. In the toolbar, from the User preferences dropdown list, select Retrieve Application Logs. The
Retrieve Application Logs dialog box appears.
The Retrieve Application Logs option is available only when a Device ID has been specified for the
user.

4. In the Notification email address field, optionally type the email address to which to send a
notification that logs are available.

5. Click OK to upload the client logs to the VMP Server. These logs are stored in the WIC\Logs subfolder of
the folder in which you have installed VMP.

' Important: Logs are retrieved without notifying the user. It is your responsibility to create and

implement suitable policies to ensure that your use of this capability does not violate applicable
laws. For example, you may need to obtain a waiver of privacy rights from employees who use
Vocera Collaboration Suite as part of their employment.

You can use groups to organize users who have similar roles. From groups, you can manage access
permissions and on-call scheduling.

From the Users & Groups module, you can:

* C(Create, rename, and delete groups
* Add users to a group and remove users from a group
* Indicate what items are to be made accessible to the group

====| Note: If you have defined a large number of groups, you can use a filter to limit the groups that are

displayed. To filter the list of groups, click Filter ® and type the filter to use. The Filter icon changes
color. Right-click this icon to reset filtering.

From the Users & Groups module, you can create a new group.
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1. From the VMP Administrator, select Users & Groups > Groups.

2. In the toolbar in the Groups pane, click Add.

3. In the New Group dialog box, enter the name of the new group and click OK.

Changing a Group Name
You can change the name of any group that you have created.

1. From the VMP Administrator, select Users & Groups > Groups.

2. In the toolbar in the Groups pane, click Edit.

3. In the Edit Group dialog box, enter the new name of the group and click OK.

Deleting a Group

From the Users & Groups module, you can delete any existing group.
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1. From the VMP Administrator, select Users & Groups > Groups.

2. In the toolbar in the Groups pane, click Delete.

3. When asked to confirm whether you want to delete the group, click Yes.

Adding Users to a Group

From the Users & Groups module, you can add users to any existing group.

1. From the VMP Administrator, select Users & Groups > Groups.

2. In the Groups pane, highlight the group to which you want to add users.
3. In the pane at the right, click the Users tab and then click Add.

4. In the Select Users dialog box, click to highlight the users to be added and click OK.
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To filter the list of users in a group or in the Select Users dialog box, click Filter and enter the filtering
criteria to use.

The Filter icon changes color.

oRe| » Users  Cortent Messaging Templates Quick Messages Distribution Lists Access  Pemissions

Name - ste oS Totat: 1 [
» Narme « Login Device ID Emal
Everyone_Global » ggoodman | |agogafien@atillc

< >

To reset filtering, right-click Filter.

Removing Users from a Group

If a user is no longer required to be in a particular group, you can remove the user from the group.

1. From the VMP Administrator, select Users & Groups > Groups.

. In the Groups pane, highlight the group from which you want to delete users.
In the pane at the right, click the Users tab.

Highlight the users that you want to delete.

Click Delete.

SIS

6. When asked to confirm whether you want to delete the users from the group, click Yes.
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Granting Group Access

You can specify that items such as content, Messaging Templates, and Distribution Lists are to be made
accessible to a group.

1. From the VMP Administrator, select Users & Groups > Groups.

N

. In the Groups pane, highlight the group with which you want to associate items.

. In the pane at the right, click the tab corresponding to the item that you want to make accessible. For
example, click Content to make content accessible to the group.

4. Click Add.

w

o

From the list of available items, highlight the item to be made accessible.

. To grant additional permissions, click any or all of the following checkboxes:
Allow update

Allow delete

Allow manage access

Visible on device by default

7. Click OK.

(2}

To change the permissions for any item that has been made accessible, highlight the item, click Manage
access, and click any or all of the permissions checkboxes.

To make an item inaccessible, highlight the item, click Remove, and click Yes to confirm that you want to
remove access to the item.
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To refresh the list of available content in the Content tab, click Refresh.

Specifying Group Permission for a Quick Message

You can specify what groups are to be given permission to use a quick message. Any user that is a member
of the group can then use the message.

. Note: For more information on quick messages, see About Quick Messages on page 162.

1. From the VMP Administrator, select Users & Groups > Groups.

2. In the Groups pane, highlight the group that you want to give permission to access a quick message.
3. Click the Quick Messages tab.
4. Click the Add icon.
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5. In the Select Template dialog box, highlight the quick messages that you want to assign to the group.

Select Template X

Cuick Message -
| g

No
3

[ok ] concel [[ Hap

6. Click OK to assign the quick message to the group.

To remove a quick message from the list of quick messages assigned to a group, highlight the quick
message and click the Delete icon.

Confirm that you want to delete access.

Group Profiles

You can create group profiles for groups that share the same set of fields and permissions. Users that are
assigned a group profile become members of all groups belonging to the group profile.

Creating Group Profiles

From the Users & Groups module, you can create a group profile for groups that have the same fields and
permissions.

1. From the VMP Administrator, select Users & Groups > Group Profiles.
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2. Select New.

3. Name the profile, and click OK.

MNew Profile >

Name:
|NI Applications| |

[ok ] camcel || e |

4. With the profile selected under Group profiles, click New.

Select the groups to include with the profile.
5. Click OK to close the dialog box.

Assigning Group Profiles

From the Users & Groups module, you can assign a group profile to a user. This makes the user a member
of all groups in the group profile.

1. From the VMP Administrator, select Users & Groups > Users.
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2. Click to highlight a user.
3. From the Member of tab, select Set Profile.

4. Use the dropdown list to select the profile, and click OK to close the dialog.

Set Profile it
Profile:

| A1 Applications |
T

5. Click OK to confirm the assigned groups.

VMP X

Users will be assigned only te groups:

Disaster Recovery Team
IT

Management

Security

[ ok ] canca

Contacts

The Contacts module enables you to import contact information for people and places that are not VMP
users, such as local businesses.

Note: Some of the features found in the Users & Groups module are covered in About Importing
and Synchronizing on page 49, which describes how to import contacts from a source, including
from a Vocera Voice Server global address book.
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Manually Adding a New Contact
You can use the VMP Administrator to add a new contact manually.
You must already have at least one contact source available in the Contact Sources view.

1. Select the Contacts module, and select Contact Sources.

2. Click to highlight the contact source that is to contain the new contact.
3. Select New and choose New Contact.

Mew Contact

4. Enter the contact details in the New Contact dialog, and click OK.

To filter the list of contact sources, click Filter and select the filter criteria to use.

The Filter icon changes color.

Name & Total

To reset filtering, right-click Filter.

Creating a Contacts Distribution List

Contacts Distribution Lists enable you to organize your contacts for quicker access. You can create a
Contacts Distribution List from the Contacts module.
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1. Select the Contacts module, and select Distribution Lists.

2. Select New &2 from the Distribution List - Contacts view.

In the Distribution List name field, enter the name of the new Contacts Distribution List.

4. If sites have been defined, use the Site dropdown list to select the site for this Contacts Distribution
List.

====| Note: Sites are available if they have been created on the Vocera Voice Server with which
=) the VMP Server has been integrated. See on page 31 for more
information on integrating with the Vocera Voice Server.
5. Select the Hidden checkbox if the Contacts Distribution List is to remain hidden. The contacts that are
members of this list remain accessible.

6. In the Distribution List Fields pane, select the fields to display on the client.

w

Mew Distribution List - Contacts x

Name and Fields

The WMP Administrator should ensure the Distribution List Name reflects its content in order that the intended users of the
Distribution List find it an intuitive tool. The Fields that are enabled to be selected at this stage of the creation of the Distribution List
will determine which Contact fields VMP users will see displayed on their device.

Name and Fields Distribution List name
Searches [ |
Group Assignment [ Hidden

Site:
| v]
DRl
3

BlackBemy PIN &
Email
Photo
Image 1
Image 2

|
O
|
]
[ image 3
O
|
O

Image 4
Title
Web Page v

< Back Mext > Cancel Help

0 Tip: Click Select All = to add all available fields.

7. Click Next.
8. Select the Contact Source in Searches.
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| Name New search

Contact Source:

Active Directory
Search Title

‘Search Active Directary

Type

® Use all contacts

() Explicit Selection

() Active Directory Ol's
() Fitter

9. Select from the following options:

Table 13: Contact source options

Option Description

Use all contacts Automatically add all source contacts to the list.

Explicit Selection Manually choose the source contacts for the list.

Active Directory OU's If the source is imported from Active Directory, you can choose to add Organization
Units.

Filter Filter for contact to add based on contact fields.

Tip: Filter for contacts with crucial fields (mobile phone, email address, etc.) to ensure you are
adding only contacts with these fields populated.

10.Click Next to display the Group Assignment pane.
11.Choose the users and groups who have access to the Distribution List and click Finish.

You can control which users and groups can view a Contacts Distribution List.

1. Select the Contacts module, and select Distribution Lists.
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2. Select a list and click Manage Access.

The Distribution List Access dialog box appears.

Distribution List Access

Users  Groups

oe Total: 8 | ®
|

| Name ~ Deviee ID Email Public ID ~
clu@dtill local

x

evoste | porasesei

Idavis@dtill local

. The Distribution List Access dialog box allows you to perform the following tasks:

Table 14: Distribution List access task options

Add User Click the Users tab, and click Add to select users who can access the list.

Add Group
Delete User

Click the Groups tab, and click Add to select groups who can access the list.

Click the Users tab, select the user, and click Remove to revoke access to the list.
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Delete Group Click the Groups tab, select the group, and click Remove to revoke access to the
list.

4. Click Close to save the access changes.

To filter the list of Contact Distribution Lists, click Filter and enter the filtering criteria to use.

The Filter icon changes color.

oOrMela Totat: 3 [

Name a Total

To reset filtering, right-click Filter.

Messaging

The Messaging module in the VMP Administrator enables you to configure the messaging environment in
the VMP Web Console and the Vocera Collaboration Suite app.

In the Messaging module, you can:

* Create Message Templates that enable users to quickly create and send commonly used or urgent
messages.

* Create Distribution Lists that enable users to send a message to multiple users simultaneously.

About Messaging Templates

Messaging Templates enable users to quickly create frequently sent or important messages. For example,
you can create a Code Blue template to ensure that emergency notifications are sent out immediately.

When you create a Messaging Template, you can specify:

* Which users or groups are to be given permission to access the template.
* The default list of recipients for any message sent using this template.

The list of recipients can contain users, Distribution Lists, or both.
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Creating Messaging Templates

If your organization has a message that you send frequently, you can create a messaging template to
help users create messages more quickly, which can be useful in emergency situations. You can create a
template by copying from an existing template.

When you create a messaging template, you can specify the list of users, the message subject, text, and

priority, an optional conversation expiration time, and one or more optional or mandatory fields. You can
also supply a list of multiple choice responses for recipients to choose from.

1. Open the VMP Administrator and select Messaging > Messaging Templates.

o

2. Click New.

The Copy From pane appears.

Mew Messaging Template x

Copy From
You can create Template based on existing template

[ Copy from

Template Access

[ Mets | Comod || Heb |

3. Do one of the following:
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» If you are copying from an existing template, select the Copy from checkbox. A list of existing
templates appears.

New Messaging Template x
Copy From
You can create Template based on exsting template

Copy From [ Copy from

To

"E_m“e Subject Body

Tu evdm ;e » Emengency! Code Biug! |
i isat 11:00 on Thursday... |

Click on the template that you want to copy from. Click Next to continue.

» If you are not copying from an existing template, leave the Copy from checkbox unselected. Click
Next to continue.

4. Click to highlight each user or Distribution List that will receive a message when the template is used.
Click > to add users and Distribution Lists to the list of recipients, or click < to remove them.

When you have finished adding users and Distribution Lists, click Next.

. Note: The list of recipients can include only one Escalation Distribution List.

5. In the Message panel, supply the fields listed below. If you are copying from an existing template, some
or all of these fields might already be provided.
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Message

Copy From

To

Message
Cptions
Template Access

New Messaging Template X

Enterthe Subject, Message and Message fields for the Messaging Template.

Subject
Code Blue

Message:

Emergency! Code Blue!

Message Fields:

oot
Label Required
Room Yes

< Back Next > Cancel Help

a. In the Subject field, type the subject of the messages to be generated from this template. This field
can be up to 512 characters in length, and must be provided.

b. In the Message field, type the default text for messages sent from the template.

6. In the Message Fields section of the Message panel, you can define one or more fields that are to be

included with each message generated from this template. For each field that you define, you can

specify whether the field is required.

e "B 4
) B @ | - |
[ Label Required
Addiional Infomion

Click Add to add a field.

Add Field X

Label:

] Required

Cancel Help

In Label, type the name of the field.

Select the Required checkbox if users must
supply this field.

Click OK to add the field.

Click Edit to edit a field that you have created.
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Click Delete to delete a field that you have
created.

To rearrange the fields, click a field to highlight it.
Click Move Up to move the field up in the list.

Click Move Down to move the field down. Repeat
Move Up and Move Down until the fields are in
the order that you want.

7. In the Options screen, enter the following template details, and click Next:

145

New Messaging Template

Options

Priarity:
Coy From Nomal “
To
Message Conversation expiration
Options Never o
T EhEeas [] Deliverto on campus users only

[] Muttiple Choice Responses

Select the Priority, Conversation expiration and Response expiration for the Messaging Template. You can also enable options for delivery to
campus user only, add muttiple choice responses and receive notifications f nobody responds to the message.

< Back Next >

X

Cancel Help

Table 15: Messaging Template options
Option

Priority

Conversation expiration

Description

The message priority can be:
¢ Urgent

* High

* Normal

The time in minutes before the message conversation
expires. This can be one of the following:

* Never (the default)

* 2min

* 5min

* 10 min

¢ Custom

If you select Custom, a field appears in which you can specify the
number of minutes.

====| Note: Once a message conversation has

= eoxpired, the message will no longer be delivered
to VCS and VMP Web Console users that have
not yet received it and will not be retrieved the
next time they log in.
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Description

Select this checkbox if messages are to be sent only to
recipients who are present.

Select this checkbox if you want to define multiple
choice responses for this template.

8. If you have selected Multiple Choice Responses, additional fields appear:

New Messaging Template

Options

campus user only, add multiple choice responses and receive notifications if nobody responds to the message

Priority:
Sy Normal ~
To
Tee=m Conversation expiration
Options Never ~

Responses
Template Access

[] Deliver to on campus users only
Multiple Choice Responses

[] Matify if no one has responded within
Response expiration:

minutes

Never ~

< Back Next >

Select the Priority, Conversation expiration and Response expiration for the Messaging Template. You can also enable options for delivery to

Cancel Help

X

Table 16: Additional Messaging Template options
Option

Notify if no one has responded

Response expiration

Description

Select this checkbox if a notification is to be sent if no
one has responded within the number of minutes that
you specify.

The amount of time in which a response is expected.
Select one of the following:

* Never

* 2 min

* 5min

e 10 min

¢ Custom - Enter the amount of time, in minutes,
before the message expires.

9. If you selected Multiple Choice Responses, click Next to provide the response options.
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Mew Messaging Template

Responses

4

3 | Thizs mes=age was sert to me by mistake.
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1) Click Add to add a response. Type the text of the

N~ response in the dialog box provided, and click OK.

oY Click Edit to edit a response that you have

= created.

oy Click Delete to delete a response that you have

= created.

‘a4 To rearrange the responses, click a response to

e highlight it. Click Move Up to move the response
up in the list.

5 Click Move Down to move the response down.

g Repeat Move Up and Move Down until the
responses are in the order that you want.

Click Next when you have finished creating message options.
10.Click to highlight each user or group that can use the template, and click >.

When you have finished adding groups, click Finish.

Editing a Messaging Template
You can edit any Messaging Template that you have created.

1. In the VMP Administrator, select Messaging > Messaging Templates.
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2. Highlight the Messaging Template that you want to edit and click Edit.

3. Click > to add users and Distribution Lists to the list of recipients, or click < to remove them.

When you have finished adding users and Distribution Lists, click Next.

. Note: The list of recipients can include only one Escalation Distribution List.

4. Edit the messaging options as needed, and click Next when finished.
. Note: For more information on these options, see Creating Messaging Templates on page 142.
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5. If you selected Multiple Choice Responses, you can update the response options.

New Messaging Template

5

3 | This message was sert to me by mistake .

1 Click Add to add a response. Type the text of the
response in the dialog box provided, and click OK.

D) Click Edit to edit a response that you have
created.

3 Click Delete to delete a response that you have
created.

4 To rearrange the responses, click a response to

highlight it. Click Move Up to move the response
up in the list.

5 Click Move Down to move the response down.
Repeat Move Up and Move Down until the
responses are in the order that you want.

Click Next when you have finished updating message options.

6. To update the list of users or groups that can access the Messaging Template:
a. To add a user or group, highlight it in the left pane of the Template Access dialog and click >.
b. To remove a user or group, highlight it in the right pane and click <.

7. Click Finish when you have finished editing the Messaging Template.

If you no longer need a Messaging Template, you can delete it.

1. In the VMP Administrator, select Messaging > Messaging Templates.
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2. Highlight the Messaging Template that you want to delete and click Delete.

3. In the confirmation dialog box that appears, click Yes to confirm that you want to delete the Messaging
Template.
Changing Messaging Template Permissions

For any Messaging Template, you can specify the users that are allowed to update, delete, or manage
access to the template.

1. In the VMP Administrator, select Messaging > Messaging Templates.

O

Messaging

2. Highlight the Messaging Template that you want to change permissions for, and click Manage access.
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3. In the Messaging Template Permissions dialog box:

/.D Click the Users tab to change permissions
~ for users, or click the Groups tab to change
permissions for groups.

(@ Click Add to add a user or group to the list of
N users or groups with permissions. In the New
Permission dialog box, highlight a user or group
and click one or more permission checkboxes:

* Allow update: Members with this permission
can add users to the list of message recipients,
and can edit the message body, subject, and
other Messaging Template properties.

* Allow delete: Members with this permission
can remove this template.

* Manage access: Members with this
permission can add or delete groups in the
Messaging Template access list.

Click OK when done.

The default administrator has Manage access
permission on every Messaging Template.

(3> Click Edit to edit the permissions of a user or
N~ group.

(4) Click Delete to delete from the list of users or
~ groups with permissions.

4. Click Close to close the Messaging Template Permissions dialog box.
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In VMP, a Distribution List (DL) is a list of users. You can send a message to an entire DL, use a DL to set

up an on-call roster, or create an Escalation Distribution List to ensure that your message is escalated if it
is not seen by its initial recipients.

When you create a DL, you specify whether it is to be a Regular Distribution List or an Escalation

Distribution List. An On-Call Distribution List, which you can use to create an on-call roster, is a special
type of Regular Distribution List.

To display a list of all defined DLs, open the VMP Administrator application and select Messaging >
Distribution Lists. The Distribution List - Users view appears.

m VMP (Default administrator) - [Distribution List - Users]
File  View Window Help

Users & Groups Distribution List - Users
Contacts . B (=) L @i
Messaging Name Type Site
| 3 [On-Call] Doctors On Shift Regular
1 Doctors Reqular
O Evenyone_Global Regular Global
Messaging
Templates

In this view, On-Call Distribution Lists have the prefix [On-Call], and Escalation Distribution Lists have
the prefix [Escalation]. All other DLs are Regular Distribution Lists.

VMP automatically creates the following DLs:

» If your VMP Server is integrated with a Vocera Voice Server, the Everyone_Global DL is a copy of the
Everyone group that is defined on your Vocera Voice Server. See

page 31 for more information on integrating with a Vocera Voice Server.
* If your VMP Server is integrated with Vocera Secure Texting, the VST Users DL lists all VST users. See
on page 35 for more information on integrating with VST.

on

====1 Note: VMP also enables you to define Contacts Distribution Lists, which are lists of contacts. See
on page 137 for more details.

You can use the VMP Administrator to create a regular Distribution List (DL). You can specify that this
regular DL is to be an On-Call Distribution List.

A regular DL is any DL other than an Escalation Distribution List, which is a special case that is created
separately.

1. Open the VMP Administrator application and select Messaging > Distribution Lists.
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Distribution Lists

2. Click New and select New Regular Distribution List.

Mew Regular Distribution List

New Escalation Distribution List

3. In the Distribution List Name field, enter the name of the new DL.
4, In the Distribution List ID field, enter the ID of the new DL.

====1| Note: When a message is initiated by an external system such as email or WCTF, VMP uses this
ID to determine the DL to which the message is to be sent.

5. If this Distribution List is to be associated with a site, select the site from the Site dropdown list.
====| Note: Sites are available if they have been created on the Vocera Voice Server with which
== the VMP Server has been integrated. See on page 31 for more
information on integrating with the Vocera Voice Server.
6. Select Enable for Texting if you want this DL to be available to Messaging users.
7. If Enable for Texting is selected, you can select On-Call Distribution List to ensure that DL
members receive messages only if their status is On-Call or Monitor. In the Minimum Users On-Call
field, select or type the minimum number of users that can be On-Call at any one time.

====| Note: If a user is having messages forwarded, the user can still be On-Call.

8. In the Notify On-Call status changes section, select On-Call to send a notification to a user when
the user's status changes to On-Call. Select Not On-Call to send a notification when the user's status
changes to Not On-Call.

9. Select Hidden if this DL is to remain hidden. Users can send messages to members of a hidden DL, but
cannot send a message to the DL itself.

10.Select how users can be added to the DL. You can select either Add Users Manually or Create DL
based on Active Directory structure.

11 Click Next.

12If you have selected Add Users Manually:

a. Type in the Search field to display only users whose names contain the search string. Click Clear to
clear the search string.

b. Select All Users to display all users, or select VST Users to display Vocera Secure Texting users only.
You can do this for either the list of users that have not yet been added to the DL or the list of users
that have been added.
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Note: For more information on importing Vocera Secure Texting users into VMP, see

c. Click to highlight a user, and then click > to move the user to the Distribution List. You can click to
highlight one or many users. To move all users to the Distribution List, click >>.

New Distribution List - Users

Users

Name and Type Sech [ [Cex

Users

Al Users VST Users
DL Access ® o
alvin Lu

-y Carol Wilson

, Default administrator
14 Grace Morgan

', Jen MeMaster

1, Josh MeNab

*, Linda Davis

|, Sharya Bhagat

Select the Users who will be @ member of Distribution List (DL). Move the appropriate Users to the right side of the screen by
double-clicking. or highlighting and pressing retum, or highlighting and pressing Add button. To search specific users, type the first few
letters of the first name or the last name in the Search field. Define wheather or not the Users can edit their own On-Call Status, and
whether thay can edit the On-Call status of all Users in DL. Finally, corfigure the cument On-Call Status of each User.

® AllUsers ) VST Users

X

< Back Next > Cancel Help

d. If the DL is an On-Call DL:
» Select Edit Personal On-Call Status to let users edit their own on-call status.
» Select Edit On-Call Status For All to let users manage the on-call status for all members of the

DI.

e In the Current On-Call Status dropdown list, specify the on-call status for each user. Select Not
On-Call, Monitor, or On-Call.

Edit Edit
Personal  On-Call Cumert N
OnCal  Status  OnCall Status ' o°
Status  for All

KA EEEEE

Oooroogo

Mot On-Call |y Calvin Lu

OnLall 1 Carnlwilson

- Grace Margan

Mot OnCall ~ | ' Jen Mchaster
Mot OnCall ~ | 1y Josh McMab
Not OnCall ~ | ' Linda Davis
Mot OnCall ~ | - Sharya Bhagat

e. Click Next.

13If you are creating the DL from an existing Active Directory structure, select the users and groups from
the tabbed lists, and click Next.
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Mew Distribution List - Users x

Structure

Define the structure for the VMP Distribution List by selecting the appropriste OU's, Securty Groups and
Distribution Groups

Name and Type
Struciure [ Uses

DL Access i k[] Domain Users
[ Domain Users

< Back Next > Cancel Help

14.The DL Access window appears, which lets you select the users and groups who will have permission
to send messages to this DL.

Mew Distribution List - Users X

DL Access

Select the Users and Groups who wil have pemission to send Alerts to the Distribution List (DL). Move the appropriate Users and
Groups to the right side of the screen by double-clicking, or highlighting and pressing retum, or highlighting and clicking the Add button.
To search for specific Users or Groups, type the first few letters of the Group name, first name, or last name in the Search field. Define
whether or not the Users and Groups can edit the On-Call Status of all Users in DL

Name and Type Search: [ Clear

Ysers Name Ste > [ ew
DL Access . on<all
| G e e
. » Engage Group < for All
{» Everyone_Global i<
s IT (o ol
4s Management

Global
Global

' Securily
- Calvin Lu Global
- CarolWikson Global
., Diefault administiator
- Grace Morgan Global
- Linda Davis Global
' Sharya Bhagat Global

< Back Finish Cancel Help

Type in the Search field to display only users whose names contain the search string. Click Clear to
clear the search string.
15.Click to highlight a user, and then click > to give the user permission to send a message to this
Distribution List. You can click to highlight one or many users. To give all users permission to send
messages, click >>.
16 If the new list is an On-Call Distribution List, select the Edit On-Call Status for All checkbox next to
each user who is to be given permission to edit anyone's on-call status.
====| Note: If a user is both a member of a DL and has permission to send a message to the DL, you
can select the Edit On-Call Status for All checkbox in either this screen or the Users screen.
Selecting either checkbox enables the ability to edit anyone's on-call status.
17.Click Finish to create the DL.

Use Escalation Distribution Lists to improve message response times by forwarding the message through a
defined escalation workflow.
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For each list, one or more branches of groups or users are defined. When a message is sent to the list,
it is sent to the first branch. If no one in the first branch responds in the specified time, the message is
escalated to the next branch. It is then escalated to additional branches if necessary.

1. Open the VMP Administrator application and select Messaging > Distribution Lists.

Distribution Lists

2. Click New and select New Escalation Distribution List.

m @ & &
Mew Regular Distribution List Type
| Mew Escalation Distribution List | Regular
Doctors Regular
E Glnhal Benlar

3. In the Distribution List Name field, enter the name of the new DL.

4. In the Distribution List ID field, enter the ID of the new DL.
====1| Note: When a message is initiated by an external system such as email or WCTF, VMP uses this
== ID to determine the DL to which the message is to be sent.

5. Use the Delivery Route dropdown list to select from one of the following options:

Table 17: Delivery route options

Option Description

Deliver to all users Deliver to all DL. members.

Deliver only to users who are Messages sent to the DL are delivered only to active members who are
present on the Wi-Fi network. currently logged onto the Vocera Voice Server and are not in DND mode.

m===| Note: If a user is present on the Wi-Fi network, but is forwarding
== 1 essages to a user who is not present, the message is not delivered.

6. Next, create the branches for the Escalation Distribution List:
a. Click New to add a New Branch to the Escalation Distribution List.
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Each branch contains one set of users to be contacted. If the response criteria are not met, the
Escalation Distribution List escalates to the next branch.

b. In the New Branch dialog box, type in the Search field to display only users whose names contain
the search string. Click Clear to clear the search string.

MNew Branch X

;s
sewcn I [Gear] Sewch [ ]G

® Al () Users (O Distribution Lists @ Al O Uses () Distribution Lists

Mame Site @

L B8 [On-Call] On-Call Doctars
Everpone_Global Global

L Calvin Lu Global
& Carol wilson Global
& Grace Morgan Global
a Jen McMaster Global
1 Josh McNab Global
& Linda Davis Global
1 Sharya Bhagat Global ~

| Name Site

Advance to the next branch if the following criteria is not true within the timeout specified
Crteria: | Al least one user(s) delivered v

Timeout after Minutes Seconds

[0 [ cacd || b |

c. Filter the selection criteria using one of the following options:
« All
* Users
* Distribution Lists

. Note: If a search string has been specified, only users whose names contain the search string
are listed.

d. Click to highlight a user, and then click > to move the user to the new branch of the Escalation
Distribution List. You can click to highlight one or many users. To move all users to the new branch,
click >>.

e. Use the Criteria dropdown list to specify the response criteria. If these criteria are not met, the
message is escalated. The available response criteria are:
* At least one user(s) delivered
* At least one user(s) opened
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* At least one user(s) responded
* All users delivered
e All users opened
* All users responded
f. Set the timeout value and click OK to continue. The timeout value must be 5 seconds or greater.
====| Note: When a message is sent to an Escalation Distribution List, and all members of a branch

of the list are off campus, the message is immediately escalated to the next branch of the list
without waiting for the timeout period to elapse.

g. Repeat these steps as necessary to create additional branches.
7. Click Next. The Group Assignment window appears, which lets specific users and groups access the DL.
8. Click the Users tab to add a user to the access list, or click Groups to add a group:

a. Click Add to display a list of users or groups.

New Escalation Distribution List x

Group Assignment
Once the content of the Distribution List is defined, the Group Assignment enables specific Groups and Users to be enabled to access the Distribution List

Name and Eranches Lo [Eomgs

Group Assignment [+] Totak 0 | ®

Name Device ID Email Public ID Pager ID

< Back Finish Cancel Help

The Select Users or Select Groups window appears.

Select Users O X

Totak 8 | ¥
Name Device ID Email

Calvin Lu clu@dtill local
Carol Wilson cwilson@dtill local

,
Grace Morgan gmorgan@dtill local
Jen McMaster jmemaster@dtil local
Josh McNab jmenab @dtill local
Linda Davis Idavis @dtill local
Sharya Bhagat sbhagat@dtill local

< >

Concel | [ b

b. Select one or more users or groups from the list.

c. Click OK to add the users or groups to the list.

d. Repeat the above steps to add additional users or groups.
9. Click Finish to create the DL.

You can edit any Distribution List or Escalation Distribution List that you have created.

1. Open the VMP Administrator application and select Messaging > Distribution Lists.
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2. Click the name of a Distribution List to select it.

Note: On-Call Distribution Lists are labeled with the prefix [On-Call]. Escalation Distribution
Lists are labeled with the prefix [Escalation].

3. Click Edit.

4. The instructions for editing a Distribution List are the same as those for creating a list:
o If you are editing a regular Distribution List, see Creating a Regular or On-Call Distribution List on
page 152.
e If you are editing an Escalation Distribution List, see Creating an Fscalation Distribution List on
page 155.

To filter the list of Distribution Lists, click Filter and enter the filtering criterion to use.

The Filter icon changes color. To reset filtering, right-click Filter.

Managing Access to a Distribution List
After you have created a Distribution List, you can specify users that can access the list.

1. Open the VMP Administrator application and select Messaging > Distribution Lists.
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2. Click the name of a Distribution List or Escalation Distribution List to select it.
3. Click Manage Access.

The Distribution List Access dialog box appears.
4. To add users or groups that can access the list, click Add.

In the dialog box that appears, click the Users or Groups tab, click the names of the users or groups to
add, and then click OK.

5. To remove access to the list, click the Users or Groups tab, click the names of the users or groups
whose access is to be removed, and then click Delete.
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When asked whether you want to remove these users or groups, click Yes.
6. When you have finished updating user access, click Close.

To filter the list of users in the Distribution List Access dialog box, click Filter and enter the filtering
criteria to use.

The Filter icon changes color. To reset filtering, right-click Filter.

Viewing the Members of a Distribution List
You can view a list of all members of any existing Distribution List.

1. Open the VMP Administrator application and select Messaging > Distribution Lists.

2. Click the name of a Distribution List or Escalation Distribution List to select it.
3. Click View Members.

A dialog box appears, containing a list of Distribution List members.
Additional fields are displayed with this list of members, depending on the type of DL:

* For Regular DLs created in VMP, this dialog box lists the Device ID, email address, and Public ID for
each user.

* For DLs imported from Vocera groups, the status for each user is displayed.
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* For Escalation DLs, the branch number is displayed.
4. Click OK to close the dialog box.

Deleting a Distribution List

If you no longer need a Distribution List, you can delete it.

1. Open the VMP Administrator application and select Messaging > Distribution Lists.

2. Click the name of a Distribution List or Escalation Distribution List to select it.
3. Click Delete.

4. In the dialog box that appears, click Yes to confirm that you want to delete the list.

About Quick Messages

A quick message is a pre-defined message text that a user can select and instantly add to a conversation.
This makes it easier for users to include a frequently used message response or an urgent message
response.

You can define quick messages, and you can specify what groups can use the quick messages that you
define.

| Note: See Specifying Group Permission for a Quick Message on page 133 for details on how to
J grant permission to a group to use a quick message.

Creating a Quick Message
You can create a quick message for use in message conversations.

| Note: After you have created a quick message, you must specify what groups have permission to
J use it. See Specifying Group Permission for a Quick Message on page 133 for details on how to
grant permission to a group to use a quick message.
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1. Open the VMP Administrator application and select Messaging > Quick Messages. The Quick
Messages pane appears.

2. Click New.

The New Quick Message dialog box appears.

MNew Quick Message X

Message:

o | Conce ([ Hep |

3. In the Message field, type the text of the new quick message.
4. Click OK to add the new quick message, or click Cancel to return to the Quick Messages pane without

adding a new message.
Editing a Quick Message
You can edit the text of a quick message that you have created.

1. Open the VMP Administrator application and select Messaging > Quick Messages. The Quick
Messages Pane appears.
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2. Click the quick message that you want to edit.
3. Click Edit.

The Edit Quick Message dialog box appears.

Edit Quick Message X

Message:

[ok ] Cacsl [ Heb |

4. In the Message field, edit the quick message text as needed.
5. Click OK to edit the quick message, or click Cancel to cancel editing.

Deleting a Quick Message

You can delete a quick message that you have created.

1. Open the VMP Administrator application and select Messaging > Quick Messages. The Quick
Messages Pane appears.
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3. In the confirmation dialog box that appears, click Yes to confirm that you want to delete the quick
message.

The quick message is deleted.

The Content module provides the tools to manage documents and image files that are stored on the VMP
Server and can be distributed and shared with licensed devices. It can deliver floor-plans, forms, and
other essential team documents.

Content is uploaded and managed by the administrator. When a file is uploaded to the VMP Server, the
title and upload date are posted to the main screen of the console. VMP supports the following file types:
e HTML file

* Image file (JPEG, GIF, BMP and PNG)

* PDF file

* Microsoft Word document

* Excel document

e Text

* Audio and video

If you plan to distribute Microsoft Word and Excel documents, you must have Microsoft Word and Excel

installed on your server so that it can properly format the documents for the device. For audio and video,
all content is streamed, and client devices can play all files that are supported by their media players.

The My Content view provides a list of the current documentation in the configured hierarchy.
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@ VMP (Default sdministrator) - [My Content]

[m]

X

Click here to view content

Reports |

Configuration |

[@ File View Window Help -8 x
Contacts OMe ‘ & "I
Messaging Tile = OnDevice  Updated Network path
Content » B [segemeitaooran |

=R e
My Content

Features of this view include:

* Content view window

* Activate or deactivate device presence
* Content update timestamp

* Network path information
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. Note: To refresh the list of available content displayed in the Content module, click Refresh.

Adding Content

You can use the VMP Administrator to add new content that can be made available to client devices.

1. Open the VMP Administrator application and select Content > My Content.

i

2. If you are adding content to an existing folder, or as a child of an existing content instance, click to

highlight the folder or instance.
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Click Open to open the New Content view.

a OnDevice  Updated  Network path
EEETE

Click here to view content

Click to highlight the document type and click Browse to select the new document.

New x

™ Common document Name:
Falder [ |
w1 Whord document Path:

%) Excel document | | Browse
21 HTML document

(Z] Plair test document

g PDF document

2 Image documert

= Images folder document
1] Streaming media

Options
@) Insert as a oot node

Cancel Help

====| Note: The Name field contains the document name, and it auto-populates based on the selected
document. If you enter a name in the Name field, it will persist.

. If the document resides on a network that requires credentials, use the Network login and Network

password fields to enter the credentials.

. Optionally, you can select Map network document. Mapping allows you to configure automatic

synchronization for document updates. If desired, select this option and configure a synchronization
interval.

Note: If your documents reside on a remote network, automatic synchronization will not work
unless the Vocera Data Exchange service is modified to use a local administrator account instead
of the default VMP Local System account.

If the document type you have selected is Word document or HTML document, the Document
style dropdown list appears. Select the document style to use.

If the document type you have selected is Word document, Excel document, or HTML document,
the Use first tables row as column names dropdown list appears. Select one of the following:

* Yes - Use the entries in the first row of the table as the column names.

¢ No - Do not use table row entries as column names.
* Use parent folder settings - Use the settings specified in the parent folder.

. In the Options section, select Insert as a root node to insert the new document into the My Content

folder, or select Insert as a child to selected node to insert the new document into the selected
folder.
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10.Click OK to close the dialog and upload the document to the server.

Updating Content

If necessary, you can update content that you have already uploaded to the VMP Server.

1. Open the VMP Administrator application and select Content > My Content.

@

My Content

2. Click to highlight the folder or document, and select Edit.

3. If the document is a Word document or an HTML document, from the Document style dropdown list,
select the document style to use.

4, If the document is a Word document, an Excel document, or an HTML document, from the Use first
tables row as column names dropdown list, select one of the following:

* Yes — Use the entries in the first row of the table as the column names.

* No - Do not use table row entries as column names.

* Use parent folder settings — Use the settings specified in the parent folder.
5. Click OK to save your changes.
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Assigning Document Permissions

Update Word document *

Name:

[Emergency Plar |
Path:

|C:\U5ers\Mmini5tmtor\Desldop\testdoc.doa|| Browse |
MNetwork login

| |
Metwork password:

| || Test |

Map network document

= r fy.
Synchronize automatically
Synchronize every (minutes):

B H

Document style:
o 3]

Use first tables row as column names:

= g
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You can use document permissions to specify the content that is to be made available to any client device
user.

Use the following steps to define document privileges.

1. Open the VMP Administrator application and select Content > My Content.

i

2. Click to highlight the folder or document, and select Manage Permissions.

3. Choose the Users or Groups tab, and select New.
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4. Click to highlight one or more entries.
5. Select one or more of the following permission options:
* Allow updates
* Allow delete
* Allow manage access
* Visible in device by default

New permission — O s

] Allow update

] Alow delste

] Allow manage access

7] Visble on device by defavit

[ ok | cance || Hep

6. Click OK.
To filter the list of entries, click Filter.

To reset filtering, right-click Filter.

Deleting Content
You can delete content that you have added.

1. Open the VMP Administrator application and select Content > My Content.
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@

2. Click to highlight the folder or document, and select Delete.
3. In the Delete Documents / Folders dialog, click Yes to confirm that you want to delete the content.

Reports

The Reports module gives Vocera administrators the ability to customize reports for organizational
requirements such as audits and quality of service. Administrators can generate a report at any time and

filter specific messaging details.

The following categories of reports are available:

* Log

* Messaging

e Transmit Status

About Logging Reports

In the Reports module, you can display the logging reports that can be generated.

To display the logging reports, select the Log icon.

@ VMP (Default administrater) - [Reports] - m} ®
7 File View Window Help .8 x
Users & Groups || Log
Contacts D BIS Push usage & Smartphone data wipe £ PiNandSMSlog
Messaging
Secuity |
] Feauylen P S5
Reports
.y
>
Log
Messaging
Configuration
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The following Log reports can be generated:

Table 18: Log reports

BIS Push usage This legacy report provides the number of BlackBerry Push API messages
sent by the server.

Smartphone data wipe This lets Administrators view whether a data wipe was successful when
sent to a device. This report is the only way to determine the status of a sent
device deletion.

PIN and SMS log This legacy report displays the BlackBerry PIN and SMS log by selected time
frame.
Security log Provides a record of Administrator actions. The report can record actions

such as include logging in and out, creating users, and the deletion of
contacts, Distribution Lists, groups, or other server entities.

SMS usage Shows the SMS usage of a device.

Creating a Smartphone Data Wipe Report
You can generate a report that indicates whether a data wipe was successful when sent to a device.

1. Open the VMP Administrator application and select Reports > Log.

2. In the Reports pane, click Smartphone data wipe. The Smartphone Data Wipe Report window opens.

== |
A Date Sent
[ From: |Jun D1 2018 D0:00:00
[ Te: |Jun 022018 00:00:00
Sott By
| User Name v
M
3 5 ‘E Generate ‘
| Current Page: none | Total Pages: 0 | Zoom Factor: 100% Il

3. In the Date section, in the From field, select the start date for which wipe data is to be displayed. The
default is midnight at the start of today's date.

4. In the To field, select the end date for wipe data. The default is midnight at the start of the next day's
date.
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5. From the Sort By dropdown list, select one of the following:
* User Name: sort by user name,
* Kill Pill Generated timestamp: sort by the date on which the smartphone wipe request was sent.

* Kill Pill Acknowledged timestamp: sort by the date on which the smartphone wipe request was
acknowledged.

6. Click Generate to generate the security log report.
Creating a Security Log Report

You can generate a report that produces a security log. This log lists when users were created, all attempts
to log in and log out, and all changes made in the VMP Server.

1. Open the VMP Administrator application and select Reports > Log.

Log

2. In the Reports pane, click Security log. The Security Log Report window opens.

[ From: Jun 072018 00:000

O To Jun 022018 00:000

M
< > | Generate:

| Current Page: none | Total Pages: 0 | Zoom Factor: 100% I

3. In the Date section, in the From field, select the start date for which log information is to be displayed.
The default is midnight at the start of today's date.

4. In the To field, select the end date for log information. The default is midnight at the start of the next
day's date.

5. In the Types section, select the checkboxes next to the log activities that are to be included in the
report. Click Select all to select all checkboxes, or click Deselect all to clear all checkboxes.
. From the Owner dropdown list, select one of the following:
» All: display security log information for all users,
* Selected: specify the users for which you want to display information.
* Unknown user: display security log information for unknown users only.

a. If you select Selected, a list of users appears. Select the users for which you want to display
security log information.

o]
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A Date
[ From:  Oct 032013 00:000

O Te: [Oct 04201900000 ~

Selectall Deselect all

Name.
[J D cfault administiaior

Jen MeMaster

<
| Current Page: none | Total Pages: 0 | Zoom Factor: 100%

7. Click Generate to generate the security log report.

NEEETVEYENE BN EEY I EEE

A Date
[ From:  Sep 202019 00:00:0 ~
OTo: Ot 04201900000 ~

Selectall Deselect all

Secu rlty Iog from 9/30/2019 12:00:00 AM

b o Do T e
19/30/2019 9:55:25 DTILL-VMP New user ed ‘Newuser"JoshMcNab® created.

‘Userslist synchronztion.

9/30/2012 10:01:11 New userJen McMaster” created.
a1 DTILL-VMP Newuser created Users st synchrontets

9/30/2019 10:02:09 Newuser"Carol Wilson"ereated.

A priLLvR e Userslistsynchronzztion. |

9/30/2019 10:02:28 . Nevuser'Linda Davis” created.
DTLLVMP Newusercreated Uners ot ymebrnte
9/30/2019 10:03:10 P Nevruser"Calvin Lu" created. Users
i DTILLVMP Newusercreted i
9/30/2012 10:03:29 . New user“Graca Morgan® created.
OTLLVMP Newuser reated Uaers it synchronins
9/30/2019 10:03:48 Newuser " created.
Y BT Users list synchronization. v
- ol | Generate:
| current Page 1 | Total Pages: 7 Zoom Factor: 100% |

Creating an SMS Usage Report

You can generate a report that shows the SMS usage for each device.

1. Open the VMP Administrator application and select Reports > Log.

2. In the Reports pane, click SMS usage. The SMS Usage Report window opens.
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[ From: [May 012018 10:0820 O+
HTo:  [dn 012018100820 G+ |

Display: | Recipiert totals -
SMS phone

< >
| Current Page: none | Total Pages: 0 | Zoom Factor: 100% I

3. In the Date section, in the From field, select the start date for which log information is to be displayed.
The default is midnight at the start of today's date.

4. In the To field, select the end date for log information. The default is midnight at the start of the next
day's date.

5. From the Display dropdown list, select either Recipient totals or Total only.

6. From the SMS phone dropdown list, select either All or Specified. If you select Specified, select the
SMS phones whose information you want to display.

7. Click Generate to generate the SMS usage report.

About Messaging Reports

In the Reports module, you can display reports that list the messaging history, statuses, and statistics for
the VMP Server.

To display these reports, select the Messaging icon.

& VMP (Default sdministrator) - [Reports] - o X
T File View Window Help -8 x
Users & Groups || Messaging
Contacts Chat - Legacy _ )
i Integration Message Activity Hlett Status — Detailed - Legacy

Messaging

e | @ sty Py (vt
Reports
Text Messages Statistics Text Messages Status ~ Detailed Text Notfications

Configuration |

The following Messaging reports can be generated:

Table 19: Messaging reports

Chat - Legacy For clients that have used the legacy Chat capability that was provided in
previous versions of VMP, this displays a timestamp of each Chat message
and provides the sender name, participants, images, and message details.

Integration Message Activity This report is not currently in use.
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Alert Status - Detailed - Legacy For clients that have used the legacy Alert capability that was provided in
previous versions of VMP, this displays specific details for Alerts sent to any
device.

Alert Statistics - Legacy For clients that have used the legacy Alert capability that was provided in

previous versions of VMP, this displays information on all Alerts sent in a
specified time period.

Alert Status - Legacy For clients that have used the legacy Alert capability that was provided
in previous versions of VMP, this displays the Alert statuses for any user.
Select the user from the user filter that appears when the report screen is

displayed.
Conversations Displays the conversations or text messages for any user.
Text Messages Statistics Displays information on all text messages sent in a specific time period.
Text Messages Status - Detailed Displays specific details for text messages sent to any device.
Text Notifications Displays the text notifications for any user. Select the user from the user

filter that appears when the report screen is displayed.

The reports that are not legacy reports from previous versions of VMP are described in more detail below.

Creating a Conversations Report

You can generate a report that displays the conversations or text messages for any user or group of users.

1. Open the VMP Administrator application and select Reports > Messaging.

)

In the Reports pane, click Conversations. The Conversations Report window opens.
B e

~  Man  Patcpants
Datatype

Curent (after 5/18/2018) ~
Date
O From: | Jun 012018 00:00:00

O o Jun 022018 00:00:00

Message cortains

Paticpart}s)
[Includs C: all of the selected |

Dispiay:

[Growp by converal v]
Show Multiple Choice Responses:

|Group by question and responses ~|
[ include Chat images

[ Show patient context information

<
| Current Page: none | Total Pages: 0 Zoom Factor: 100% Il

3. Click the Participants tab.
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4. From the dropdown list that appears, select All to show all conversations, or select Filtered by User /
Distribution List to specify the users whose conversations are to be displayed.
a. If you have selected Filtered by User / Distribution List, a list of users is displayed. Select the
users whose conversations are to appear in the report.

o Conversations Report

The document does not conlain any pages.

<
[ Cunent Page: none Total Pages: 0 Zoom Factor: 100%

5. Click the Main tab.

6. In the Date section, in the From field, select the start date for which conversations are to be displayed.
The default is midnight at the start of today's date.

7. In the To field, select the end date for conversations. The default is midnight at the start of the next
day's date.

8. In the Message contains field, optionally type search criteria. If you specify any search criteria, only
conversations that contain the search text are displayed.

9. From the Participant(s) dropdown list, select one of the following:
* Include Conversations with all of the selected participants
* Include Conversations with at least one selected participant
These are the participants that you selected in the Participants tab.

10 From the Display dropdown list, select how the displayed conversations are to be organized. Select
either Group by conversation or Sort by timestamp.

11 From the Show Multiple Choice Responses dropdown list, select how multiple choice responses are
to be displayed. Select either Group by question and responses or As part of conversation.

12 Select the Include Chat images checkbox to include images sent in a conversation as part of the
conversation report.

13.Select the Show patient context information checkbox to include the patient context of the
conversation if it exists.

14 Click Generate to generate the conversations report.

[E=8 Hem =]
| & (o0 (] & | P 4@ la |
~  Main Participants
Datatype
Corert (dter 8/19/2019) v
Conversations - Group by conversation Dete
From: [Sep 292019000000 [~
Report Criteria 7o [oct 042013 000000
Message cortais
Participart(s):
Include Conversations wh al o e selected
Report Display:
Grace Morgan, Jen McMaster Group by conversation v
107312016 5:44:43 AM Jen McMaster The staff meetingis 2 pm today. e
. .
o) Generat
Current Page: 1 Total Pages: 1 Zoom Factor: 100%

177 VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



Creating a Text Messages Statistics Report

THE VMP ADMINISTRATOR

You can generate a report that provides details on the conversations or text messages for any user or

group of users.

1. Open the VMP Administrator application and select Reports > Messaging.

2. In the Reports pane, click Text Messages Statistics. The Text Messages Statistics Report window

opens.

| Cument after 5/18/2018)

Preiod

[ From: Jun 012018 00:0000

O Te: Jun 02201800:0000

Senders sorting order

| Bytet message sent ~

e i ‘E Generste ‘

| Current Page: none | Total Pages: 0 | Zoom Factor: 100% I

3. In the Period section, in the From field, select the start date for which conversations are to be

displayed. The default is midnight at the start of today's date.

4. In the To field, select the end date for conversations. The default is midnight at the start of the next

day's date.

5. From the Senders sorting order dropdown list, select how the displayed conversations are to be

organized. Select either By text message sent or By name.
6. Click Generate to generate the text messages statistics report.
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B GOy | 0 & R w1 & | |6 B[l -
A Datatyps
i | Curent (efter 5/18/2018) -
Preiod
[ From: |Jun 012012 00:00:00 B
O Jun 02 2018 00:00:00 =]
Senders sorting arder
| By tent message sent ~|
Recipients
Forwarded Recipients |1
Messages for Delivery |6
e e R
=
< P e 5 ! ‘ﬁ Generate |
| Current Page: 1 | Total Pages: 1 | Zoom Factor: 100% I

Creating a Detailed Text Messages Status Report

You can generate a report that provides detailed data on the text messages and status reports sent and
received by the VMP Server. In this report, you can specify the message sources, senders, recipients,
priority, and subject or message content.

1. Open the VMP Administrator application and select Reports > Messaging.

2. In the Reports pane, click Text Messages Status - Detailed. The Text Messages Status - Detailed
Report window opens.

=]
A~  Message Senders Recipients
Datatype "
| Curent afier 518/2018) v
Date Sent
O From: | Jun 012078 00:00:00 @
O T [dn 02208 000000 E]

e
Insert summany row for each Text Message
Search and report on User's final delivery status ¢

[ Show patient context information

Initizted from

]

[] Initizted by email
|1 Vocera Secure Texting e

v
< ol Ees \

| current Page: none | Total Pages: 0 Zoom Factor: 100% Il

3. Click the Message tab.

4. In the Date Sent section, in the From field, select the start date for which conversations are to be
displayed. The default is midnight at the start of today's date.

5. In the To field, select the end date for conversations. The default is midnight at the start of the next
day's date.
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. From the Type dropdown list, select the information to display in the report. Select either Text

Messages Only or Text Messages and Statuses.

. If you have selected Text Messages and Statuses:

a. Select the Insert summary row for each Text Message checkbox if you want the report to
contain summary rows.

b. If needed, select the Search and report on User's final delivery status only check box.
Select the Show patient context information checkbox to include the patient context if it exists.

. In the Initiated from section, clear the checkboxes next to the message sources that you do not want

to display in the report.

10In the Subject contains field, optionally type search criteria. If you specify any search criteria, only

conversations whose subject contains the search text are displayed.

11In the Message contains field, optionally type search criteria. If you specify any search criteria, only

conversations whose message body contains the search text are displayed.

12In the Priority section, clear the checkboxes of the message priorities that you do not want to see in

the report.

13If you have selected Text Messages and Statuses from the Type dropdown list, the Status area

appears, which displays the message statuses that you can include in the report. Clear the checkboxes
of the message statuses that you do not want to see in the report.

14 Click the Senders tab.
15From the dropdown list that appears, select All to show all senders, or select Specified to specify the

senders whose conversations are to be displayed.

a. If you have selected Specified, a list of senders is displayed. Select the senders that are to appear in
the report.

Text Messages Status - Detailed Report

The document does not contain any pages.

[ Current Page: none Total Pages: 0 Zoom Factor: 100%

16.Click the Recipients tab.
17 From the dropdown list that appears, select All to show all recipients, or select Filtered by User /
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Distribution List to specify the recipients whose conversations are to be displayed.

a. If you have selected Filtered by User / Distribution List, a list of recipients is displayed. Select the
recipients whose conversations are to appear in the report.
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< 5) ‘: Genersie ‘
| Cumrent Page: none | Total Pages: 0 | Zoom Factor: 100% /|

18.Click Generate to generate the detailed text messages status report.

Creating a Text Notifications Report
You can generate a report that displays the text notifications sent and received in the VMP Server.

1. Open the VMP Administrator application and select Reports > Messaging.

2. In the Reports pane, click Text Notifications. The Text Notifications Report window opens.

EEs—]

A Man  Senders Recpients
Datatype
| Currert (after 5/18/2018) ~|

Date
1 From: |+ 012012 00:00:00 B
O e Jun 02 2018 00:00:00 [FLd

Message contains:

|
Recipient(s)
| Include Nottications with allof the selected re |
Initiated from

[ WEB Console

e 5 |= Generate ‘
| Current Page: none | Total Pages: 0 Zoom Factor: 100% Il

3. Click the Senders tab.
4. From the dropdown list that appears, select All to show all notifications, or select Specified to specify
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the senders whose notifications are to be displayed.

a. If you have selected Specified, a list of senders is displayed. Select the senders whose notifications
are to appear in the report.
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Jen McMaster

Josh McNab

Linda Davis

Paging gateway user
Fartner Aleits

<
| Current Page: none | Total Pages: 0 Zoom Factor: 100% ]

5. Click the Recipients tab.
6. From the dropdown list that appears, select All to show all notifications, or select Filtered by User /
Distribution List to specify the recipients whose notifications are to be displayed.

a. If you have selected Filtered by User / Distribution List, a list of recipients is displayed. Select the
recipients whose notifications are to appear in the report.

. ol s |
| Current Page: none Total Pages: 0 Zoom Factor: 100% ]

7. Click the Main tab.

8. In the Date section, in the From field, select the start date for which notifications are to be displayed.
The default is midnight at the start of today's date.

9. In the To field, select the end date for notifications. The default is midnight at the start of the next
day's date.

10In the Message contains field, optionally type search criteria. If you specify any search criteria, only
notifications containing the search text are displayed.

11 From the Recipient(s) dropdown list, select one of the following:
* Include Notifications with all of the selected recipients
* Include Notifications with at least one selected recipient
These are the recipients that you selected in the Recipients tab.

12In the Initiated from section, clear the checkboxes next to the message sources that you do not want
to display in the report.

13.Select the Show only notifications with multiple choice responses checkbox to display only
notifications for which a multiple choice response was requested.

14 Click Generate to generate the text notifications report.
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o=/ Text Notifications Report

fo )@ s

A Main  Senders Recipients
Data type
Curent {after 5/18/2018)
Date
[ From: Jun 012018
O Te:

Jun 02

Message contains

(B2 20| &R [won [ & | [ B & B |G- -
Text Notifications
Report Criteria
Default administator
Include Notifications with all of the selected recipients

[On-Call] Doctors On Shift

Vocera Alert, Vocera Console, Vocera Generic, Vocera Page

WEB Console. Smartphone Client, Vocera Badge, Vocera Voice server, Web Service, WCTE,
Initiated by email, Vocera Secure Texting, Vocera VML, Voice Server Email Integration,

Recipiert(s)
Include Notfications with all of the selected re ~

Intizted from

WEB Console
Smartphone Client
Vocera Badge
Vocera Voice server
Web Service
WCTP

<

Initiated by email
Vocera Secure Texting
Vocera VMI

v

> & Generate

Current Page: 1 Total Pages: 1

Zoom Factor: 100%

In the Reports module, you can display reports that list the status of Chat messages and content sent from

the VMP Server.

Select the Transmit Status icon to

display these reports.

The following Transmit Status reports can be generated:

Table 20: Transmit Status reports

Report Type

Chat by user - Legacy

Content

Description

For clients that have used the legacy Chat capability that was provided in
previous versions of VMP, this displays transmit status information on Chat
messages. You can specify the user for which Chat status information is to
be displayed.

Displays transmit status information on content transmitted from this
Server.

You can generate a report that lists the users that have received content that has been provided for them.

1. Open the VMP Administrator application and select Reports > Transmit Status.

Transmit
Status

2. In the Reports pane, click Content. The Transmit Status Content Report window opens.
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<
| Current Page: none | Total Pages: 0 | Zoom Factor: 100% If

3. From the Group by dropdown list, select User to organize the report by user name, or select Content
to organize the report by content items.

4. From the Status dropdown list, select one of the following:
» All: Display all users, whether or not they have received the content.
* Received: Display users that have received the content.
* Not received: Display users that have not received the content.

5. From the Content dropdown list, select the type of content for which content transmit status
information is to be displayed, or select All to display information for all content types.

6. From the Users dropdown list, select All to display content transmit status information for all users, or
select Selected to specify the users for which you want to display information.
a. If you select Selected, a list of users appears. Select the user for which you want to display content

transit status information.

<|
| current Page: none | Total Pages: 0 | Zoom Factor: 100%

7. Click Generate to generate the content transmit status report.
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85 Transmit Status Content Report

[E=S ICR =2

(03 3 0| & & & [ww ] & |
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Default administrator

%) Emergency Plan

% Emergency Plan
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Content transmit status

N S TS

Jen McMaster
N S TS
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o View options
Group by | User ~

Fiter
Stus: Al 7

Contentt: | PDF document v

Users: Al 7

Not received

Not received

=] Generats

Current Page: 1

Total Pages: 1 Zoom Facter: 100%

After you have created a report, you can use the tools provided to edit, print, or export the report.

These tools are available in a toolbar at the top of the report:

Text Messages Status - Detailed Report

BEEER R R Y I =

The following table describes these tools.

Tool

) search

L Print

Iil Print Direct
[y Page Setup
"7 Hand Tool
&, Magnifier
=\ Zoom Out

100% Zoom

%, Zoom In

| First Page

"':] Previous Page
[::' Next Page
I/ Last Page

Ellj Multiple Pages

N Background Color

Iﬁ Watermark
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Description

Search for a word or text in the report.

Select a printer and print the report.

Print the report on the last selected printer.

Set up the report pages for printing.

Move around in the displayed report.

Toggle between smaller and larger display views.

Display more of the report in a smaller size.

Specify the percentage size to use when displaying the report.
Display less of the report in a larger size.

Go to the first page of the report. This appears only when you are not already on the
first page of the report.

Go to the previous page. This appears only when you are not already on the first page
of the report.

Go to the next page. This appears only when you are not already on the last page of
the report.

Go to the last page of the report. This appears only when you are not already on the
last page of the report.

Display multiple pages at once.

Select the background color for the report.

Supply a watermark for each page of your report.
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Tool Description
\ld Export Document Export the document in the format specified in the dropdown menu. Depending on the
format you specify, additional formatting options may appear.
=1 Send E-mail Include the document in an email message in the format specified in the dropdown
menu. Depending on the format you specify, additional formatting options may
appear.

The Configuration module enables you to customize your VMP environment to suit your needs.

The Configuration module is organized into views, which are listed in the table below.

Table 21: Configuration module views

View Description

System Options Manage system options.

Wireless Gateways Create and modify system wireless gateways.
Contact Fields Customize contact fields for your deployment.
Contact Source Mapping Map contact fields to source fields.

User Source Mapping Map user fields to source fields.

Plugin Configuration Configure integrated plugins.

Licensed Applications Manage application licensing.
For more information on System Options, see on page 258.
For more information on Wireless Gateways, see on page 101.

The System Options control the behavior of the VMP Server and the VMP Administrator.

For more information on system options, see on page 258.

The Contact Fields module provides options to define the field source mapping appropriate for your
contacts.

Field source mappings should be defined before the source import is initiated. You can map contact
fields from one or many sources. This view also provides options to define field types specific for your
environment.

Contact Fields
@t

Name Type
Personal Photo Photo

b | Bkt P S
Email Email
Photo Image
Image 1 Image
Image 2 Image
Image 3 Image
Image 4 Image
Title Text
Web Page URL
Emai 2 Email
Mobile Phone Phone
Pager Phane
Callback Phone Phone
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The Contact Fields view includes the following options:

Table 22: Contact field options

Option
&)
v

Description

Open the Define Field dialog to create a new field.

Delete a highlighted field.

Edit a highlighted field.

Move the highlighted field up.
Move the highlighted field down.

THE VMP ADMINISTRATOR

Define the fields that are included in a search from the client for indexing.

Use the VMP Administrator Contact Source Mapping module to edit contact fields.

{8 YMP (Defoult administrator) - [Contact Source Mapping] - o x
£ File View Window Help -
Users & Groups || Contact Remote Sources. Title:
Contacts Source type Contact field Source fied ~
Content Active Directory (Legacy) First Name: First name v
Reports BES 4.0 Middee Name: v
Configuration sz ; ; Last Name: Last name v
- e BlackBeny PIN v
— Exchange Server 2010 el Enal =
,J Generc LDAP Fhas ¥
Contact Fields Voczra :mage - -
image 2 v
mage 3 v
- - mage 4 -
el Tle: v
Contact Source Web Page: Web page -
S Email 2 v
© Mobie Phone: | Mobik phone Vv

This view lists available sources on the left. Click to highlight the source for mapping edits. Each source
field is listed on the right. The fields contain a dropdown list to map the source field to a VMP field.

O

Tip: The field mappings are also defined during an initial source import. Use this view only when
updates are required.

Use the VMP Administrator User Source Mapping module to map VMP fields to fields from the import

VST

DevicelD:

source.
User Remote Sources Default Mapping
Source type Contact field Source field
BES 4.0 Middle Name: ~
BES 4.1 Last Name Last name ~
EEE Tile Title ~
Vooers Email Eonai ~

GatewaylD:

This view lists available sources on the left. Click to highlight the source for mapping edits. Each source
field is listed on the right. The fields contain a dropdown list to map the source field to a VMP field.
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Tip: The field mappings are also defined during an initial source import. Use this view only when
updates are required.

Use the Plugin configuration view to add and configure licensed plugins for your deployment.

The following plugin configurations are supported.

Table 23: Plugin configuration support

Plugin
MIR3 FAX

WIC PIN Blaster

MIR3 SMS

SendWordNow SMS connector

SMTP connector

MIR3 Voice

SendWordNow Voice

188

Settings

Enter the following settings:

¢ Company

e URL

¢ Username

e Password

* Confirm Password

Enter the following settings:

e Server

* Login

e Password

* Confirm Password

Enter the following settings:

e URL

¢ Username

e Password

¢ Confirm Password

Enter the following settings:

* Login
e Password
* Confirm Password

Enter the following settings:

e Server

¢ Port

e SSL

* PrimaryPagerID

Enter the following settings:

e URL

¢ Username

e Password

¢ Confirm Password

Enter the following settings:

* Login
e Password
¢ Confirm Password

VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



189

Plugin
TFC Voice

Voice Gate

Settings

Enter the following settings:

e TUsername
e Password
¢ Confirm Password

* cliid
e user id
* caller id

Enter the following settings:

* (Client Name

e (lient ID

e Confirm Client ID
¢ Display Number

THE VMP ADMINISTRATOR
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Plugin Settings
GEMUSE integration Enter the following settings:

* Scanning folder (Required field): The local or network location where
incoming GE MUSE XML files will be located. The service account
credentials used by the Vocera Data Exchange service are used to
authenticate to network locations.

e XML Mapping Field (Required field): The XML tag to use when mapping field
values to Distribution Lists. Examples of commonly used XML tags include

<ReferringMDLastName> and <SiteName>.

===| Note: The value of this field - the XML tag to match in incoming
== messages - is referred to as XMLMappingField elsewhere in this
section.

e Default distribution list (Required field): Used if the defined Mappings
do not match the value of XMLMappingField that is specified in the
incoming XML.

* Default notification distribution list (Required field): When a new XML
file is processed for an unmatched XMLMappingField value, send a
notification to this Distribution List.

e Mapping 1 through Mapping 100 (Optional fields): Enter
XMLMappingField = <Distribution List Name> to map each
XMLMappingField value specified in the incoming XML to its
corresponding Distribution List name.

* Notification DL 1 through Notification DL 100 (Optional fields): When a
new XML file is processed that matches the specified Mapping, send a
notification to this Distribution List.

The body of a generated message contains the following fields from the GE MUSE XML file:

Subject: GE MUSE consult from XMLMappingField
Patient ID: <PatientID>

Patient Name: <PatientLastName>, <PatientFirstName>

Gender: <Gender>

Age: <PatientAge>

Ordering Physician: <HISOrderingMDLastName>,
<HISOrderingMDFirstName>

<TestReason>

All messages are given Urgent priority.

When a new XML file is processed, the format for the notification sent to the notification
Distribution List is:

Subject: GE MUSE consult status changed for Patient ID
<PatientID> at XMLMappingField MappingFieldValue
Body: The GE MUSE consult request sent to <first
name> <last name> received the response <response> at
<timestamp>.

You can configure any licensed plugin that you have added to your VMP Server.

1. From the VMP Administrator, select Configuration > Plugin Configuration.
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Plugin
Configuration

2. Click the Active checkbox for the plugin you want to configure.

Plugin Configuration X

Plugin Active | % Reset Settings
tass Notification FéX messaging Name Value
1 MIR3 A O Confia
Maszz Matification PIN messaging o URL
1 WIC PIN Blaster 0 £3 Usemams
tass Motification SM5 messaging ° Pasomod s
\? LRSS a o Confirm Password | ™5
& SendwordMow SMS cannectar O
\b SMTP connectar ]
tass Notification VR

» 1 MIR3WYoice
@ SendwordMow Voice O
1 TFC Yoice ]
5? Voice Gate O
Tes mesoge iteon [tion Doscition
W GEMUSE integration O
[ok ]| cancel || Hep |

3. For each required setting, enter its value in the Value column.
4. Click OK to save the configuration.

Use the Vocera Messaging Platform Licensed Application view to display available application licenses and
assign licenses to platform users. This view lists each licensed application, the available licenses, and the
number of licenses currently assigned to users.

To display the Licensed Application view, select Configuration > Licensed Applications.
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Highlight an application to view the assigned users. Add or remove a licensed user from an application by
clicking to highlight the user and selecting Add or Delete.

Note: The applications that are available to you depend on whether your license key is in an XML
format. See The XML License Key Format on page 21 for more details on this format.
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The VMP Web Console provides a browser-based way to send messages, view on-call status, and create
schedules. You can also place calls from the VMP Web Console if your device is logged into Vocera
Collaboration Suite.

The VMP Web Console provides administrator and user access to the VMP communication platform from
your Web browser.

The URL for the VMP Web Console is the DNS entry or the IP address of the VMP Server.

Depending upon the firewall configuration, the VMP Web Console can be opened up to external, off-
network users.

Users are assigned access to the VMP Web Console in the VMP Administrator. For details about granting
users access to the VMP Web Console, see on page
231.

The VMP Web Console is supported on Microsoft Internet Explorer version 11, Google Chrome, Mozilla
Firefox, and Microsoft Edge. Safari is supported on MacOS.

To use the VMP Web Console, you must log in.

vocera\ Web Console

Log in to Vocera

Username

BN

Password

Q

Vocera Messaging 5.3.3.2315 © 2019 Vocera

1. In the Username field, type your username.
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2. In the Password field, type the password for your username.
3. Click Log in to log in to the VMP Web Console.

====1| Note: If you are a Vocera Secure Texting user, you cannot log into the VMP Web Console.

The VMP Web Console Monitor View lists messages sent or received by the users for which you have
granted viewing permission.

To access the Monitor view, select the Monitor View icon.

vocera W Web Console

Jen McMaster
you are needed in room 203

====| Note: This icon appears only when the user that is logged on has permission to view either sent
messages or received messages. See on page 234 for more
information on granting permission to view messages.

The Monitor View lists each message.

vocern W Web Console ) 105n Menab | Logout

Monitor View

O o o505 veveb 2 sentvo

4 Josh McNab 2:41pm rs«::il_wiems: : Read: 1
= Jen McMaster Delivered: 1
0

(No Subject) Can't deliver:
vou are needed in room 203

=
s

Vocera Messaging 5.3.3.2315 © 2019 Vocera

Click a message to display its details.

From the Monitor View, you can search for messages, or select the source or recipient of a message.
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i‘ Web Console 9 20ch enab | Lovaus
Monitor View
UL | snt by: Josh Mchab
4 Josh McNab Recipients: 2
ent: 1
[@]* Grace Morgan... Delivered: 1
charts for Bob Perkins Can't deliver: 0
Please bring them right away!
# Josh McNab 10:37am  Reclplents: 2 Read: 1
ent:
fal* Grace Morgan... Delivered: 1
charts for Bob Perkins Can't deliver: 0
Jen McMaster has been added to the conversation
4 Josh McNab Yesterday :eci‘pien(s: % Read: 1
ent:
fal* Grace Morgan... Delivered: 1
charts for Bob Perkins Can't deliver: 0
Could you please bring them to me? Thanks.
“* Josh McNab Yesterday ;Red‘olenls: z Read: 1
ent:
fal * Grace Morgan... Delivered: 1
charts for Bob Perkins Can't deliver: 0
Do you have the charts for patient Bob Perkins?
Display [T ver page

Vocera Messaging 5.3.3.2315 © 2019 Vocera

1 Use the search box to search for messages by:

* Sender

* Recipient

* Subject

* Keyword (in the message subject)

2 The Sent by field. Click the pencil icon to create Sent By filters.

3 The Sent to field. Click the pencil icon to create Sent To filters.
For more information on using the Sent By and Sent To filters, see on page
195.

====| Note: You must use the VMP Administrator to grant permission for a user to view messages
sent or received by any other user. See on page 234 for more
information on granting permission to view messages.

In the Monitor View, you can create Sent By and Sent To filters that limit the messages that are displayed
on the screen.

1. Do one of the following:

1 Click the pencil icon in the Sent by field to edit the Sent By filter.

2 Click the pencil icon in the Sent to field to edit the Sent To filter.
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vocers W

4 Josh McNab

% Jen McMaster
(No Subject)

you are needed in room 203

E Sent by: Josh McNab

Web Console

Monitor View

2:41 pm

THE VMP WEB CONSOLE

{£) cail Goodman | Logout

Recipients:
Sent:
Delivered:
Can't deliver:

Page SN of 1 Display (I per page

Vocera Messaging 5.3.2.2104 © 2019 Vocera

2. In the Select Users/Groups dialog box, select the All tab to display both users and groups, select the
Groups tab to display groups only, or select Users to display users only.
3. Select the checkboxes of the users and groups to include in the filter:

1 Click > to add a user or group.
2 Click < to remove a user or group.
3 Click << to remove all users and groups.

Available Users/Groups

GROUPS USERS

4. Click Next.

196

[

Next

‘[ Cancel ‘

Josh McNab
[Global] Hospitalist
Available, Off campus
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5. In the selection tree dialog box that appears, select the checkboxes of the criteria to be matched for
messages to appear in the Monitor View. You can select separate criteria for secure messages and for

notifications.

Sent By - Select Users/Groups

Secure Messages
[— Responses
With Responses
Without Responses
[— Expiration
Expired
Not Expired

Does not have Expiration

L Priority

Normal
High
Urgent

Back

Notifications
— Responses
With Responses
Without Responses
— Expiration
Expired
Not Expired

Does not have Expiration

L— Priority

Normal
High
Urgent

Save Cancel

6. Click Save to save this filter, or click Cancel to cancel editing the filter. Click Back to return to

selecting users and groups.

Vocera Messaging Platform users can create or send a secure message to users or Distribution Lists using
the VMP Web Console. The console provides an interface for sending messages from your Web browser.

You can grant access to the VMP Web Console when you create, import, or edit users. Users can create
messages from existing templates if they have been made available, and they can edit the templates if you
enable that option.

====| Note: The text of a message can be up to 3000 characters long, and the subject header can contain
up to 512 characters. Any ASCII character can be included, but emojis are not supported.

You can use the VMP Web Console to send a message to any user or Distribution List.

1. Open the VMP Web Console from your Web browser.
2. Select the Message tab.

197

Note: If the message has more than 50 recipients, it is defined to be a Mass Notification. See
on page 212 for details.
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Contacts ES

Calvin Lu
[Global] Registered Nurse

Mot Available

Carol Wilson
[Global] Charge Nurse
Mot Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

Secure Messages

Grace Morgan 12:28 pm
charts for Bob Perkins
Could you please bring them to me? Tha..

Jen McMaster 12:07 pm
Here's the latest picture of Linda

The New Secure Message screen appears.

4. Select New Text to create a new message.

vocera Il Web Console ) 305 menab | Logous

:\ New Secure Text New Secure Message

To: i

New Text Subject: | ‘

(&) Click to attach patient info

B 1] -

w ) Send
Priority  Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

You can also create a message using a message template. This enables you to send an emergency
message quickly. For information on how to send a message using a template, see
on page 201.

5. To add one or more message recipients, either type the recipient name in the To: field, or click the Add
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Recipient icon to select a Distribution List or user to add to the recipient list.
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Web Console ) 105h McNab | Logout

New Secure Message
o ([~

Subject: | |

(&) Click to attach patient info

As you type in the To: field, a list of all users and groups in your current site that match the text that
you type are displayed in a popup window:

New Secure Message

‘,:3 »'Deh McMaster
Subje \&&¥ obal] Registered Nurse

(] = ] -

Quick Messages Priority Attach Media Responses
This list includes all favorites that match your typed text, even if they are on a different site.
’=| Note: If a recipient is having messages forwarded to another contact, that contact is

automatically added to the list of recipients when the message is sent.

When a message recipient is an individual user, the VMP Web Console indicates the user's availability. A
green dot next to the user's name indicates that the user is available:

New Secure Message

ICHE @ Grace Morgan =

Subject: | |

An orange dot next to the user's name indicates that the user is available but is in Do Not Disturb mode.

If a user is unavailable, the user's name is highlighted with a red background, and a banner indicates
that the user is unavailable:

New Secure Message

@ Grace Morgan is unavailable

If you are sending a message to multiple users, and one or more users are unavailable, the unavailable
users are listed first.

6. If you have clicked the Add Recipient icon, the Select Recipients dialog box appears. Select the
Favorites tab to display favorites only, or select the Contacts tab to display all contacts.

=== Note: Sce on page 252 for more information on creating
favorites.
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7. Select the checkboxes of the users and Distribution Lists to include as recipients:

Available Users

FAVORITES CONTACTS

Calvin Lu
[Global] Registered Nurse
Mot Available

Carol Wilson
[Global] Charge Nurse
Mot Available

[Global] Registered Nurse
Available, Off campus

Linda Davis
[Global] Respiratory Therapist
Mot Available

®
o
@ rontomse

Click > to add a recipient.

Click < to remove a recipient.

Cancel

Click << to remove all recipients.

Selected Users

8. If your message has a subject, type the subject text in the Subject field.
9. To attach patient information to this message:

200

Select Patient sites |

PATIENTS FROM Engage Server #2 (Site2)

Camryn , Nicolas

Room: 2 DoB: May/26,/2018 (74d)
Unit: Unitl

MRN: VMP2-2

Douglas, Donald Mc

Room: Room1 DoB: May/05/1960 (58y)
Unit: Unitl

MEMN: VMP2-mm1

Goldner, Michel

Room: Room1 DoB: Jul/26/2014 (4y)
Unit: Unitl

MRN: VMP2-3

Leffler, Carley

Room: Room1 DoB: Jul/26/2018 (13d)
Unit: Unit1

MRN: VMP2-1

Patient, PatientvVMP2 Patient

Unit:

o ) (o)

Room: DoB: May/07 /1970 (48y)
v

a. Click the Click to attach patient info link. The Select Patient dialog box appears:

If no patient information is available, this link does not appear.

patients.

text.

b. Click My Patients to view your patient list only, or click All Patients to view a list of all available

c. Type text in the search field to limit the patient list to patients whose name matches your search
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d. Select the patient whose information you want to attach to this message.
e. Click OK to close the Select Patient dialog box. The message now contains a link to the patient
information that you have selected.

vocera I Web Console 9 10sh venab | Logous

Q \ Cancel \ New Secure Text New Secure Message
Q IR Doctors =

New Text Subject: | ‘

(&) BARBARA S ADAMS - Room: CC593 - DoB: Dec/27/1945 (71) @

3 8 - Send
Priority Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

Note: If you have linked to patient information, and you have not specified a subject for your
message, the VMP Web Console uses the patient name as the message subject.

10.Click Priority to specify a priority for the message. Select one of Normal, High, or Urgent. The
following table lists the notifications sent for each priority:

Priority
Norma
High
Urgent

!

Notifications in VCS app
1 Single ring and vibration
Multiple rings and vibrations

Multiple rings (overriding user's volume setting) and vibrations

Important: On some devices, messages sent with Urgent priority may be spoken out loud to
some recipients. Sending confidential patient health information with this priority may violate
privacy regulations.

11.Do one of the following:

a. Tos
b. Tos

end a text message, type the message text in the field at the bottom of the screen and click Send.
end a photo, click Attach Media and select the image that you want to send.

Attach Media is not available if you have disabled the Allow attaching pictures from a file
configuration option in the VMP Administrator.

c. To create a message that requires a response, click Responses. This displays the interface for
sending a message that requires a response. See on
page 208 for more details.

Message templates enable you to send emergency messages quickly, as the text and recipients are defined
for you in the VMP Administrator.

For information about creating templates, see on page 142.

1. Open the VMP Web Console from your Web browser.
2. Select the Message tab.

201
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Contacts ES

Calvin Lu
[Global] Registered Nurse

Mot Available

Carol Wilson
a [Global] Charge Nurse
Mot Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

3. Click the Compose icon.

Secure Messages #
Grace Morgan 12:28 pm
charts for Bob Perkins
Could you please bring them to me? Tha..
Jen McMaster 12:07 pm
Here's the latest picture of Linda

The New Secure Message screen appears.

4. Select the message template from the list of templates. If you have defined a large number of templates,
type text in the template search field to display only the templates that match your search text. If you
are looking for a template with a long name, expand the New Secure Text pane to view it.

vocera Il

\_' ncel | New Secure Text

Q) Code

New Text

Templates

Code Blue

Note: To search for multi-word text or a text fragment that includes a space, enclose your search
text in double quote characters, as in "search text".

The message template appears.
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vocera I Web Console 9 1050 menab | Logout

: ancel | New Secure Text New Secure Message
Q Code Bl [On-Call] On-Call Doctors =

New Text Subject: |Cude Blue

MESSAGE
Templates

Message: ‘Emergency! Code Blue in room 203, |

D Deliver to on campus users only

Code Blue

Staff meeting

MESSAGE SETTINGS

D Notify if no one has responded within minutes

‘: Send ‘

Vocera Messaging 5.3.3.2315 © 2019 Vocera

5. Your template may already have specified default recipients for your message. To add one or more

additional message recipients, either type the recipient name in the To: field, or click the Add
Recipient icon to select a Distribution List or user recipient.

Web Console ) 30sn McNab | Logout

New Secure Message

Doctors =

Subject: \Code Blue \

====| Note: If a recipient is having messages forwarded to another contact, that contact is
automatically added to the list of recipients when the message is sent.

When a message recipient is an individual user, the VMP Web Console indicates the user's availability. A
green dot next to the user's name indicates that the user is available:

New Secure Message

ICHN @ Grace Morgan =

Subject: | |

An orange dot next to the user's name indicates that the user is available but is in Do Not Disturb mode.

If a user is unavailable, the user's name is highlighted with a red background, and a banner indicates
that the user is unavailable:

New Secure Message

To: ® Jen McMaster x|

@ Grace Morgan is unavailable

®

If you are sending a message to multiple users, and one or more users are unavailable, the unavailable
users are listed first.

. If you have clicked the Add Recipient icon, the Select Recipients dialog box appears. Select the

Favorites tab to display favorites only, or select the Contacts tab to display all contacts.

== Note: Sce on page 252 for more information on creating
favorites.

7. Select the checkboxes of the users and Distribution Lists to include as recipients:

203
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1 Click > to add a recipient.
2 Click < to remove a recipient.
3 Click << to remove all recipients.

Available Users Selected Users

FAVORITES CONTACTS

Calvin Lu
[Global] Registered Nurse
Mot Available

Carol Wilson
[Global] Charge Nurse
Mot Available

[Global] Registered Nurse
Available, Off campus

Linda Davis
[Global] Respiratory Therapist
Mot Available

®
o
@ e

THE VMP WEB CONSOLE

8. In the Subject field, type or edit the message subject if it is needed. The message template may have

9. To attach patient information to this message:
a. Click the Click to attach patient info link. The Select Patient dialog box appears:

Select Patient sites |

204

provided this text for you.

PATIENTS FROM Engage Server #2 (Site2)

Camryn , Nicolas =

Room: 2 DoB: May/26/2018 (74d)
Unit: Unit1
MRM: VMP2-2

Douglas, Donald Mc

Room: Room1 DoB: May/05/1960 (58y)
Unit: Unitl

MRN: VMP2-mmi1

Goldner, Michel

Room: Room1 DoB: Jul/26/2014 (4y)
Unit: Unitl

MRN: VMP2-3

Leffler, Carley

Room: Room1 DoB: Jul/26/2018 (13d)
Unit: Unitl

MRN: VMP2-1

Patient, PatientVMP2 Patient
Room: DoB: May/07/1970 (48y)

[ o ] Cancel |

uUnit:

If no patient information is available, this link does not appear.
b. Click My Patients to view your patient list only, or click All Patients to view a list of all available

patients.

c. Type text in the search field to limit the patient list to patients whose name matches your search

text.
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d. Select the patient whose information you want to attach to this message.
e. Click OK to close the Select Patient dialog box.

====| Note: If you have linked to patient information, and you have not specified a subject for your
message, the VMP Web Console uses the patient name as the message subject.

10In the Message field, type or edit the message text. The message template may have provided this text

for you.

11 Below the Message field, you may have created additional fields in which you can provide information.
One or more of these fields may be required. See on page 142 for more
details.

12.To specify an expiration time in minutes for your message, click one of the buttons in the

Conversation Expiration row:

* Never, which indicates that the message never expires (this is the default setting)
* 2 min

* 5 min

* 10 min

* Custom
If you click Custom, a field appears in which you can specify the number of minutes before the

message expires:

vocera I Web Console 9 1050 Monab | Logout

[ cancel | New Secure Text New Secure Message
Q Code Bl [On-Call] On-Call Doctors =

Subject: |Cmde Blue |

New Text

MESSAGE

Templates
Message: ‘Emergency! Code Blue in room 203, |

Code Blue

Staff meeting Expiration in | | minutes

D Deliver to on campus users only

MESSAGE SETTINGS

D Notify if no one has responded within minutes

Response Expiration:

Vocera Messaging 5.3.3.2315 © 2019 Vocera

====1| Note: Once a message conversation has expired, the message will no longer be delivered to VCS
and VMP Web Console users that have not yet received it and will not be retrieved the next time

they log in.

13.Select the Do not deliver to off campus users checkbox if this message is to be delivered only to

users who are on-campus. This ensures that emergency messages are sent only to those people who can
immediately respond to them.

14 Configure the following options.
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Option

Priority

Notify if no one has
responded

Response Expiration

Response Options

THE VMP WEB CONSOLE
Description

One of the following:

* Normal (the default)
* High

e Urgent

See on page 197 for details on how these priority levels
are handled in the VCS app.

' Important: On some devices, messages sent with High or Urgent priority

may be spoken out loud to some recipients. Sending confidential patient
health information with either of these priorities may violate privacy
regulations.

Select this checkbox if you want to be notified when no one has responded within
the number of minutes that you specify in the text field. If no one responds to this
message during this time period, the Notify Me icon is displayed in the message
link:

()

» If you are logged onto a Vocera badge, the notification is sent as a message on the
badge.

* If you are logged into a badge and on to the Vocera Collaboration Suite, a tone
notification is sent to the badge, and the Notify Me icon is displayed in the
message link.

* If you are logged into a badge and on to the VMP Web Console, a tone
notification is sent to the badge, and the Notify Me icon is displayed in the
message link.

Specify the time period, in minutes, in which responses to this message are allowed.
This time period is indicated on the sent message. Select Custom to specify a time
period.

If the communication requires a response, set multiple choice options to help the
recipient respond quickly. When you type an option, a new field appears to enable
you to type an additional option if necessary. To delete an option that you have
created, click the Delete icon:

RESPONSE OPTIONS \
1: |1 am on my way. \bg
2: | sorry, I am busy. [x]

3] |

15.Click Send to send the message, or click Cancel to return to the message interface described in

on page 197.

If you use a template frequently, you can set it to be a favorite. Favorite templates appear at the top of the
list of templates.

1. Open the VMP Web Console from your Web browser.

2. Select the Message tab.
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Contacts ES

Calvin Lu
[Global] Registered Nurse

Mot Available

Carol Wilson
[Global] Charge Nurse
Mot Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

Secure Messages #

Grace Morgan 12:28 pm
charts for Bob Perkins
Could you please bring them to me? Tha..

Jen McMaster 12:07 pm
Here's the latest picture of Linda

The New Secure Message screen appears.
4. In the list of templates, locate the template that you want to specify as a favorite. If necessary, scroll
down in the list until you find it.

vocera Il Web Console 9 105 menab | Logout

[ cancel ] New Secure Text New Secure Message
Q Code Hll [On-Call] On-Call Doctors x

New Text Subject: |Code Blue |

MESSAGE
Templates

Message: ‘Emergency! Code Blue in room 203, |

D Deliver to on campus users only

Code Blue

Staff meeting

MESSAGE SETTINGS

D Notify if no one has responded within minutes

‘. Send ‘

Vocera Messaging 5.3.3.2315 © 2019 Vocera

5. Click the star next to the template name. The star turns yellow, which indicates that this template is a
favorite.
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vocera Il Web Console 9 1050 menab | Logout

( cancel ] New Secure Text New Secure Message

Q Code BN [On-Call] On-Call Doctors =

New Text Subject: |C0de Blue |
MESSAGE
Templates

Message: ‘Emergency! Code Blue in room 203, |

D Deliver to on campus users only

Code Blue

Staff meeting

MESSAGE SETTINGS

D Notify if no one has responded within minutes

‘: Send ‘

Vocera Messaging 5.3.3.2315 © 2019 Vocera

The selected template is moved to the top of the list of templates, along with any other favorite
templates that you have previously selected.

To remove a template from the list of favorites, click the star next to the template name again.

You can send a message that requires the recipient to provide a response.

1. Open the VMP Web Console from your Web browser.
2. Select the Message tab.

Contacts | Sites |

Calvin Lu
[Global] Registered Nurse
Not Available

Carol Wilson
[Global] Charge Nurse

Mot Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

Secure Messages

Grace Morgan 12:28 pm
charts for Bob Perkins
Could you please bring them to me? Tha..

Jen McMaster 12:07 pm
Here's the latest picture of Linda
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The New Secure Message screen appears.

Select New Text to create a new message.

vocera I Web Console D 305 Menab | Logous

el \ New Secure Text New Secure Message
Q 3

New Text Subject: |

‘.;,/ Click to attach patient info

= g & Send
Priority  Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

You can also create a message using a message template. This enables you to send an emergency
message quickly. For information on how to send a message using a template, see

on page 201.
To add one or more message recipients, either type the recipient name in the To: field, or click the Add
Recipient icon to select a Distribution List or user to add to the recipient list.

Web Console ) 10sh McNab | Logout

New Secure Message

Subject: | |

(&) Click to attach patient info

====| Note: If a recipient is having messages forwarded to another contact, that contact is
automatically added to the list of recipients when the message is sent.

When a message recipient is an individual user, the VMP Web Console indicates the user's availability. A
green dot next to the user's name indicates that the user is available:

New Secure Message

ICHE @ Grace Morgan =

Subject: | |

An orange dot next to the user's name indicates that the user is available but is in Do Not Disturb mode.
If a user is unavailable, the user's name is highlighted with a red background, and a banner indicates
that the user is unavailable:

New Secure Message

@ Grace Morgan is unavailable

If you are sending a message to multiple users, and one or more users are unavailable, the unavailable
users are listed first.
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6. If you have clicked the Add Recipient icon, the Select Recipients dialog box appears. Select the
Favorites tab to display favorites only, or select the Contacts tab to display all contacts.

7. Select the checkboxes of the users and Distribution Lists to include as recipients:

8. Click Responses to display the screen for sending a message with a response.

9.

210

====! Note: Sce
favorites.

1 Click > to add a recipient.
2 Click < to remove a recipient.
3 Click << to remove all recipients.

Available Users Selected Users

FAVORITES CONTACTS

Calvin Lu
[Global] Registered Nurse
Mot Available

Carol Wilson
[Global] Charge Nurse
Mot Available

[Global] Registered Nurse
Available, Off campus

Linda Davis
[Global] Respiratory Therapist
Mot Available

®
9
@ e

‘ H Cancel ‘

9 Josh McNab | Logout

vocera\ Web Console

[ cancel | New Secure Text
Q To:

New Secure Message

New Text Subject: |needed in room 203
(&) Click to attach patient info
Templates
MESSAGE

Patient Reguest Message: ‘\mu are needed in room 203 ‘

C] Notify if no one has responded within minutes

RESPONSE OPTIONS

Team Potluck Lunch

1: \il am on my way. \o

2: ‘:Sorry, 1 am busy. ‘o

3:\'

Vocera Messaging 5.3.3.2315 © 2019 Vocera

In the Subject field, type an subject for the message if it is needed.
10.To attach patient information to this message:
a. Click the Click to attach patient info link. The Select Patient dialog box appears:
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PATIENTS FROM Engage Server 22 (Site2)

Camryn , Nicolas
Room: 2 DoB: May/26/2018
Unit: Unit1

MRN: VMP2-2

Douglas, Donald Mc

Room: Room1l DoB: May/05/1960
Unit: Unit1

MEMN: VMP2-mm1

Goldner, Michel
Room: Room1

Unit: Unitl

MRN: VMP2-3

Leffler, Carley
Room: Room1
Unit: Unit1

MRN: VMP2-1

Patient, PatientVMP2 Patient
Room:
Unit:

(o« ) (Ccancel )

DoB: Jul/26/2014 (4y)

DoB: Jul/26/2018 (13d)

DoB: May/07/1970 (48y)

-

(74d)

(58y)

w

b. Click My Patients to view your patient list only, or click All Patients to view a list of all available

patients.

c. Type text in the search field to limit the patient list to patients whose name matches your search

text.

d. Select the patient whose information you want to attach to this message.
e. Click OK to close the Select Patient dialog box.

====| Note: If you have linked to patient information, and you have not specified a subject for your
message, the VMP Web Console uses the patient name as the message subject.

11In the Message field, type the text of the message.
12 Configure the following options.

211

Option

Priority

Notify if no one has
responded

Description

One of the following:

* Normal (the default)
* High

e Urgent

See
are handled in the VCS app.

on page 197 for details on how these priority levels

' Important: On some devices, messages sent with Urgent priority may
be spoken out loud to some recipients. Sending confidential patient health

® /' information with either of these priorities may violate privacy regulations.

Select this checkbox if you want to be notified when no one has responded within
the number of minutes that you specify in the text field. If no one responds to this
message during this time period, the Notify Me icon is displayed in the message
link:

()

» Ifyou are logged onto a Vocera badge, the notification is sent as a message on the
badge.

* Ifyou are logged into a badge and on to the Vocera Collaboration Suite, a tone
notification is sent to the badge, and the Notify Me icon is displayed in the
message link.

* Ifyou are logged into a badge and on to the VMP Web Console, a tone
notification is sent to the badge, and the Notify Me icon is displayed in the
message link.
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Option Description

Response Expiration Specify the time period, in minutes, in which responses to this message are allowed.
This time period is indicated on the sent message. Select Custom to specify a time
period.

Response Options If the communication requires a response, set multiple choice options to help the

recipient respond quickly. When you type an option, a new field appears to enable
you to type an additional option if necessary. To delete an option that you have
created, click the Delete icon:

RESPONSE OPTIONS e

1: [T am on my way. \k@
2: \Sorry, I am busy. |o

3:| |

13.Click Send to send the message, or click Cancel to return to the message interface described in
on page 197.

When you create a message that has more than 50 recipients, it is automatically treated as a Mass
Notification.

When you receive a Mass Notification, the text N Participants is shown as the recipient, where N is the
number of recipients.

The list of Mass Notification recipients can be displayed in the VMP Web Console, but cannot be displayed
on user devices.

After you have sent or have received a secure message in the VMP Web Console, you can continue a
conversation with the recipients or sender of the message.

1. Select the Message tab.

vocern I

Contacts E

Calvin Lu
[Global] Registered Nurse

Mot Available

Carol Wilson
g [Global] Charge Nurse
Mot Available

#, Grace Morgan
‘?) [Global] Patient Care Techni...
Available, Off campus

2. From the list of messages in the Secure Messages pane, select the message. The message is displayed in
the pane at the right.
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vocera s Web Console ) 20sh Mciab | Logous

Grace Morgan

Secure Messages “ charts for Bob Perkins

£ v (8
Read - 12:18 pm

Grace Morgan 12:18 pm - :
charts for Bob Perkins Do you have the charts for patient Bob Perkins? 9

Click to attach patient info

&

Yes, they are in my office.
Grace Morgan - 12:18 pm

Here's the latest picture of Linda

aJen McMaster 12:07 pm @ Yes, they are in my office.

e = B -

Quick Messages Priority Attach Media Responses

Vocera Messaging 5.3.2.2215 © 2019 Vocera

The colored ring around each message participant's photo or initials indicates the participant's
availability:
* Green indicates that the participant is available.
* Red indicates that the participant is not available.
* Orange indicates that the participant has set Do Not Disturb.

3. In the text field at the bottom of the pane, type your text message and click Send. Your messages and
the responses sent to you are displayed.

&) 10sh McNab | Logous

vocera I Web Console

-~ ; " Grace Morgan T
.t

Secure Messages [ ‘ Hide ‘ charts for Bob Perkins )

£ (8 (@ Click to attach patient info

Read - 12:18 pm
a Grace Morgan 12:18 pm

charts for Bob Perkins Do you have the charts for patient Bob Perkins?
Yes, they are in my office. .
Grace Morgan - 12:18 pm

Here's the latest picture of Linda

aJen McMaster 12:07 pm Yes, they are in my office.
Read - 12:28 pm

Could you please bring them to me? Thanks.

e S B «

Quick Messages Priority Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

4. To change the priority of a message, click Priority and select the priority to use. If the priority is higher
than Normal, the priority is included in the message.
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vocera\s Web Console 9 705 menab | Logout

Grace Morgan

Secure Messages charts for Bob Perkins

EAv (o}

(& Click to attach patient info

Read - Yesterday - 12:18 pm
Grace Morgan Yesterday _ )
charts for Bob Perkins Do you have the charts for patient Bob Perkins? @
Could you please bring them to me? Tha. S

Grace Morgan - Yesterday - 12:18 pm

Jen McMaster Yesterday @ Yes, they are in my office.
Here's the latest picture of Linda

Read - Yesterday - 12:28 pm

Could you please bring them to me? Thanks.
Read - Yesterday - 12:37 pm

Please bring them right away!
@ Urgent Priority

[ |~ 0 «

Quick Messages Priority Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

5. To attach media to a conversation, click Attach Media and select the attachment to include. A
thumbnail of the attachment appears in the conversation.

ﬁ Josh McNab | Logout

vocera Web Console

Secure Messages i Jen McMaster
Q

HJen McMaster 12:07 pm

Here's the latest picture of Linda

Read - 12:07 pm

Click to view

Read - 12:07 pm
Here's the latest picture of Linda

e 5 B -

Quick Messages Priority Attach Media  Responses

Vecera Messaging 5.3.3.2315 © 2019 Vocera

Click the thumbnail to view the attachment in more detail.

Attach Media is not available if you have disabled the Allow attaching pictures from a file
configuration option in the VMP Administrator.

6. To request a response to a message, click Responses. In the Response Request screen, specify the
response information, and click Send.
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vocera\r Web Console 9 705 menab | Logout

Jen McMaster

re Messages Bob Perkins

MESSAGE

Message: [Type 'your message here

Grace Morgan 11:28 am
Need someone in room 203
MESSAGE SETTINGS

charts for Bob Perkins
Please bring them right away!

Jen McMaster
Bob Perkins

Here's the latest picture of Linda

D Notify if no one has responded within minutes
Yesterday

RESPONSE OPTIONS

i

Vocera Messaging 5.3.3.2315 © 2019 Vocera

7. If you have been requested to supply a response, a list of response options is provided. Hover over an
option to select it, and click the option to send the response.

vocera\l Web Console ) 20sh MoNab | Lagout

Messages Grace Morgan

(@ Click to attach patient info
Grace Morgan - 11:28 am

Grace Morgan 11:28 am

Need someone in room 203. Need someone in room 203.

Grace Morgan, Je... 11:07am | Your Response is Required

charts for Bob Perkins Tap to select your response

Please bring them right away!

I am on my way. |H

Jen McMaster Yesterday

Here's the latest picture of Linda Sorry, I am busy. ‘ ‘ Click to

e | ] -

Quick Messages Priority Attach Media  Responses
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====| Note: If the sender has specified a time limit for a response, and the time limit has expired, this
will be indicated in the conversation:

vocera\l Web Console ) 20sh MoNab | Lagout

Grace Morgan

(@ Click to attach patient info
Grace Morgan - 11:28 am

Grace Morgan 11:28 am

Need someone in room 203. Need someone in room 203.

Grace Morgan, Je... 11:07am | Response Request Expired
charts for Bob Perkins Expired at 12:01 pm
Please bring them right away! You can no longer respand

Jen McMaster Yesterday
Here's the latest picture of Linda

e | ] -

Quick Messages Priority Attach Media ~ Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera
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If you are having more than one conversation, use the pane at the left to switch from one session to
another.

To display the current message delivery status, click on any text that you have sent in a conversation.
Click on a profile picture to display the contact status information for that person.

If a VST user sends a message, you can see all users who are part of this message, including those VST
users who are not part of an organization on the imported VST cloud server and are therefore not in the
VMP Server database.

You can view a list of the participants in a conversation.

1. Select the Message tab.

vocen I

Contacts | Sites |

Calvin Lu
[Global] Registered Nurse
Not Available

Carol Wilson
a [Global] Charge Nurse
Mot Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

2. From the list of messages in the Secure Messages pane, select the message for which you want to view
the list of participants.

3. Click the Info icon.

vocera W Web Console ) 20sh MoNab | Lagout

_ Grace Morgan
Setuplicesaies charts for Bob Perkins
v e & Click to attach patient info

Read - Yesterday - 12:18
Grace Morgan Yesterday i .
charts for Bob Perkins Do you have the charts for patient Bob Per ? @

Could you please bring them to me? Tha.

E Grace Morgan - Yesterday - 12:18 pm

Jen McMaster

Yesterday @ Yes, they are in my office.
Here's the latest picture of Linda

Read - gterday - 12:28 pm
Could you please bring the me? Thanks.

e | ] -

Quick Messages Priority Attach Media ~ Responses
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The list of participants appears:
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vocera\r Web Console 9 705 menab | Logout

Messages Wessage Details

Subject: [ ]

Grace Morgan, Je... 10:z7am
charts for Bob Perkins
Jen McMaster has been added to the con.

@ Add Participant

Jen McMaster Yesterday |

Here's the latest picture of Linda

Jen McMaster
[Global] Registered Nurse

] [ canest

Vocera Messaging 5.3.3.2315 © 2019 Vocera

4. Click OK to return to the conversation.

You can add additional users to an existing message conversation.

1. Click the Info icon.

vocera\dsl Web Console 9 705 wcnab | Logau

Grace Morgan

Messages charts for Bob Perki

(@ Click to attach patient info

Read - Yesterday - 12:18
Grace Morgan Yesterday ~ X
charts for Bob Perkins Do you have the charts for patient Bob Per
Could you please bring them to me? Tha

Grace Morgan - Yesterday - 12:18 pm

Jen McMaster Yesterday Yes, they are in my office.
Here's the |atest picture of Linda

Read - ygterday - 12:28 pm

Could you please bring the me? Thanks.

® ~ ] -

Quick Messages Priority Attach Media Responses
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The list of participants appears:
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vocera\I

Secure Messages

EAv (o}

Subject: ‘

Web Console

rﬁ Wessage Details

THE VMP WEB CONSOLE

9 Josh McNab | Logout

Grace Morgan, Je... 10:372am
charts for Bob Perkins
Jen McMaster has been added to the con.

Yesterday

Jen McMaster
Here's the latest picture of Linda

Vocera Messaging 5.3.3.2315 © 2019 Vocera

PARTICIPANTS

Add Participant

Jen McMaster
[Global] Registered Nurse

2. Click Add Participant. The Select Recipients dialog box appears.
3. Select the Favorites tab to display favorites only, or select the Contacts tab to display all contacts.

Note: Sce
favorites.

on page 252 for more information on creating

4, Select the checkboxes of the users that you want to add to the conversation:

1 Click > to add a user to the conversation.

2 Click < to remove a user that you have added to the conversation.

3 Click << to remove all users that you have added. You cannot remove users that you have not
just added.

Available Users

FAVORITES CONTACTS

Calvin Lu

[Global] Registered Nurse
Mot Available

Carol Wilson
[Global] Charge Nurse
Mot Available

[Global] Registered Nurse
Available, Off campus

Linda Davis
[Global] Respiratory Therapist
Mot Available

-®
0
@ e

-

[ ok
5. Click OK to add the selected users to the conversation.

The conversation now indicates that new people have joined.
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Selected Users

Cancel
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vocera

Secure Messages
£ v (o

Grace Morgan Yesterday
charts for Bob Perkins

Could you please bring them to me? Tha

Jen McMaster Yesterday
Here's the latest picture of Linda

®

Quick Messages

Vocera Messaging 5.3.3.2315 © 2019 Vocera

Web Console

(& Click to attach patient info

Grace Morgan - Yesterday - 12:18 pm

Yes, they are in my office.

THE VMP WEB CONSOLE

9 Josh McNab | Logout

Grace Morgan ('I \
charts for Bob Perkins .

Read - Yesterday - 12:18 pm

Do you have the charts for patient Bob Perkins?

Read - Yesterday - 12:28 pm
Could you please bring them to me? Thanks.
Read - 10:37 am

Jen McMaster has been added to the conversation

1] -
Attach Media Responses

====| Note: If a user in a message conversation is having messages forwarded to another user, that user

is automatically added to the conversation.

A quick message is a pre-defined message text that you can select and add to your conversation without
having to type any text. This enables you to quickly add frequently used or urgent messages to the

conversation.

You can use quick messages that have been defined in the VMP Administrator, or you can create them in

the VMP Web Console.

For more information on quick messages, see

For more information on creating quick messages, see

on page 162.
on page 220.

1. In a message conversation, click Quick Messages.

vocera W

Secure Messages i
v @

(@ Click to attach patient info

Grace Morgan Yesterday
charts for Bob Perkins

Could you please bring them to me? Tha...

Jen McMaster Yesterday
Here's the |atest picture of Linda

Vocera Messaging 5.3.3.2315 © 2019 Vocera

Web Console

Grace Morgan - Yesterday - 12:18 pm

Yes, they are in my office.

Priority Attach Media ~ Responses

9 Josh McNab | Logout

Grace Morgan 0
charts for Bob Perkins L.,.'

Read - Yesterday - 12:18 pm

Do you have the charts for patient Bob Perkins?

Read - Yesterday - 12:28 pm

Could you please bring them to me? Thanks.

|~ ] -

2. In the list of quick messages that appears, click the quick message that you want to use.
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Quick Messages [ Edit |

Iam on my
way.

Iam with a
patient.

No
Yes

-] = f -

Quick Messages Priority Attach Media Responses

The text of the quick message is copied into the message field.
3. Click Send to send the quick message text to your conversation.

You can create a quick message for use in message conversations. You can also edit a quick message that
you have created.

1. In a message conversation, click Quick Messages.

vocera W

) 050 Mcnab | Logout

Web Console

Grace Morgan

Secure Messages [E4 charts for Bob Perkins

£ v (o

(@ Click to attach patient info

Read - Yesterday - 12:18 pm
Grace Morgan Yesterday X X
charts for Bob Perkins Do you have the charts for patient Bob Perkins? @
Could you please bring them to me? Tha .
Grace Morgan - Yesterday - 12:18 pm
Jen McMaster Yesterday @ Yes, they are in my office.
Here's the |atest picture of Linda

Read - Yesterday - 12:28 pm

Could you please bring them to me? Thanks.

[ ] = ] -

Quick Messages Priority Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

2. In the list of quick messages that appears, click Edit.

Quick Messages [ Edit |

I am on my
way.

1 am with a
patient.

No

Yes

(-] = B -

Quick Messages Priority Attach Media Responses

A list of available quick messages appears.
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vocera\s Web Console 9 705 menab | Logout

Secure Messages [# | £ Quick Messages

I am on my way

EAv (o}

Grace Morgan 11:28 am . )
Need someone in room 203 Tam with a patient

Grace Morgan, Je... 11:07am  No
charts for Bob Perkins
Please bring them right away!

Yes

Jen McMaster Yesterday

Here's the latest picture of Linda Sorry, I am busy m

% Add Quick Message

Vocera Messaging 5.3.3.2315 © 2019 Vocera

3. To edit a quick message:
a. Click the Edit button next to the message. The Edit Quick Message dialog box appears.

Edit Quick Message

I am with a patient

‘ Save H Cancel |

b. Edit the quick message text as needed.
c. Click Save to save the changed text.

’=| Note: To delete a quick message that you have created, click Delete next to the message that

you want to delete.

4. To add a quick message:
a. Click Add Quick Message.
The Add Quick Message dialog box appears.

Add Quick Message

| Save H Cancel ‘

b. Add the new quick message text.
c. Click Save to save the new quick message.

You can specify the message conversations that are to be displayed in the Secure Messages screen.

1. Select the Message tab.
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vocern I

Contacts ES

Calvin Lu
[Global] Registered Nurse

Mot Available

Carol Wilson
a [Global] Charge Nurse
Mot Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

2. Click the Inbox icon to display the filtering options.

Secure Mess=25z5 Ed

Message Status

All Mot responded

Display Folders

[3_, Motifications

3. In the Message Status section, select whether to display all messages, messages to which you have not
responded, or messages that are unread.

4. In the Display Folders section, select Texts to display text conversations, and select Notifications to
display notifications. You can select either or both.

5. Click outside of the filtering options popup menu to hide it. The Secure Messages screen is updated to
reflect your selections.

If you do not need to save a message, you can hide it.

1. Select the Message tab.
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vocer s

Contacts ES

Calvin Lu
[Global] Registered Nurse

Mot Available

Carol Wilson
a [Global] Charge Nurse
Mot Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

2. From the list of messages in the Secure Messages pane, select the message that you want to hide.
3. Click Hide.

vocera\s Web Console 9 705 wcnab | Logau

_ ) Grace Morgan
Secure Messages J charts for Bob Perkins
v (el ¢ X ent i

H Grace Morgan Yesterday

Read - Yesterday - 12:18 pm

Do you have the charts for patient Bob Perkins?

charts for Bob Perkins
Could you please bring them to me? Tha

Here's the latest picture of Linda

Grace MorgaM Yesterday - 12:18 pm
HJen McMaster Yesterday @ Yes, they ake in my office.
Read - Yesterday - 12:28 pm

Could you please bring them to me? Thanks.

® ~ b -

Quick Messages Priority Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

4. In the Hide Conversation dialog box, click Yes to hide the message.

====| Note: The message reappears if a sender or recipient that has not hidden the message continues the
= conversation.

Your system administrator may have linked your VMP environment to an Engage environment. Two types
of Engage environment connections are supported.

* Connections to the Engage Patient Context Adapter, which enable you to add information on a patient
to a message conversation.

* Connections from Engage to the VMP SOAP interface, which send alarms sent by patients or care
providers to you as notifications.

You can respond to an alarm, view patient information, or contact the care team assigned to the patient.

====| Note: See the Engage product documentation for more details on these adapters.
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If patient information is available and no patient has been added to your conversation, you can add
patient information if you have permission to do so.

1. Select the Message tab.

vocers I

Contacts | Sites |

Calvin Lu
[Global] Registered Nurse
Not Available

Carol Wilson
[Global] Charge Nurse
Not Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

2. From the list of messages in the Secure Messages pane, select the message. The message is displayed in
the pane at the right.

vocera I Web Console 6 3050 Monab | Logout

Secure Messages | GI'B_CE Morg_an
moving a patient
v (@ 3

Sent -11:31 am
Grace Morgan Yesterday . )
moving a patient I need help moving a patient. 9

I need help moving a patient.

Jen McMaster Yesterday
Here's the latest picture of Linda

[ = ] -

Quick Messages Priority Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

3. Click the Click to attach patient info link. The Select Patient dialog box appears.
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Select Patient Sites |
[ aser v]

PATIENTS FROM Engage Server #2 (Site2)

-

Camryn , Nicolas

Room: 2 DoB: May/26/2018 (74d)
Unit: Unitl

MRM: VMP2-2

Douglas, Donald Mc

Room: Room1 DoB: May/05/1960 (58y)
Unit: Unitl

MRM: VMP2-mrml

Goldner, Michel

Room: Room1 DoB: Jul/26/2014 (4y)
Urit: Unitl
MRN: VMP2-3

Leffler, Carley

Room: Room1 DoB: Jul/26/2018 (13d)
Unit: Unit1

MRN: VMP2-1

Patient, PatientVMP2 Patient

Room: DoB: May/07/1970 (48y)
Lnit: bl
( OK ] Cancel ]

THE VMP WEB CONSOLE

If no patient information is available, this link does not appear.

4. If your facility has more than one patient site:

a. From the toggle switch at the top left of the screen, select All Patients. This displays the Sites
button, which enables you to select a current patient site.

b. Click Sites. From the popup menu that appears, select the site that you want to display.

Patients @) Garrison, Mal
PATIENTS FROM ENGAGE SERVER #1 Engage Server #1 v
Carter, Amy Cox Engage Server #2
Room: 201C
DoB: 31/Jul/1955 (B1y) Hospital ABG Server
Unit: Cardiology
MRN: 584 999 333 124 Hospital XYZ
Carter, Ronald Morgana )
Room: 202B 5t Clous Hoepital

DoB: 01/Jun/1943 (73y) ﬁ
Unit: Cardiology . .
MRN: 897 001 312 445 Ht: 6ft 2in

5. Select the patient list that you want to display. If your facility supports more than one patient site,

225

select from the following:

* My Patients - Current Site: Display the list of patients assigned to you at the site that you have
selected in the previous step.

* My Patients - All Sites: Display the list of patients assigned to you at all sites.
» All Patients: Display the list of all patients at all sites.

_J My Patients - All Sites

| Al Patients

P
Room: ROOM1111

If your facility has one patient site only, select from the following:

* My Patients: Display the

list of patients assigned to you.

» All Patients: Display the list of all patients at all sites.
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====| Note: If there are more than 100 patients in the list, not all patients are displayed. Use the
search box to search for any patient in the list, including those that are not displayed.

6. Type text in the search field to limit the patient list to patients whose name matches your search text.
7. Select the patient whose information you want to attach to this message.
8. Click OK to close the Select Patient dialog box.

The information for the selected patient is now included in the message conversation.

vocera W Web Console 6 10sn Monab | Logout

Grace Morgan
moving a patient

=pdc ® BARBARA S ADAMS - Room: CC593 - DoB: Dec/27/1945 (71)

Sent - 11:31 am

Secure Messages

Grace Morgan Yesterday _ )
moving a patient I need help moving a patient. @

I need help moving a patient.

Jen McMaster Yesterday
Here's the latest picture of Linda

(] = ] -

Quick Messages Priority Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

====1| Note: If you have added patient information to a message conversation and the conversation has

= no subject, the patient's name is displayed in the Subject field in the Secure Message panel of the
Message tab. The patient name does not become the subject of the message conversation.

If you have received a notification from the VMP SOAP interface that contains information on alarm
generated by or for a patient, you can respond to the alarm, view the information for the patient, and
contact the care team assigned to the patient.

1. In the Secure Messages screen, click the notification to view it. If necessary, scroll the screen to view
the details of the alarm.

vocera I Web Console ) s0sh menab | Logour

Secure Messages ] Notification

== From: @ Henry Thomas

Henry Thomas 11:19 am I
Aa Code Blue Subject: Aa Code Blue
CODE BLUE!!

Message: CODE BLUE!!

Sent: Sep/13/2019 - 11:19 am Delivered: Sep/13/2019 - 11:19 am
RESPONSE REQUIRED

1: Tam on my way.

2: Sorry, I am busy.

Vocera Messaging 5.3.3.2315 © 2019 Vocera
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If the alarm has a priority of High or Urgent, an icon appears next to the Subject line.
2. In the Response Required section of the notification, select one of the responses that have been made
available to you.
3. Tap the link for the patient to display patient information and contact the care team. See
on page 227 and on page 228 for more details.

If you have added patient information to a message conversation, or you have received a notification
containing patient information, you can view it.

1. In the Secure Messages screen, click the message or the notification containing the patient information.
2. In the link to the patient information, click the View Details button.

vocera\s Web Console 9 705 wcnab | Logout

Grace Morgan

Secure Messages [ hide | TR i

View Details

cav (@l (@ BARBARA S ADAMS - Room: CC593 - DoB: Dec/27/1945 (71)

Sent - 11:31 am

Grace Morgan Yesterday . :
moving a patient I need help moving a patient. @

I need help moving a patient.

Jen McMaster Yesterday
Here's the latest picture of Linda

® * 0 -

Quick Messages Priority Attach Media Responses

Vocera Messaging 5.3.3.2315 © 2019 Vocera

The patient information screen appears.

vocera W Web Console ) 105 Mcnia | Logaut

Secure Messages & BARBARA S ADAMS - Room: CC593 - DoB: Dec/27/1945 (71)
£ v (o Patient Info

Care Team

MRN No: 1234564020180919
Yesterday -
Emge; I::g:rgan Gender: Female @ Ace Cline
I need help moving a patient. Admit Date: 2012-12-08T21:10:00.000-
05:00
Disch Date: Calvin Lu
Jen McMaster ~ vesterday A‘dsrcnif;\gezsoi:e @ [(Global] Registered Nurse >
Here's the latest picture of Linda Patient Status: Admitted Not Available

Carol Wilson
[Global] Charge Nurse >
Not Available

Grace Morgan
[Global] Patient Care Techni... bhs
Available, Off campus

Jen McMaster
[Global] Registered Nurse bhs
Not Available

Text Care Team >

Vocera Messaging 5.3.3.2315 © 2019 Vocera

This screen contains two panes:

* The Patient Info pane, which contains details on the linked patient.

* The Care Team pane, which contains links to contact information for care team members.
3. Click Close to hide the patient information.
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If you have added patient information to a message conversation, or you have received a notification
containing patient information, you can view and contact the care team assigned to this patient.

1. In the Secure Messages screen, click the message or the notification containing the patient information.
2. In the link to the patient information, click the View Details button.

228

vocera\

Grace Morgan Yesterday
moving a patient
I need help moving a patient.

Jen McMaster Yesterday
Here's the latest picture of Linda

Vocera Messaging 5.3.3.2315 © 2019 Vocera

Secure Messages # \ Hide \
v (o

Quick Messages

Web Console

(& BARBARA S ADAMS - Room: CC593 - DoB: Dec/27/1945 (71)

[ ] |~ ] -

Priority Attach Media

Grace Morgan
moving a patient

Responses

ﬁ Josh McNab | Logout

Sent - 11:31 am
I need help moving a patient.

View Details

The patient information screen appears, including the Care Team pane, which displays a list of care
team members in a scrollable window.

vocers I

Secure Messages #

A v (e

Web Console

Patient Info

Grace Morgan
moving a patient
1 need help moving a patient.

Yesterday

Jen McMaster Yesterday
Here's the latest picture of Linda

Vocera Messaging 5.3.3.2315 @ 2019 Vocera

MRN No: 1234564020180919

Gender: Female

Admit Date: 2012-12-08T21:10:00.000-
05:00

Discharge Date:

Admit Reason:

Patient Status: Admitted

'gi‘ BARBARA S ADAMS - Room: CC593 - DoB: Dec/27/1945 (71)

Care Team

@ Ace Cline
®

Calvin Lu
[Global] Registered Nurse
Not Available

Carol Wilson
[Global] Charge Nurse
Not Available

Grace Morgan
[Global] Patient Care Techni...
Available, Off campus

Jen McMaster
[Global] Registered Nurse
Not Available

Text Care Team

9 Josh McNab | Logout

>

>

b4

This list of care team members can contain users from either or both of two sources:
* VMP Web Console or VCS users
* Users obtained from the Engage Patient Context Adapter
Users obtained from the Engage Patient Context Adapter cannot be contacted from VMP Web Console.

information for that user. See

contact information.

. In the list of care team members, click on any VMP Web Console or VCS user to display contact

on page 250 for more details on this

To send a message to all care team members who are VMP Web Console or VCS users, click the Text
Care Team link at the bottom of the screen.
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The Text Care Team link does not appear if the care team does not include any VMP Web Console or
VCS users.

5. Click Close to hide the patient information.

When you are logged into the VMP Web Console, you will see a system notification whenever you receive
a new message if you are using a browser that supports this.

This ensures that you receive notice of new messages when your browser is in the background on your
screen or if you are viewing another browser tab.

Vocera message from Josh McNab X
You are needed in room 203,
ry
et d
via 1921662113 el

When you click on the notification, the new message is displayed in the VMP Web Console.
This capability is supported on the following browsers:

* Microsoft Edge

* Mozilla Firefox

* Safari

* Google Chrome (for URLs that start with https: or localhost: only)

On Google Chrome, you will hear a tone whenever you receive a system notification for a new message.

If you have linked your VMP Server to an Engage environment, the Patients view lists all current patients.

1. To access a list of current patients, select the Patients view.

vocera

Secure Messages #

The list of patients appears.
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Patients

Ismael Q. Abel
Room: 7063 DoB: Jan/09/1954
Unit: HATH 07PP

MRN: IsmaelAbel 19540109

GABRIEL ACUNA

Room: CC473 DoB: Jun/14/1984
Unit: FACILITY CARDIO

MRN: 12345640202275565

Vocera Messaging 5.3.3.2315 © 2019 Vocera

Web Console

Patient Info
Name: GABRIEL ACUNA
Room: CC473

DoB: Jun/14/1984 (33y)
MRN No: 12345640202275565
Gender: Male

Patient Status: Admitted
Admit Reason:

Discharge Date:

Admit date: 2012-12-08T17:55:00.000-
05:00

2. If your facility has more than one patient site:

a. From the toggle switch at the top left of the screen, select All Patients. This displays the Sites
button, which enables you to select a current patient site.

b. Click Sites. From the popup menu that appears, select the site that you want to display.

Patients

Room: 202B

PATIENTS FROM ENGAGE SERVER #1 Engage Server #1 v
Carter, Amy Cox Engage Server #2

Room: 201C

DoB: 31/Jul/1955 (61y) Hospital ABC Server

Unit: Cardiology

MRN: 584 999 333 124 Hospital XYZ

Carter, Ronald Morgana 1 Claus Hosptal

DoB: 01/Jun/1943 (73y) ﬁ
Unit: Cardiology . .
MRN: 897 001 312 445 Ht: 6 ft 2in

THE VMP WEB CONSOLE

9 Josh McNab | Logout

Care Team

@ Ace Cline

Calvin Lu
[Global] Registered Nurse >

Not Available

Carol Wilson
[Global] Charge Nurse >
Not Available

Grace Morgan
[Global] Patient Care Techni... >
Available, Off campus

Jen McMaster
[Global] Registered Nurse >
Not Available

Text Care Team >

3. Select the patient list that you want to display. If your facility supports more than one patient site,
select from the following:

* My Patients - Current Site: Display the list of patients assigned to you at the site that you have

selected in the previous step.
* My Patients - All Sites: Display the list of patients assigned to you at all sites.
* All Patients: Display the list of all patients at all sites.
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vocerna\
Patients
[y parieens v | G
—

Select Patwnts

" My Patients - Current Site

B My Patients - All Sites
R Al patients
AD

P
Room: ROOM1111

= Roo

DoB

If your facility has one patient site only, select from the following:
* My Patients: Display the list of patients assigned to you.
* All Patients: Display the list of all patients at all sites.
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====| Note: If there are more than 100 patients in the list, not all patients are displayed. Use the
search box to search for any patient in the list, including those that are not displayed.

4. Select the patient for which you want to display information.
The patient information consists of two panes:
* The Patient Info pane, which contains details on the linked patient.
* The Care Team pane, which contains links to contact information for care team members.

5. In the list of care team members, click on any VMP or VCS user to display contact information for that
user. See Using Web Console Contacts on page 250 for more details on this contact information.

6. To send a message to all care team members who are VMP or VCS users, click the Text Care Team link
at the bottom of the screen.
The Text Care Team link does not appear if the care team does not include any VMP or VCS users.

About User Permissions

As an administrator, you can provide user permissions for access to the VMP Web Console, for creating
and managing schedules, and for Messages sent by other users.

Granting Existing Users Access to the VMP Web Console

You can grant access to any user at any time by editing the user or contact record.

1. Start the VMP Administrator:
All Programs > VMP Administrator
2. Select Users & Groups > Users.

3. Click to highlight the desired user, and click the Edit icon.

The End-User Settings window appears.
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4, Click to select Enable Web Console Access.

New User

Step 1: End-User Settings

Step 1: End-User Settings
Step 2: Push Technology and Licensing

First Name: ‘Jush

Middle Name ‘

Last Name ‘ McMab

Tle: \

Email:

Public: 1D

Pager ID:

Vocera ID:

Home Site:: ‘

Auto Forwarding
Allow Forwarding: | Follow System Settings (Yes)

Forward To ‘

Profile:

Desktop and Web Access
[ Enable PC Admin Console Access

I Enable Web Consale Access I

Vocera credentials

Login: ‘

Password: ‘

Corffimation: ‘

Next >

5. Provide the authentication credentials, and click Next.
6. Click Next and click Finish to save the edited account and complete the task.

THE VMP WEB CONSOLE

====| Note: You can grant VMP Web Console access to multiple users at once when importing users and

contacts. See

on page 60 for more details.

You can grant permissions to enable a user to create and manage schedules in the VMP Web Console. You

can also grant permission to a user to view schedules in all on-call distribution lists.

1. Start the VMP Administrator:
All Programs > VMP Administrator
2. Select Users & Groups > Users.

3. In the Users pane, click the name of the user for which user rights are to be edited.
4. In the toolbar, from the User preferences dropdown list, select User rights.
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5. In the Right Groups pane, select Custom permissions.

QPO D@ 2% Total: 10 | ®

Nome | & Userrights | Devics ID Emai PubicD A
3 b Unlock user clu@dill local

Carol Wils( & Applications on device local

Default & Plugins configuration

. .

(Grace Mot & Retrieve Application Logs gmorgan@aillocal

Jen McMaster |imcmaster imemaster @il local

Josh McNab menab i ol .

!

< >

Member of Content Distribution Lists  View Sent By - Text Messages  View Received By - Text Messages  Messaging Templates
OO ®
Name: -+ Patient Data Access Site
» No [ |

The Edit Rights dialog box appears.

Edit Rights X

Allow o Paging AP| G

Assign documernts to devices

System manager Manage contact sources

Users manager

Manage distribution lists

[ Contacts managsr O
[ | Content manager [ Change system settings
[ | Distribution lists manager [ | Create/zdit /delete VMP users
[1| Groups manager [1| Defautt email intiation user
[1| Own group manager [1| Manage all documerts
[ | Paging API Gateway [ | Manage all groups
[ Reports viewsr [ | Manage all schedules
[ | Superuser [ | Manage contact distribution lists
O O
| |
O

Manage groups user belongs to A

[ok | camesl || Hep

THE VMP WEB CONSOLE

6. In the Edit Rights dialog box, select the Manage schedules checkbox to allow this user to create

233

schedules and to edit the schedules that he or she has created.

Edit Rights *

» [] | Manage all schedules [l
[1| Contacts manager [1| Manage contact distribution lists
[ | Content manager [] | Manage contact sources
[ | Distribution lists manager [ | Manage distibution lists
[ | Groups manager [ | Manage groups user belongs ta
[ | Own group manager » [l Manage schedules
[ | Paging API Gateway [ | Manage who views VMP text messages
[1| Reports wiewer 1| View all distribution lists
[1| Superuser [1| View all messaging templates
[ | System manager [ | View all pager alerts in the report
[ | Users manager [ | view all reports
[ | View all schedules v
Rt Descrpton

[ok ]| camesl | Hep

on page 123 for more details.

=== Note: If Manage schedules has already been selected and cannot be changed, this user has
already been granted the right to manage schedules as part of a Right Group. See
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7. In the Edit Rights dialog box, select the Manage all schedules checkbox to allow this user to edit all
schedules that anyone has created.

8. In the Edit Rights dialog box, select the View all schedules checkbox to allow this user to view all
schedules, including those for distribution lists to which the user does not belong.

9. Click OK to finish editing user rights.

====| Note: The default administrator always has permission to access schedules. At least one user must
= be given permission to manage schedules.

You can give one or more users the ability to view messages sent by or received by other users. This
enables access to the Monitor View in the VMP Web Console.

1. Start the VMP Administrator:
All Programs > VMP Administrator
2. Select Users & Groups > Users.

3. Highlight the users to which you want to grant permission to view sent messages, and click the View
Sent By - Text Messages tab at the bottom of the user list.

0 Users =
QPO @ 2% Total: 10 | ®
Name 4 Login Device ID Email Public ID ~
» clu clu@dtill local
Carol Wilson cwilson cwilson @dtill local
Default administrator admin
Grace Morgan gmorgan amorgan@dtill local
Jen McMaster jmcmaster imcmaster@dtill local
Josh McMab jmcnab jmcnab@dtill local w
< >
Member of Content Distribution Lists I\u'lew Sent By - Text Messages IVlew Received By - Text Messages  Messaging Templates
[F] »
Name -
4. Click Add.
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.-‘_I, Users

(== e

Login Device 1D

clu
Carol Wilson

cwilson
D elault administatg admin
Grace Morgan gmorgan
jmcmaster

jmenab

Total: 10 | ®
Email Public 1D Ll
clu@dtill local

cwilson@dtill local

gmorgan@dtil local
jmemaster@dtill local
jmenab @dtill local

THE VMP WEB CONSOLE

>

w

5. Highlight the users and groups whose sent messages can be viewed, and click OK.

Select Users/Groups X

Name ~
b

/s Engage Group

/is Everyone_Global

LT

/4s» Management

s Securily

-, Calvin Lu

- CarolWilson

~ Grace Morgan W

Concel ||t

6. Highlight the users to which you want to grant permission to view received messages, and click the
View Received By - Text Messages tab at the bottom of the user list.
7. Click Add.

8. Highlight the users and groups whose received messages can be viewed, and click OK.

You can use the VMP Web Console to specify on-call status and create schedules.

If On-Call Scheduling has been provided with the VMP Server, you can use the On-Call view to update
your own on-call status or the on-call status of other users.

You can also use the Schedules view to create schedules based on On-Call Distribution Lists (DLs). See

on page 152 for more information about creating On-Call
DLs.

Schedules can be copied from existing schedules, can be drafted and remain unpublished, and can be
published at any time.

You can view schedules by:
* Day

* Week

* Month

* Shifts

For information on how to grant users the right to change their own status, see
on page 152.
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For information on how to grant users the permission to manage schedules, see

=

on page 232.

On-Call Scheduling field.

Note: To determine whether On-Call Scheduling has been provided, start the VMP Enterprise
Manager, select Instances, and click your license key. In the Modules pane, check the value of the

You can change your on-call status in any schedule that includes you.

1. Open the VMP Web Console from your Web browser.
2.

236

Click On-Call.

vocera I

Grace Morgan
Need someone in room 2

. 11:07 am

Please bri em right away!

McMaster Yesterday
ere’s the latest picture of Linda

This icon appears only if you have access to On-Call Distribution Lists.
3. In the On-Call Lists pane, click My Status. A list of the Distribution Lists to which you belong is

displayed, along with your on-call status for each.

vocera Web Console

On-Call
_ @ Josh McNab's On-Call Status
| My Status | [on:Camm On-Call Doctors

[On-Call] On-Call D...

Regular Distribution List

Vocera Messaging 5.3.3.2315 © 2019 Vocera

9 Josh McNab | Logout
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4. For the Distribution List for which you want to change your on-call status, click your current status. A

list

vocera Il

5. Change your status to one of the following:
* On-Call - Receive messages sent to the list.

of options appears.

m @ Josh McNab's On-Call Status

On-Call] On-Call Doctors
My Status Eistribuliun Eis&

[On-Call] On-Call D...

Regular Distribution List

Vocera Messaging 5.3.3.2315 © 2019 Vocera

Web Console

9 Josh McNab | Logout

Select On-Call Status

on-call
Monitor

Not On-Call

v

* Monitor - Receive message sent to the list, but a response is not expected even when a message
requires one.

* Not On-Call - Do not receive messages sent to the list.

You can modify the on-call status of any user in a Distribution List.

1. Open the VMP Web Console from your Web browser.

Tip: Select Monitor to receive messages sent to the list without the expectation of a response or
action for the message. A shift manager might find it useful to monitor the shift and ensure that

messages are handled appropriately.

2. Click On-Call.
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vocera\\Il

Secure Messages

Grace Morgan 11:28 am

MNeed someone in room 2

. 11:07 am

Please bri em right away!

McMaster Yesterday
ere's the latest picture of Linda
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This icon appears only if you have access to On-Call Distribution Lists.

3. In the On-Call Lists pane, click the Distribution List that you want to update. A list of users is
displayed, along with their on-call status.

\/OC@(@‘ / Web Console ) J0sh McNab | Lagout

M) [On-Call] On-Call Doctors
Q
Calvin Lu
My Status (Giobal Regitered Nurse
S Not Available
Carol Wilson
ron-calt] on-Cail D... | (@) (Gl charse urce
Regular Distribution List Not Available
Grace Morgan
(Sl Pliontare Tochican
Available, Off campus
Jen McMaster
Not Available
Josh McNab
[Global] Hospitalist
S3/ Available, Off campus
7%, Linda Davis
Not Available
. Charsn Dhanad

Vocera Messaging 5.3.3.2315 © 2019 Vocera

4. For the user whose on-call status you want to change, click the user's current status. A list of options
appears.

vocera W Web Console ) 205 moab | Logout

m gl -Call] On-Call Doctors

My Status

Calvin Lu
(Clobal] nepstered nurse

Not Available

Carol Wilson
(o) Charge urse

[On-call] on-call D...

Regular Distribution List Not Available

Select On-Call Status

Grace Morgan
@ [Global] Patient Care Technician on-Call 3

Mot Available Menitor

Not On-Call v

v
Josh McNab
[Globa Hospialis

Available, Off campus

Jen McMaster
[Global] Registered Nurse
Available, Off campus

4% Linda Davis
i@- [Global] Respiratory Therapist @ totoncall v |
s

Vocera Messaging 5.3.3.2215 © 2019 Vocera

. Change the user's status to one of the following:

* On-Call - Receive messages sent to the list.

* Monitor - Receive messages sent to the list, but a response is not expected even when a message
requires one.

* Not On-Call - Do not receive messages sent to the list.
====1| Note: At least one user in the Distribution List must have a status of On-Call at all times.

If you do not want to update a user's on-call status, tap the list name at the top left of the screen to
return to the list of users.

. Repeat the above step until all users have had their on-call status changed as needed.

A logged in user can use the VMP Web Console to create an on-call schedule if you have used the VMP
Administrator to grant permission to do so.
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Note: For details on granting scheduling permissions, see

on page 232.

1. Open the VMP Web Console in your Web browser.

2. Click Schedule.

race Morgan 11:28 am
Need someone in room 203.

Grace Morgan, Je... 11:07am
charts for Bob Perkins
Please bring them right away!

Jen McMaster Yesterday
O Bob Perkins
Here's the latest picture of Linda

The list of schedules appears.

vocers W

On-Call Schedule
Actions |Schedule Name A

# X On-Call Doctors

# X Walk-In Clinic Doctors

Vocera Messaging 5.3.3.2315 © 2019 Vocera

3. Click New Schedule.

Web Console

THE VMP WEB CONSOLE

D Default administrator | Logout

[On-Call] On-Call Doctors

[On-Call] Walk-In Clinic Doctors

|[ Dashboard

Note: If you do not have permission to create on-call schedules, the New Schedule button is

not available.

4. Enter a meaningful Schedule Name.
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New Schedule

Schedule Name: \ \

Schedule Distribution List: | [0n-Call] Walk-In Clinic Docters ]|

Schedule Start Date: l ‘

Time Zone: | (UTC-05:00) Eastern Time (US & Canada) jl Daylight saving

Minimum # of On-Call Users per Shift: | 1 ‘ Enable Automatic Validation

5. Use the Schedule Distribution List dropdown list to select the On-Call Distribution List (DL) for the
schedule.

6. Click in the Schedule Start Date field to open the calendar picker and select the start date.

@  oOcober2019

Su Mo Tu We Th Fr Sa

I8 s Calis

6| 7/ 8

7. If needed, use the Time Zone dropdown list to select the appropriate time zone, or select the Daylight
saving checkbox.

8. In the Minimum # of On-Call Users per Shift field, enter the minimum number of users that are to
be specified as on-call in each shift.

9. Select the Enable Automatic Validation checkbox if the VMP Server is to perform automatic
validation of this schedule to ensure that all shifts have enough on-call users.

10If you want to copy the shifts for the new schedule from an existing schedule, click to activate the
Copy shifts from an existing Schedule checkbox, and select the schedule from the dropdown list.

Copy shifts from an existing Schedule

Copy shifts from: | on-call Doctors ﬂ\

11.Use the Permissions pane to select Users/Groups with permission to view or manage the schedule.
Click to activate the checkbox next to the desired user or group and click > to select.

PERMISSIONS

Available Users/Groups Selected Users/Groups

Manage

@ Calvin Lu o Default administrator .

12 Click OK to continue.
13.Click the name of the schedule to continue editing it.
14 Select a time period for which to schedule shifts:
* Select Day to schedule shifts for a specific day.
* Select Week to schedule shifts for a specific week.
* Select Month to schedule shifts for a specific month.
15.Use the arrow buttons or the calendar picker to select a date or date range for which to schedule shifts.
In the Day view, select a date:
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\/OC@(@\ Web Console ) 10sh McNab | Logout

< October 2019 « 2 October 2019/,

Wednesday, 2
12:00 am - 8:00 am

ICarol Wilson

Calvin Lu
[Global] Registered Nurse
Not Available
@ not on-call

Carol Wilson
[Global] Charge Nurse
Not Available
@ not on-call

Grace Morgan
@ [Global] Patient Care Techni...
Not Available
on-call

Vocera Messaging 5.3.2.2215 © 2019 Vocera

In the Week view, select a week:

vocera W\ Web Console

< October 2019 «29 - 5 October 2019,

N\,

Sun, 29

CH [
Calvin Lu

[Global] Registered Nurse
Not Available

@ not on-call

Carol Wilson
[Global] Charge Nurse
Not Available

@ not on-call

Grace Morgan

@ [Global] Patient Care Techni...
Not Available

@ on-call

« October 2019 ,

+40 am - Pacific Daylight Time.

Calvin Lu
[Global] Registered Nurse
Not Available

@ not on-call
Carol Wilson
@ [Global] Charge Nurse

Not Available
@ not on-Call

Grace Morgan

@ [Global] Patient Care Techni...
Not Available
® on-call - _“_““

Vocera Messaging 5.3.3.2315 © 2019 Vocera HELP

Oct 5

16.To assign a shift to a user:

a. Drag the user's name to the time slot that is to be the start of the shift. The Shift Period dialog box
appears.
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Shift Period
co: P OGO 000 0@
Start

Time:
End Time: Feb 25 v |/0Zam ¥ |00 ¥

Feb 25 v |/0lam ¥ |00 ¥

o

. If you want to use color coding to distinguish between different types of shifts, use the Color option
to select the color in which this shift is to be displayed in the schedule. This is useful if you have a
number of roles that need to be filled for each shift, as you can use a different color to represent each
role.

In the Start Time dropdown lists, select the date and time of the start of the user's shift.

In the End Time dropdown lists, select the date and time of the end of the user's shift.

. Click OK to add the shift, or click Cancel to cancel.

Tip: To change the times for a user's shift, drag the shift assignment to the desired time slot. Drag
the bottom of the shift assignment to increase the number of assigned hours.

® a0

17 Repeat the above step to add users to the schedule as appropriate. You can schedule more than one user
in any time slot.

18.When you have finished creating the shift assignments, click Repeat to copy these assignments to
other days of the month:

Repeat Day

Repeat

[ Every Sunday

Wl Every Monday

Wl Every Tuesday

Wl Every wednesday

Wl Every Thursday

Wl Every Friday

[ Every saturday

Repeat from | | to

Use the checkboxes to specify the days of the week on which these shifts are to be assigned.

. Click in the Repeat from field to specify the start of the date range in which these shifts are to be
assigned.

c. Click in the to field to specify the end of the date range.
d. Click OK.
19.Click Day, Week, or Month to view the shift assignments for a specific day, week, or month. To view
the shift assignments for a specific user, click Shifts and then click the user's name.
In the Week or Month view, you can copy shift assignments from one day to another:

a. Locate the day of the month whose shift assignments you want to copy. Click on the heading for that
day of the month to highlight it.

o o

Sun, 29 Mon, 30 Tue, 1

b. Click Copy.
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c. Locate the day of the month to which you want to copy the shift assignments. click the heading for
that day of the month to highlight it.
d. Click Paste. The shift assignments are copied to the specified day.
20.To ensure that all shifts have enough on-call users, click Validate. This checks all days for which shifts
are scheduled, up to the (possibly partial) last day. A pop-up dialog appears that either lists the shifts
for which not enough on-call users are defined or indicates that the schedule is valid.
21.When the schedule is complete, click the back arrow to return to the Schedule list.

vocerna I

(O §< October 2019

Resources

AtoZ v| (o} 12:00 am - 7:00 am

Grace Morgan
Calvin Lu
[Global] Registered Nurse
Not Available

@ ot on-call

Carol Wilson
[Global] Charge Nurse
Not Available

@ not on-call

22 Select the Published checkbox to publish the schedule.

A user that is a member of an on-call distribution list can view the on-call schedules that have been
created for the list. Other logged-in users can view on-call schedules for a distribution list to which they
do not belong if you have granted this permission as administrator.

====| Note: For details on granting scheduling permissions, see
== on page 232.

1. Open the VMP Web Console in your Web browser.
2. Click Schedule.

243 VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



THE VMP WEB CONSOLE

race Morgan 11:28 am
Need someone in room 203.

Grace Morgan, Je... 11:07am
charts for Bob Perkins
Please bring them right away!

Jen McMaster Yesterday
O Bob Perkins
Here's the latest picture of Linda

The list of schedules appears.

vocera Web Console 5 Jen Mcmaster | Logout

On-Call Schedule
Actions [Schedule Name A Published ® |Distribution List Associated ®

October 2019 [On-Call] On-Call Doctors

Vocera Messaging 5.3.3.2315 @ 2019 Vocera

If no edit icons appear in the Actions column, the schedule is read-only: you can view it, but not edit it.
3. To sort the schedule names, click the triangle icon next to Schedule Name.

0On-Call Schedule

Actions |Schedule Name A Published e |Distribution List Associated ®

4. To search for a schedule, type the search text in the field provided.

On-Call Schedule

Actions |Schedule Name A Published e |Distribution List Associated ®

5. To view a schedule, click its name. The schedule appears.
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vocera\ Web Console £3) en MeMaster | Logout

« 1 October 2019 ,

12:18 pm - Pacific Daylight Time

Calvin Lu

[Global] Registered Nurse
Not Available

@ not on-Call

Carol Wilson
[Global] Charge Nurse
Not Available

@ rot on-call

Grace Morgan
[Global] Patient Care Techni...
Not Available

On-Call

7:00 am - 11:00 am

== Jen McMaster

Vocera Messaging 5.3.3.2315 © 2019 Vocera

If the schedule is read-only, this information is displayed next to the name of the schedule.

6. Click Day, Week, or Month to view the shift assignments for a specific day, week, or month. To view
the shift assignments for a specific user, click Shifts and then click the user's name.

From the VMP Web Console, you can view the Schedule Dashboard, which lists any or all the schedules
that you have created and who has been assigned shifts in these schedules for any specific day.

1. Open the VMP Web Console in your Web browser.
2. Click Schedule.

race Morgan
Need someone in room 203.

Grace Morgan, Je... 11:07am
charts for Bob Perkins
Please bring them right away!

Jen McMaster Yesterday
O Bob Perkins
Here's the latest picture of Linda

3. Click Dashboard.
4, Click Select Schedules.

5. To select a schedule, go to the Available Schedules pane, select the checkbox next to the schedule,
and click >. To unselect a schedule, go to the Selected Schedules pane, clear the checkbox next to the
schedule, and click <.
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Select DL's/Users

Drag and drop to sort

=

Do On-Call Doctors =

Do Walk-In Clinic Doctors

[ [s]¢ |[ Cancel |

You can select a maximum of 20 schedules.
6. To change the order in which the schedules are to be displayed, drag and drop the schedules in the
Selected Schedules pane as needed.

7. Click OK. The Schedule Dashboard now displays the schedules that you have selected. For each
schedule, the shifts assigned for the current date are displayed.

< Schedules Dashboard <1 October » o2
e

_In Clini :
0On-Call Doctors Vel Cinfe
Doctors
12:00 am - 3100 pm 2100 arm - 6:00 3
EZELU Grace Morgan Jen McMaster

Carol Wilson

8. To view the shifts for a different date, select the date from the calendar at the top right of the Schedule
Dashboard, or use the arrow icons to navigate to the date that you want to display.

< Schedules Dashboard <1 October »

On-Call Doctors

00 am - 3:00 pm
ace Morgan

< ©chedules Dashboard 0 ocbwmis ©

Select Schedulcs . 2 s[4ls

On-Call Doctors

00 am - 3:00 pm
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You can print a schedule that you are editing. The portion of the schedule that is printed is identical to
the portion that you are viewing. For example, if you are viewing the schedule for the current week, the
printed schedule is for that week.

1. Open the VMP Web Console in your Web browser.
2.

o ok w

Click Schedule.

vocera\sI ‘

Secure Messages

race Morgan 11:28 am
Need someone in reom 203.

Grace Morgan, Je... 11:07am
charts for Bob Perkins
Please bring them right away!

Jen McMaster Yesterday
O Bob Perkins
Here's the latest picture of Linda

Click the name of the schedule to display.

Click one of Day, Week, or Month to display the schedule for that time period.
Click Print. A print window appears that displays the schedule to be printed.
In the print window, click Print. This displays the Windows print command window. From this

window, select the desired printer and options.

After you have created a schedule, you can edit any shift to add or delete people to it. You can also change

the color in which the shift is displayed.

1. Open the VMP Web Console in your Web browser.
2.
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Click Schedule.
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race Morgan 11:28 am
Need someone in room 203.

Grace Morgan, Je... 11:07am
charts for Bob Perkins
Please bring them right away!

Jen McMaster Yesterday
O Bob Perkins
Here's the latest picture of Linda

The list of schedules appears.

vocers W

Web Console

On-Call Schedule

Actions |Schedule Name A Published
# X On-Call Doctors

# X Walk-In Clinic Doctors [ ]

Vocera Messaging 5.3.3.2315 © 2019 Vocera

3. Click on a schedule to display it.

D Default administrator | Logout

O | v Schedule | [ Dashboara

e | Distribution List Associated e

[On-Call] On-Call Doctors

[On-Call] Walk-In Clinic Doctors

THE VMP WEB CONSOLE

4. Double-click the shift that you want to edit. The Shift Assignment dialog box appears.

«o: P00 00000

Available Users

Selected Users
Q

Q
Calvin Lu Carol Wilson
o [Global] Registered Nurse a [Global] Charge Nurse
Not Available Not Available

Grace Morgan
[Global] Patient Care Technician
Not Available

Josh McNab
[Global] Hospitalist
Available, Off campus

@
Jen McMaster

a [Global] Registered Nurse
Available, Off campus

( 0K H Cancel
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5. To add a person to a shift, in the Available Users column, select the checkbox next to the user that you
want to add and click >.

6. To remove a person from a shift, in the Selected Users column, select the checkbox next to the user
that you want to delete and click <.

7. To change the color in which the shift is displayed in the schedule, select a color from the options
available.

8. Click OK to save your changes to the shift.

After you have created a schedule, you can contact a person who has been assigned to a shift in that
schedule.

1. Open the VMP Web Console in your Web browser.
2. Click Schedule.

race Morgan 11:28 am
Need someone in room 203.

Grace Morgan, Je... 11:07am
charts for Bob Perkins
Please bring them right away!

Jen McMaster Yesterday
O Bob Perkins
Here's the latest picture of Linda

The list of schedules appears.

\/Ocera‘ s Web Console D Default administrator | Logout

On-Call Schedule O | r:cv Schedule | [ Dashboard

Actions |Schedule Name A Published e |Distribution List Associated e

#" X On-Call Doctors [On-cCall] On-Call Doctors

# > Walk-In Clinic Doctors [On-Call] walk-In Clinic Doctors

Vocera Messaging 5.3.3.2315 © 2019 Vocera

3. Click on a schedule to display it.
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4. Click on the name of a person who has a shift in the schedule. A list of contact options appears for that
person.

vocera s Web Console

< October 2019 « 3 October 2019,

Resources
[Atoz ¥| Q 12:00 am - 9:00 am
‘l ‘ ¥ = BN Carol Wilson

% Calvin Lu

= [Global] Registered Nurse
Mot Available
. Mot On-Call

5. Select the contact option that you want to use, and follow the instructions for that option to contact the
person.

The Web Console Contacts view shows all contacts the logged in user is allowed to access.

====| Note: Contact access is defined in the VMP Administrator. For details about defining contacts
distribution lists, see on page 136.

Use the Contacts view to initiate a communication with a contact.

The Email option is available only for users, and is available only if the VMP Server administrator has
allowed email communication. Only messages can be sent to group contacts.

1. Log on to the VMP Web Console from your Web browser.
2. Click Contacts to display the Contacts view.

vocera\\s

Seci' e Messages #

Gface Morgan 12:28 pm
harts for Bob Perkins
Could you please bring them to me? Tha...

O Jen McMaster 12:07 pm
il Hers's the latest picture of Linda

3. Toggle between Favorites or Contacts at the top of the Contacts pane.
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vocera I

“rcitacts ES
| Contacts ¥

Calvin Lu
[Global] Registered Nurse
Not Available

Carol Wilson
[Global] Charge Nurse
Not Available

Grace Morgan
[Global] Patient Care Techni...

Available, Off campus

Tip: Start typing the contact name in the search box to quickly find a user, group, or Distribution
List. For details on using Favorites, see on page 252,

Select a contact to display it:

vocera Web Console ) 205 monab | Logous

o 3 Jen McMaster
"Cnnta:tgv“ _ ‘ [Global] Registered Nurse

Available, Off campus

@ O e

Call Urgent Call Text
g Everyone_Global
[Global] Regular Distributio... (CONTACT{DETATLS

Site:
Calvin Lu Global
[Global] Registered Nurse
Not Available

[On-call] on-call ...
On-Call Distribution List

Job Title:
Registered Nurse

Carol Wilson Name:
[Global] Charge Nurse
Not Available Jen McMaster

Grace Morgan
[Global] Patient Care Techni...

Not Available

Jen McMaster
[Global] Registered Nurse .
I

Vocera Messaging 5.3.3.2315 © 2019 Vocera

251

Click Close to close this window:.

. If a contact is a Vocera Voice Group, the group may contain subgroups. Click the subgroup you want to

view. When viewing a subgroup, click the Back arrow to return to the parent Voice Group.

. When you have found the contact, select Call, Urgent Call, or Text to communicate with the contact.

If the contact is a Voice Group or Distribution List, you can send a Broadcast or Urgent Broadcast to
all members of the group or Distribution List.

=== Note: The Call, Urgent Call, Broadcast, and Urgent Broadcast operations are initiated on
your client application (VCS client or Vocera badge).
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Vocera categorizes contacts as individual users, Voice Groups, and Distribution Lists.

For each user, a colored ring around the user's photo or initials indicates the user's presence and
availability:

* Green indicates that the user is available.

* Orange indicates that the user is in Do Not Disturb mode for calls, messages, or both.

* Red indicates that the user is not available.

For all contacts, the site that the contact belongs to is enclosed in square brackets:

* If Vocera Secure Texting users are included in the list of contacts, the site for each Vocera Secure
Texting user is the organization to which that user belongs.

* If you have not created any sites, all contacts other than Vocera Secure Texting users have the site
name [Globall.

For each user, details on the user's current status are provided below the contact's name, site, and title.
These include the following:

* The contact's availability status, corresponding to the colored ring around the user's photo or initials.
This is one of Available, Do Not Disturb, or Not Available. For Do Not Disturb, the current status
indicates whether calls, messages, or both or are not being let through.

* Messages Forwarding indicates that messages to this contact are being forwarded to another contact.

* Off Campus indicates that the contact is available but is not on the corporate network. An example of
this is when the contact is logged into the VMP Web Console.

Vocera Secure Texting users are listed as Available and Off Campus.

Voice Groups and Distribution Lists are indicated with a multi-person icon.

vocera s

M tatus

0 [On-cCall] On-cCall D...

Regular Distribution List

For each user in a Voice Group or a Distribution List, a photo of the user and the availability status are
displayed. If the user has no photo, the user's initials are displayed.

In the VMP Web Console, you can specify a list of Favorite contacts that you communicate with
frequently.

To display the list of Favorites, select Favorites at the top of the Contacts pane.
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@ [Global] Patient Care Technician
Mot Available

You can add a contact to the list of Favorites.

THE VMP WEB CONSOLE

This lets you quickly determine if the Favorite is logged in to the Vocera system. See

@ Note: If a Favorite is a Vocera user, the contact status for the user is displayed in the Favorites list.

on page 252 for more information on contact status.

1. Click Contacts to display the Contacts view.

vocera I

Secr e Messages

harts for Bob Perkins

Here's the latest picture of Linda

Gface Morgan 12:28 pm

Could you please bring them to me? Tha...

O Jen McMaster 12:07 pm

2. Select Contacts at the top of the Contacts pane to display all contacts.

3. Select a contact from the displayed list.

0 Tip: Start typing the contact name in the search box to quickly find a user or group.

4. Click the star icon located at the top right of the contact. This changes the star to yellow, which marks
this contact as a Favorite. The VMP Web Console adds the contact to the Favorites list.
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Contacts [ sites |

(comsc ) N

2]
Ll ©
®
®
@
@

Vocera Messaging 5.3.2.2215 © 2019 Vocera

1 Jen McMaster

[Global] Registered Nurse
Available, Off campus

@ O

Call Urgent Call

[On-cCall] On-call ...

On-Call Distribution List

Everyone_Global
[Global] Regular Distributio... LETET LS
Site:

Calvin Lu Global

[Global] Registered Nurse .
Not Available Job Title:
Registered Nurse

Carol Wilson
[Global] Charge Nurse
Mot Available

Name:
Jen McMaster

Grace Morgan
[Global] Patient Care Techni...
Mot Available

Jen McMaster
[Global] Registered Nurse
Ronilable, A e

THE VMP WEB CONSOLE

9 Josh McNab | Logout

Text

If contacts have been organized into sites, you can specify which sites are to be displayed in the Contacts

list.

Server has been integrated. See

integrating with the Vocera Voice Server.

Note: Sites are available if they have been created on the Vocera Voice Server with which the VMP

on page 31 for more information on

The sites that you choose to display remain selected if you log out of the VMP Web Console and log back

m.

1. Click Contacts to display the Contacts view.

vocera\I

Seci’ e Messages #

Giace Morgan
harts for Bob Perkins
Could you please bring them to me? Tha...

@) Jen McMaster 12:07 pm

Here's the latest picture of Linda

2. Click Sites.
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vocers Web Console

Contacts [ sites |

(Comses v] CHN
[On-cCall] On-call ...
On-Call Distribution List
g Everyone_Global
[Global] Regular Distributio... LETET LS

Site:
Calvin Lu Global
[Global] Registered Nurse
Not Available

. Jen McMaster

{ [Global] Registered Nurse
Available, Off campus

Urgent Call Text

Job Title:
Registered Nurse

Carol Wilson Name:
[Global] Charge Nurse
Mot Available Jen McMaster

Grace Morgan
[Global] Patient Care Techni...
Mot Available

Jen McMaster
[Global] Registered Nurse .
Ronilable, A e

Vocera Messaging 5.3.2.2215 © 2019 Vocera

THE VMP WEB CONSOLE

9 Josh McNab | Logout

3. In the list of sites that appears, select or clear the sites to display.

When you have specified the sites that you want to display, and you are typing a text string into the
contacts search field, the following matches appear:

* Any contacts (users or groups) whose name matches the text string, and who belong to one of the sites

specified here.

* Any favorites whose name matches the text string, whether they belong to one of the sites specified
here or not. Favorites are always available to receive messages.

If you are logged in to the Vocera Collaboration Suite, you can call a contact from the VMP Web Console.

1. Log on to the VMP Web Console from your Web browser.
2.

Click Contacts to display the Contacts view.

vocera\\s

Seci' e Messages #

Giace Morgan
harts for Bob Perkins
Could you please bring them to me? Tha...

O Jen McMaster 12:07 pm
il Hers's the latest picture of Linda

3. Click the name of the contact to which you want to place a Call. The screen for this contact displays the
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ways that you can communicate with the contact.
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vocera Web Console ) 20sh Mciab | Logous

Contacts [ sies || # . Jen McMaster
\: Conta Glu!:l'al] Registered Nurse
Ca

[Global] Registered Nurse
Not Available

Carol Wilson Call Urgent Call
[Global] Charge Nurse

Site:

Grace Morgan Global

[Global] Patient Care Techni...

Not Available Job Title:
Registered Nurse

Jen McMaster

[Global] Registered Nurse Name:

Available, Off campus Jen McMaster

Josh McNab

[Global] Hospitalist
Avallable, Off campus

7 Linda Davis

_=1) [Global] Respiratory Therapist
Not Available >

Vocera Messaging 5.3.2.2215 © 2019 Vocera

4. Click Call to place a call to the contact, or click Urgent Call to place an urgent call to the contact. This
call behaves exactly as if you had originated it from the device.

When you are logged in to the VMP Web Console, you can change your profile picture.

1. Log on to the VMP Web Console from your Web browser.
2. Click Contacts to display the Contacts view.

vocera I

Sec e Messages

Gface Morgan 12:28 pm
harts for Bob Perkins
Could you please bring them to me? Tha...

O Jen McMaster 12:07 pm
gl Here's the latest picture of Linda

3. Click your name to display your contact page.
4. Click on your profile picture at the top left of the contact page.
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Josh McNab

Global] Hospitalist

mrailable, Off campus

Call gent Call Text

CONTACT DETAILS
Site:
Global

Job Title:
Hospitalist

Name:

Josh McNab

5. In the View Picture dialog box that appears, click Change.

View Picture

| Change H Close |

6. In the file browser window that appears, select the profile picture that you want to use and click Open.
7. When the View Picture dialog box reappears, click Save to update your profile picture.

View Picture

Save H Cancel

257 VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



System options control the behavior of the Vocera Messaging Platform.

You can access some options from the VMP Administrator, and others from the VMP Enterprise Manager.

You can set configuration options to control the behavior of the VMP Administrator.

These options are organized into categories, and some categories are divided into subcategories. To access
these options, start the VMP Administrator and select Configuration > System Options.

B YMP (Default adi
File  View Winc

Users & Groups
Contacts
Messaging
Content

Table 24: System and Networking
Option Description
Networking

Vocera Messaging Server Public ~ The IP address or fully-qualified domain name (friendly DNS name) that is used
Host Name / IP to reach VMP when sending email registrations to end-users.

Vocera Messaging Server Internal The IP address or fully-qualified domain name (friendly DNS name) that V5000
Host Name / IP devices use to reach VMP and the VMP Administrator uses to retrieve the list of
users from a Vocera Voice Server group.

Email

Enable Outgoing Email Allow outbound email messages to be sent from the VMP Server through SMTP.
These include administrative messages and message responses.
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Option
Display Name

Email Address

SMTP Server

SMTP Port

SMTP Authentication
Security

Device validation certificate
Enable smartphone

authentication by certificate

Enforce SSL for smartphone
connections

Enforce server certificate
validation on smartphone

Enforce App PIN

Enforce Smartbadge PIN

PIN Timeout

Enforce device password for all

smartphones

Minimum Password Length

Require at least one letter

Auto Lock

Enforce Change Password
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SYSTEM OPTIONS
Description
The name under which outgoing email is to be sent.
The email address that outgoing email is to be sent from.
The SMTP server through which outgoing mail is to be sent.
The port that the SMTP server uses. The default is 25.
Whether SMTP authentication is required with the SMTP relay host.

The approved certificate for device validation. Devices must have installed the
corresponding device certificate to be able to access this server.

Whether to enable device authentication using a certificate. This option is
currently not in use.

Enforce that all communications between the VMP Server and VMP smartphone
clients are to use SSL. This is required when using iOS clients.

Before you can set this option, you must supply an SSL certificate using the
NetworkSecureCertificate option in the VMP Enterprise Manager.

Whether the smartphone is to validate the server certificate against the local
operating system's keystore. If this option is set to No, smartphone clients use
an HTTPS connection with VMP regardless of whether the SSL certificate on the
VMP Server is trusted or self-signed. If this option is set to Yes, the certificate
must be trusted to allow an HTTPS connection.

Enforce that access to the client application must require PIN entry. Valid
settings are OFF, ON, and Shared (PIN required for shared devices only). This
option is set to either Shared or OFF in the Security Options dialog box during
installation - see on page 13 for more details.

You can override this setting for any individual user. For more information, see
on page 122.

If you change the Enforce App PIN setting to ON, device users will not be able to set a PIN if they
registered by email or using a registration key and do not have either a valid VMP Server username
and password or a valid Active Directory username and password.

Enforce that access to the Vocera Smartbadge must require PIN entry. Valid
settings are Yes and No.

If Enforce App PIN or Enforce Smartbadge PINhas been activated, set the
number of seconds that the device can remain idle before the PIN must be re-
entered.

Indicate that the client app is not enabled to run on a device unless a password
has been specified for the device. This ensures that sensitive information is
kept safe if the device is lost or stolen. Valid settings are OFF, ON, and Shared
(device password required for shared devices only).

Enter the number of characters the user must include in the device password.
For iPhone users, the device Passcode Lock settings must be changed if you
want a password longer than 4 numerical digits..

Select Yes to ensure that the user adds at least one letter to the device password.
For iPhone users, you cannot insist on a password with at least one letter. For
iPhone users, the device Passcode Lock settings must be changed if you want a
password to include a letter.

Set the duration of inactivity, in minutes and seconds, until the device auto-
locks. In the following example, the device is set to auto-lock after five minutes
and thirty seconds:

5m30

Select Yes to ensure the user changes the device password at a regular
frequency.
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Option

Password Change frequency

Unique passwords before reuse
permitted

Maximum failed attempts before
device wipe

Accept client log uploads

User Inactivity

Time of inactivity for automatic
logout

Days of inactivity before user is
placed into Warning state

Days of inactivity before user is
placed into Locked state

Time of inactivity for auto logout
of smartphone client

Device inactivity timeout
interval

VCS logout in dual mode also
causes a badge logout

Table 25: Notifications
Option

Enforce Notification Settings

Secure Messages Priority:
Normal

Secure Messages Priority: High
Secure Messages Priority: Urgent

Calls

Notify Me

Other
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SYSTEM OPTIONS
Description

If Enforce change password is set to Yes, enter the interval, in days, at which
the user is required to change the device password.

The VMP Server stores a list of the most recently used passwords for a device.
A password cannot be reused if it is one of the N most recent passwords used,
where N is the value of this option.

Enter the number of times a password can be incorrectly entered before all
system sensitive information is wiped from the device.

Indicates whether log files can be uploaded to the server from Vocera
Collaboration Suite clients.

The number of minutes that the browser and VMP can be inactive before
automatic logout. This does not affect clients or the VMP Enterprise Manager.

The number of days before a Warning icon is placed on a user account.

The number of days before an inactive user is locked. Locked users cannot
access the VMP Administrator. See on page 126 for more
details.

The number of minutes that a client can be inactive before automatic logout.
Users in Dual Mode are logged out of the smartphone client but not the badge.

If a user is offline for more than the number of minutes specified in this option,
the user's status is set to "not available". The maximum value for this option is
1440 minutes (24 hours).

Whether a user in Dual Mode who logs out of the VCS app should also be
automatically logged out of the badge.

Description

Whether VCS clients must be forced to accept the vibration and ringtone settings
specified in the VMP Administrator. Valid values are:

* ON - all clients must be forced to accept system settings
* OFF - any client can configure vibration and ringtone settings
* Shared - all shared devices must be forced to accept system settings

The vibration pattern and ringtone for Normal priority secure messages. Click
Configure to display the notification specification dialog box.

The vibration pattern and ringtone for High priority secure messages. Click
Configure to display the notification specification dialog box.

The vibration pattern and ringtone for Urgent priority secure messages. Click
Configure to display the notification specification dialog box.

The vibration pattern and ringtone for calls. Click Configure to display the
notification specification dialog box.

The vibration pattern and ringtone for notifications that are generated when
the Notify Me checkbox is selected for messages that require a response, and
a response is not provided in the specified time. Click Configure to display the
notification specification dialog box.

The vibration pattern and ringtone for notifications for changes in On-Call
status, new or updated Content, missed calls, and voicemails. Click Configure
to display the notification specification dialog box.
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For a more detailed description of notification options, see

Table 26: Contacts
Option

Allow User to upload personal
image

Allow Email Communication

Table 27: Secure Messaging
Option
Enable Remind Me Later Option

Default Subject Line for 3rd Party
Integrations

Response waiting interval

Retain Message History in
Database

Deliver message content to SMS
users

Allow Urgent messages

Include attached images in the
report

Number of days of inactivity to
archive a conversation

Allow users to forward messages

Forward clinical system
messages

Allow attaching pictures from a
file

Allow attaching pictures from the
camera

Table 28: Override Notifications

Option

Enable Do Not Disturb Mode on
Smartphone Clients
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on page 80.

Description

Whether a user can upload a photo to their Contact entry from a client
application.

This setting controls whether client applications can use email as a mode of
communication. If this setting is enabled, the client uses the device's default
email editor.

Description

Enables the Remind Me Later option on the Vocera Collaboration Suite app.
When this option is enabled, if a Vocera Collaboration Suite user has not viewed
a message, a reminder notification is sent after a specified number of minutes
has elapsed. The Remind Me Later option sends a reminder for Urgent and High
priority messages. Optionally, VCS can also be configured to send a reminder for
Normal priority messages.

The subject line to use when messages are sent from a third-party WCTP source.

The number of seconds to wait for a user response when an SNPP or WTCP
message is sent.

The number of weeks that messages are kept in the Microsoft SQL database.

Determines whether the content of an Alert is delivered to an SMS user. The
default is No, since SMS channels are non-secure.

Whether messages can be marked as Urgent.

Whether to include attached images when generating a report

The number of days that a conversation is to be inactive before the conversation
is archived.

Whether users can forward messages to another user. Forwarding can also be
turned on or off for any specific user.

Whether to employ user-specified message forwarding settings for messages
from clinical systems, including VMI and CWE.

====| Note: Vocera recommends that you disable this setting, as the behavior
=== | is inconsistent when clinical system messages are forwarded to badges.

If enabled, allow VMP Web Console users and users on mobile clients to attach
pictures to secure messages by selecting an existing file. Setting this option to
No disables access to the photo gallery on mobile devices.

If enabled, allows users on mobile clients to use the device camera to take
pictures to attach to secure messages.

Description

Whether Do Not Disturb is to be allowed in the client application.
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Table 29: Content
Option

Minimum document update
frequency

Allow Content sync with Mapped
Network Drives

Table 30: Web Console
Option

Disclaimer for Web Logon
Enabled

Organization Name

Text

Web Console Date Format

Enabled

Table 31: Integrations
Option

Vocera Voice

SYSTEM OPTIONS

Description

For the Content module, the minimum number of minutes between updates of
documents in shared folders.

Whether to support synchronization of Content module documents on mapped
network drives (not recommended).

Description

Whether a disclaimer popup appears when users log in to the VMP Web Console.
The organization name to appear in the disclaimer popup.

The content of the disclaimer popup.

The format in which dates are displayed in the VMP Web Console.

Whether HTML, CSS, and JavaScript static files are sent to the browser in
compressed format.

Description

' Important: If any of these values are changed, you must manually restart the VMP Server by restarting the

Vocera Data Exchange Service. See on page 26 for details on how to do
8/ this.
Enabled Whether the VMP Server is to interact with a Vocera Voice Server.
IP Addresses The IP address of the Vocera Voice Server, or comma-separated addresses if the
Vocera Voice Server is operating in a clustered environment. This option can
be set in the Voice Server dialog box during installation. See
on page 13 for more details.
Port The Vocera Voice Server port number.
Use HTTPS Whether to use HTTPS for secure communication with the Vocera Voice Server.
VCG IP Addresses The Vocera Client Gateway IP address, or comma-separated addresses if

VMI Message Expiry

Enable Enhanced Voice Server
NIO Tomcat Feature

Retain call and voice mail history
in the database

Use VCG for VCS client
connection management
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the Vocera Client Gateway is operating in a clustered environment. These
addresses are configured when the Vocera Voice Server is installed and has been
synchronized with the VMP Server, and cannot be edited here.

The number of minutes before VMI (Vocera Messaging Interface) messages sent
from the Vocera Voice Server expire.

Whether to enable support for scaling changes included in the Vocera Voice
Server. Ensure that this feature is enabled in the Vocera Voice Server before
enabling it in the VMP Server.

The number of days to retain calls and voice mail messages from client devices
in the server database.

When enabled, the VCS client will use the Vocera Client Gateway server for
enhanced connection management. This setting is recommended to improve
resource management on the clients. Requires Vocera Client Gateway version
5.2.2 or later and VCS version 3.2 or later.

See the Vocera Voice Server Telephony Configuration Guide for details on the VCG properties that
configure the VCS and VMP interface.
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Option

Send user-generated messages to
Vocera badges

Consider Call Forwarding in User
Presence Status

Prevent voice enunciation on
user-generated messages

Allow Accept/Decline for Urgent
Calls

Show integration messages on
device lock screen

Patient Context

Enabled

SYSTEM OPTIONS
Description

Specifies whether messages generated from Vocera Collaboration Suite and
the VMP Web Console are to be displayed on Vocera badges. All other types of
messages are always sent to Vocera badges.

Specifies whether a user is to be considered available if he or she has configured
call forwarding on the Vocera Voice Server, even if he or she is not logged into
VMP.

Specifies whether to disallow voice enunciation on badges of messages sent from
Vocera Collaboration Suite and the VMP Web Console regardless of the priority-
based enunciation rules configured on the Vocera Voice Server. This can prevent
personal health information being heard.

This feature requires Vocera Voice Server 5.3.2 or later.

Specifies whether to disallow auto-answering of urgent calls. When enabled, the
user must accept or decline the call.

Whether to allow messages sent from systems integrated with VMP to appear on
the lock screens of client devices.

' Important: If a message contains confidential patient health
information, displaying the message on the lock screen may violate
privacy regulations.

Set to Yes to enable integration with the Engage Patient Context Adapter. See
on page 39 for more details.

Vocera Secure Texting App - Message Exchange

Enabled

User ID

Shared Key

Manage VST Contacts

Email

Enable Secure Message Initiation

Set to Yes to enable messages and images to be exchanged between Vocera
Collaboration Suite users and Vocera Secure Texting mobile applications.

This ID is configured by the VST cloud server to identify the connected Vocera
organization.

Authenticates the connection between the VST cloud server and the connected
Vocera organization.

Specifies the server that manages VST contacts.
If this field is set to Voice, VST contacts are managed on the Vocera Voice Server.

If this field is set to VMP, VST contacts are managed on the VMP Server in the VSTContacts
distribution list.

Enables the configuration of a user's email into the Messaging feature.

Secure Message Initiation - Incoming Mail

Protocol

Email Scan Interval

Initiation Permitted

EWS Domain

Email Username
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The protocol for the mailbox. This is one of POP3, IMAP4, or Exchange Web
Services.

Depending on the protocol selected, additional connection parameters must be specified, including
POP3/IMAP/EWS Host and POP3/IMAP4/EWS Port.

The number of seconds between scans for new incoming email.
Who can initiate messages by email. This is one of the following:

* From any email address: Anyone that can send email can initiate a
message.
* From VMP users only: Only registered VMP users can initiate a message.

The Exchange Web Services domain. Appears only when Protocol is set to
Exchange Web Services.

The username associated with the mailbox that the VMP Server is to monitor.
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Option
Email Password
Confirm Email Password

POP3/IMAP4/EWS Host

POP3/IMAP4/EWS Port

IMAP4/EWS Use Secure
Connection

IMAP4/EWS Security Port

IMAP4 Authentication Type

IMAP4/EWS Mailbox

Delete Email Once Processed

WCTP

PollingID 1
PollingID 2
PollingID 3

SMS Aggregation

Configure SMS aggregator plug-in

Table 32: Scheduling
Option

When does daily validation
happen

Validation look ahead interval
Table 33: VBI Data Export

Option
Enable VBI Data Export
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Description

The password for the mailbox username.

The password for the mailbox username (repeated).

The hostname for the server hosting email account. This must be the domain
name, not the URL. For example, use mail.customer.com, not https://
mail.customer.com/owa.

The port number for email account connections to the host. See
on page 11 for the default port requirements for these protocols.

Whether the connection to the email server must be secured. Appears only when
Protocol is set to either IMAP4 or Exchange Web Services.

The port number at which the email server is accepting secure connections. See

on page 11 for the default secure port requirements for these
protocols. Appears only when Protocol is set to either IMAP4 or Exchange
Web Services.

The type of login that the IMAP4 email server supports. Select either Login or
Authentication. Appears only when Protocol is set to IMAP4.

The mailbox name to access within the specified email account (for example,
Index). Appears only when Protocol is set to either IMAP4 or Exchange Web
Services.

How often the VMP Server will remove emails from the monitored mailbox.
This is one of the following:

* Immediately: The VMP Server deletes the email immediately after it has
been converted to a message.

* Once/Day: The VMP Server deletes all processed emails that are older than
24 hours.

* Never: The VMP Server never deletes any email. Select this setting only if
email is deleted by another process or person.

The polling IDs to use when communicating with a WCTP source.

Link to the Plugin Configuration window in which you can configure an SMS
aggregator service.

Description

The time at which schedule validation takes place when it has been specified
for on-call schedules. When automatic validation is performed, a report is
generated that is emailed to all users that have edit access on the schedule.

The number of days to look ahead in an on-call schedule when validating. This
number can be between 1 and 14.

Description

Whether or not the Vocera Business Intelligence (VBI) Data Export function is
active.

VOCERA MESSAGING PLATFORM ADMINISTRATION GUIDE



SYSTEM OPTIONS

Option Description
Time of Data Export The time at which to run the VBI Data Export job.
Location of Data Export Where to store the VBI Data Export logs. The default is the <drive>\Vocera

\Support\Upload folder, where <drive> is the drive on which VMP is installed.

From the VMP Enterprise Manager, you can set configuration options to control the behavior of the VMP
Server.

These options are organized into categories, and some categories are divided into subcategories. To access
these options, start the VMP Enterprise Manager and select Configuration > Configuration.

s
Configuration

Options marked with an asterisk * are visible only when you click Advanced Options.

If you have installed a standalone version of the VMP Administrator, the VMP Enterprise Manager
displays only a limited subset of these options. The options available in a standalone environment are
marked with two asterisks **.

====| Note: If you are using VMP in a clustered environment, you must update these options on each
cluster node on which the VMP Server is installed.

Table 34: VMP Enterprise Manager Configuration Options

Option Description

Database

Auth

Login ** The database account used to query stored permissions
and authenticate users. The default is wicauth.

Password ** The password for this account.

Confirm Password ** A repetition of the password for this account.

Master

Login The account used by the application server and by the

VMP Administrator if authenticated successfully. The
default is wicapplication.

Password The password for this account.

Confirm Password A repetition of the password for this account.

Server ** The name or IP address of the VMP database server.

MaxConnections * ** The maximum number of cached connections to the SQL
Server.
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DBUpdateFile * **

Services
WDE

NetworkInterface

NetworkPort
NetworkSecurePort

NetworkSecureCertificate

NetworkSecureEnforceWebSSL

MaxPacketSize *

DefaultSliceLimit *

EnableWebServer

Enable automatic Web login

SYSTEM OPTIONS

Description

The SQL file for the DBUpdate tool. This tool is used by
Vocera technical support.

The IP address of the network interface to which the
server listens for requests. If this is set t0 0.0.0.9, all
interfaces are available.

The HTTP port number for the VMP Server.
The secure HTTPS port number for the VMP Server.

The SSL certificate to be used with the VMP Server.

This is set in the Security Options dialog box during
installation. See on page 13 for
more details.

Enforce the use of SSL when connecting from the VMP
Web Console to the VMP Server.

The data size used by device clients when
communicating with the server.

The maximum size of a compressed data chunk in a
packet. This enables limiting of memory consumption on
the device.

Enable the VMP Web Console.

Enable Active Directory automatic login (supported for
Internet Explorer only).

Enable no authentication for Web login Enable the Open Portal interface.

Do not show VMP instances on Web login page If multiple instances of the VMP Server are available, do
not display them on the VMP Web Console login page.

BISStatusRecordsFlashInterval * The BIS-B status record expiration interval. This value

does not need to be changed.

Apple push protocol version * This value does not need to be changed.

Apple push idle connection timeout * This value does not need to be changed.

Connection Limit * The number of requests that the server can handle
simultaneously. Requests over the limit are kept in a
connection queue.

Connection Timeout * The length of time that a connection remains in the
connection queue.

Media Stream Connections Limit * The maximum number of simultaneous media streaming

HTTP connections.

Device Push Connections Limit * The maximum number of simultaneous device push

connections.

Web Push Connections Limit * The maximum number of simultaneous web push

connections.
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Active Directory Server **

Connect to Active Directory over SSL **

Allow Active Directory user to login (display login/
password form) **

Enable automatic login using Active Directory
authentication **

Allow current logged domain user to login (display link)

GCMProxy *
WCTP *
Security code *
SMTP

Server

Port *

VMP email
UseAuthentication *
Login *

Password *

Confirm Password *
UseSSL *

Network *

Proxy *

Enabled *

Host *

Username *
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Description

The Active Directory IP address or host name when the
VMP Server is integrated with Active Directory. This
option can be set in the Active Directory dialog box
during installation. See on
page 13 for more details.

If your Active Directory server is not using port 389, you must specify
the port number. For example, for an Active Directory server on

vocera. com using port 50000, specify VOCera.com: 50000.

=== | Note: If you have previously imported users
=== from an Active Directory server, you must supply
the same server information here. See
on page 52 for
details.

Whether to connect to the Active Directory server using
SSL. The default is False.

Enable the use of Active Directory user names and
passwords when logging into the VMP Administrator.
Only users that have been granted permission to log into
the VMP Administrator can use their Active Directory
credentials. The default is False.

Select True to enable logging into the VMP Web Console
using Active Directory credentials. The default is False.

Select True to display an auto-login link. If this link is
clicked, the VMP Server attempts to automatically log in
using Windows authentication. The default is False.

This value does not need to be changed.

The security code to allow WCTP polling.

The SMTP server for email notifications. In a clustered
environment, this is used to send failover notifications.

The port number for the SMTP server.

The email address that email notifications are sent from.
Whether to use SMTP authentication.

The login ID for SMTP authentication.

The password for the SMTP login.

A repetition of the password for the SMTP login.
Whether to use SSL for the SMTP connection.

Whether a proxy is to be enabled on the network. If a
proxy is enabled, all outgoing requests go through this

proxy.
The IP address of the proxy.

The username for the proxy.
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Password *
Confirm Password *
Soap * **

ConnectionsLimit * **

Logging
Limit log messages to VMP Log File

Limit log messages to Windows Event Log
Limit EMail notifications
Email Address(es) for Notifications

Enable extended communication logging *

Enable smartphone extended communication logging *

Enable Badge extended communication logging *

Enable web console extended communication logging *

Enable SOAP extended communication logging *

Size of log file in megabytes *

Count of log files *
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Description
The password for the proxy username.

A repetition of the password for the proxy username.

The maximum number of simultaneous SOAP
connections.

The levels of log messages to be written to the log file.

The levels of log messages to be written to the Windows
event log.

The levels of log messages for which email notifications
are to be sent.

The email addresses to which email notifications are to
be sent.

Enables logging of the content of HTTP requests, WCTP,
and email. Warning: This logging information may
contain message text, which may cause patient-sensitive
information to appear in the log files.

Enables logging of VMP smartphone data exchanges.

Warning: This logging information will contain
message text.

Enables logging of Vocera Badge data exchanges.

Warning: This logging information will contain
message text.

Enables logging of VMP Web Console data exchanges.

Warning: This logging information will contain
message text.

Enables VMP SOAP interface logging.

Warning: This logging information will contain
message text.

Specifies the maximum size of a log file. When the file
reaches this size, a new file is started. If 0 is specified,
log file rotation is disabled.

The number of log files to retain in the system. If this is
set to 0, log files are never deleted.
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